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Account Manager - What's New?

We have introduced the following enhancements and changes in this release:

Improved Service Address Management: Previously, while assigning an emergency service address to
extensions in bulk, you had to browse through duplicate and unused addresses. With this release we have cleaned
up the address list as follows:

o Unused emergency service addresses resulting from closed accounts and changed addresses are eliminated

from the list.
o Most duplicate addresses are removed.
When editing a branch:

o Fora more robust caller experience, dedicate service extensions (Ring Groups, Call Queues, and Auto
Attendants) to specific Branches and Cost Centers.

o Ensure that service extension calls get a prompt live response by assigning receptionists to service
extensions.
o For easier extension management within a branch, you can see regular and service extensions that are
assigned to your branch, as well as unassigned extensions that you can use.
For quicker management of call park extensions, you can create and delete call park extensions in bulk.

Control your security requirements by selecting the minimum password length required to access voicemail for
regular and service extensions. Changes to the minimum password length take effect the next time the relevant

passwords are changed.
Streamline the contacts list by excluding service extensions from the Contact Directory.

We have now introduced a dedicated option that controls the availability of the Virtual Office mobile app. Enable or
disable the Virtual Office mobile app at extension level for all customers.
For a clearer international calling experience, all phone numbers now follow the international E.164 phone number

format.
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Overview

Welcome to 8x8 Account Manager. 8x8 Account Manager is the simple way for phone system administrators to
manage their company's 8x8 Virtual Office phone system from any desktop.

Using 8x8 Account Manager, phone system administrators can:
= Configure and manage extensions.
m Manage Virtual Office user profiles.
m Manage your phone system features such as Auto Attendant, Ring Groups, and Music on Hold.
= Transfer active phone numbers to 8x8 services.
m  Manage your payment methods.
m Check order status.

m  Open and track support cases.
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System Requirements

You require the following systems to operate:
Supported Operating Systems

= Windows® 7, Vista, and XP
m Mac OS 10.5.4 (Leopard®) or newer
Required Plug-ins

Flash Player 10.0 or newer
Supported Browsers

The latest versions of the following browsers are recommended:

Microsoft Windows Environment: Mac OS Environment: Linux Environment

m  Firefox m  Firefox m  Firefox

m Google Chrome m Google Chrome m Google Chrome
m Internet Explorer 11 m  Safari m Opera

m Opera ‘

m Safari

Required Firewall Ports
m 80 TCP (http)
m 443 TCP (https)

Minimum System Requirements
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System Requirements

Windows XP éWindows 7 and Vista

‘Mac

m Pentium 4 1.3 GHz/AMD Athlon XP

1500+ or newer

m 512 MB of RAM

m Pentium 4 1.3 GHz/AMD Athlon XP

1500+ or newer

m 1 GBof RAM

m Powercomputer G4/G5

or newer

m 512 MB of RAM

Bandwidth Recommendations
m Cable modem: DSL or better

= Minimum: 1.5 Mbps down and 384 kbps up
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Get Started

Once you log in to 8x8 Account Manager, you can edit your personal settings and begin to manage your tasks. For
information on getting started with the application, refer to:

m Logln
m Edit My Profile

m Know the Interface

LogIn
Logging in to 8x8 applications is quick and simple. You can log in using your 8x8 credentials or via single sign-on from
your company's preferred identity management system:

m Login using 8x8 username and password: Access all 8x8 applications you subscribe to using your 8x8 username.

m Loginusing SAML SSO: Log in to 8x8 apps using your company's identity management system, such as Okta,
Microsoft ADFS, or OneLogin, if enabled. Access all services available to you using your standard company login.

m Login using Google SSO: Log in using your company Google Apps credentials to authenticate into 8x8 apps, if
enabled. Access all services available to you using your standard company login.

Log in Using 8x8 Username and Password

1. Log in to Account Manager by going to http://login.8x8.com from your preferred browser.

2. Enter your 8x8 username and password, and click Login. The Application Panel opens. Select the desired
application to launch.

If you wish to avoid entering the credentials every time you launch the application, select Remember Me in the login
screen. The application remembers your password for automatic authentication every time you launch the application.

Version 1.0 5
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Log in Using SAML SSO

1. Launch Account Manager by going to http://login.8x8.com from your preferred browser.

2. Inthe login screen, click Use Single Sign On.

The SSO login prompt opens.
3. Enter your 8x8 username or company email for validation.
4. Click Continue to view your SSO options.

5. From your options, select Log in using SAML.

Virtual Office  Help

L3
El!l{ulg

Sign On

USERNAME

PASSWORD

Remember Me

Version 1.0 6
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6.

Get Started

f— Note: If you log in using Okta or Centrify, the login page opens in a new browser tab instead of in
f the application window. Until you log in, the application window reads Login from browser....

Enter the credentials to log in to the identity provider.
The 8x8 application panel launches. Select the desired application to open.

Log in Using Google SSO

1.
2.

Launch Account Manager by going to http://login.8x8.com from your preferred browser.

In the login screen, click Use Single Sign On.

The SSO login prompt opens.
Enter your 8x8 username or company email.
Click Continue to view your SSO options.

From your options, select Log in using Google.

If prompted, enter your company Gmail address and password.

Click Allow to grant 8x8 single sign-on access to your Gmail profile.

You are now authenticated to your 8x8 app. The Application Panel opens.

Edit My Profile

As an Account Manager primary administrator, you can edit your profile information, such as name, password, time
zone, and communication preferences.

Version 1.0
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Click Edit My Profile at the top of the window.

Account Manager Company Name: Spacialty Cockies | Main Number: (556) 054-7455

Welcome, Sarsh Thomas | Sign Cut

mail: cliu@s: Account: | Business Ld
Edit My Profile
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Edit Profile Information
Edit Profile Information © Help
uame
First Name Sarah Due to FCC CPNI reguirements, customers must provide a Pass Phrase when calling 8x8
Last Name Thomas for access to calls logs, call detail records and billing informaticn. It will alse be needed to
make any changes by phone to the email address associated with the profile.
User ID 'specialtycookies
Pass Phrase apipass123
User ID specialtycookies
New Password [7]
Confirm New
Password
Language Japanese ro
Snge 590 0n
Federation ID PHILLIFL@GMAIL.COM 0 Time Zone US/Eastern r 9

‘Communication Preferences

¥ 8x8 e-newsletters
Helpful tips with information on the latest news and features.

i

The password hint is associated with your primary email address.

¥ Product and promotion emails
Current Password Hint Question Emails about new products, special discounts and offers
Current Password Hint Answer Monthly bill notification
New Password Hint Guestion T Email me wn{an my monthly bill is available for viewing.
New Password Hint Answer

‘B8x8 satisfaction surveys and product trial
Invite me to give feedback and try new products.

Contact Information Users can update their communication preferences in their Virtual Office Online Account.
Note: 8x8 reserves the right to contact you regarding senice, feature or policy
Email announcements and information about your account.
Primary Email Address Email Type -
sbeckmann@SpeciatyCookies.com Business v | (@
sgarud@ExE.com Business * | @
Phone

Primary Counfry Code  Phone Number  Extension Phone Type

3

16508463008 Business v | @

4086457878 Main @

| Save i Cancel |

Enter your First Name, Last Name, New Password, and Confirm New Password.

Hover overﬂ to learn the password requirements.
Enter the Federation ID if you are using SAML account.
The Federation ID is used to map the SAML identity provider account to your 8x8 account.

Enter both New Password Hint Question and New Password Hint Answer.
The password hint is associated with your primary email address.
Enter Contact Information.

Enter your primary email address and phone number.

Get Started
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6. Entera Pass Phrase.
You need to provide a pass phrase when calling 8x8 to make changes to your email address associated with the
profile.

7. Select a Language.
It determines the language of the email communications sent to the primary administrator such as password reset
or account notifications.

8. Select a Time Zone.
The time zone is used for call recording, call queues, and scheduling and running reports.

9. Enter your Communication Preferences, such as newsletters, product and promotion emails, bill notifications,
and surveys.
You can also update your communication preferences in your Virtual Office desktop app.

: &= Note: Only the primary administrator is able to receive billing notification emails. Secondary
;?ﬁ administrators (even those with billing privileges) do not have the option to receive billing
notifications.

Version 1.0 9
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Know the Interface

The Account Manager home page provides a snapshot of your Virtual Office system. At a glance, you can schedule and

see the status of tasks from support requests to number transfers.

HOME | PHONE SYSTEM | BILLING | REPORTING | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Call Log Summary

Billng Summary Phone System Sefup Get off to a quick start!

SelectTime Frame ¥ Status: Current T Fere Watch this quick video to learn
Payment Amount: $0.00 O hm::umgety:‘rsm
— and running qui
NextPayment 53022017 View User Profiles ¥ g

S View Privileges
View Call Logs few Stateme
< e SEEnEE Installation Appointmentis)
Update Billing Profile Download Activation Cades
Account Updates

Order Status | View All

AD0300042930 - Not Shipped | SA10004182 - Not Shipped | AC0300042346 - Not Shipped | More

8x8 Network Alerts | Support
(“.,)) | Supp
A All systems and networks are currently functioning at 100%

Empower your users with

How do T set up holiday hours and greetings? How do 1 chang YOUR GUESTION 8x8 Virtual Office Mobile
How do I change the Call Forwarding rules for an extension? How do T make ’
How do I change my Auto Attendant greetings? How do T set up v (mnglr play

How do I set up my pheone extensions for the first time? How do I chang

Available on the

Ll
How do T set up Virtual Office Online accounts? How do T chang ' App Store

How do I set up Virtual Office Mobile on my cell phone? How do T view © >
Send to our experls
How do I check the status of a phone number transfer request? How do T pay 1 [[hgl

Account Drop-Down Menu

If you have more than one type of 8x8 service, they are listed in the Account drop-down menu. Click the arrow and
select Business to manage your 8x8 Virtual Office business phone system.

Account: Business A

Phone System Name: Specialty Cookies -

The drop-down can contain the following options:
m Business
m Virtual Office Solo
m Virtual Meeting
= Virtual Room
Phone System Name Drop-Down Menu

If your phone system has multiple PBXs, click the arrow to select which one you want to manage.

Version 1.0
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Note: If you have only one phone system, the drop-down does not display.

Call Log Summary

Displays the number of incoming and outgoing calls based on a selected time interval. Use the drop-down arrow to
select:

= Today

= This week

m  This month

Con Log Sommary Phone Sysiem Setup
— Select Time Frame v = Status: Demo/Trial Setup Features

tE $: Payment Amount: $212 93 Cantact Directory

= = Eﬁ;‘ Payment 5o 50 on4p View User Profiles

— View Privileges
View Call Logs fiew Stateme

i - View Stat.,r.mms Installation Appointment(s)
Update Billing Profile Download Activation Codes

Billing Summary

Summarizes current charges for your 8x8 Virtual Office phone service, and provides links to your Billing Statements and

Billing Profile.
Phone $ystom Sotup

— Select Time Frame v = Status: Demo/Trial Setup Features
tE $: Payment Amount: §212.93 Contact Directory
= || g NEXtEavment View User Profiles

Due: 05-02-2016

. View Privileges
View Call Logs fiew Stateme

i - View Stat..r.n-nts Installation Appointment(s)
Update Billing Profile Download Activation Codes

Phone System Setup

When you first purchase 8x8 Virtual Office, an 8x8 technical installation representative will walk you through all your
setup tasks over the phone. If you did not have this appointment and need assistance, please schedule an over-the-
phone installation appointment. To view details, schedule or reschedule 8x8 installation appointments, click
Installation Appointment(s).

While ordering additional features, you may pause at any point during the order process. After pausing, just click
Continue Setup to continue the order process from the point you last saved.
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CallLogSummary

— Select Time Frame ¥ p— Status: Demo/Trial
E: $: Payment Amount: $212.93
— = Next Payment -
= Due: 05-02-2016
View Call Logs View Statements

Update Billing Profile

Phone System Setup

12

Setup Features

Contact Directory

View User Profiles

View Privileges

Installation Appointment(s)
Download Activation Codes

Account Updates

This is a snapshot of your account status. You can view:

Get Started

m Order Status: Shows the status of orders placed in the last 30 days. To view the status of earlier orders, click View

All and then select or search for the desired order.

m Number Transfer Status: Displays pending number transfer requests. To view the status of all number transfers,

click View All.

m 8x8 Network Alerts: Displays information about any important 8x8 system or network updates. To contact 8x8

Support, click Support.

Account Updates

9 Order Status | View All
- SA10000542 - Not Shipped

Number Transfer Status | View All
212

S -1
41 5 202880 - Open - In Progress

(“.n) 8x8 Network Alerts | Suppor
All systems and networks are currently functioning at 100%

How Do I...?

These are links to top Help topics.

You can access these and additional help information using the Help link located on all Account Manager pages.

T

How do I change an extension’s features?

How do I set up holiday hours and grestings?

How do I change the Call Forwarding rules for an extension?
How do I change my Auto Attendant greetings?

How do I set up my phone extensions for the first time?
How do I set up Virtual Office Online accounts?

How do I set up Virtuzal Office Mobile on my cell phone?

How do I check the status of 3 phone number transfer request? How do I pay my bill?

How do I make changes to Ring Groups?

How do I change my extension numbers?

How do I set up Virtual Office Pro features?

How do I change the voicemail password for an extension?

How do I view my bill and update my billing options?

Version 1.0
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Set up Phone Systems

Setting up the phone systems involves configuring the extensions, creating users, assigning user to extensions, and
setting up preferred features for extensions. Based on the phone system needs of your company, refer to the following
topics:

m Manage Extensions

m Define Outbound Calling Options

m Manage Call Recording

m Create an Auto Attendant Profile

m Configure Company Settings

m Request Number Transfer

m Configure Virtual and Toll-Free Numbers

m Create Ring Groups

m Access Music on Hold

m Set up Group Paging

m Configure Voicemail and Fax Notifications

m Add-On Features

Manage Extensions

When you log in to Account Manager for the first time, you see one or more phone extensions that are provisioned by
the 8x8 provisioning team for your business. To see phone extensions, go to Phone Systems > View All

Extensions. The Manage Extensions page opens up. The phone extensions are not assigned to any users or user
profiles yet. You must create a user profile and then assign the profile to the extension. To learn how to create a user

Version 1.0
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profile, click here.
Use the Manage Extensions page to:

m Assign a user profile to an extension.

m Edit individual extensions.

m Edit multiple extensions.

Ass

Change extension numbers.

Reset extensions to their default settings.

ign a User to an Extension

Setup Phone Systems

To assign a user to an extension, you must first create a User Profile. For details, refer to Create User Profiles.

1. Click Phone System on the top navigation bar.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions

PHONE 5YSTEM Extensions

» Extensions

» Auto Attendant Quick Find / Edit Extension

> Virtual and Toll-Free IEZE IGE5H enter extension number, phone number or
Humbers ’

» Ring Groups

» Music on Hold
» Call Queues r—
L Extensions

» Switchboard l i

» Paging
» Company Seftings
» Number Transfer
» Call Recording

¥ Edit Voicemail / Fax
MNofifications

G EP;OQ

Edit Multiple Change Extension Download Call Outbound Calling
Extensions Numbers. Recordings Options

caller ID.

Version 1.0

From the Phone System page, click View All Extensions.

Click Edit next to the extension you want to edit.

You are now on the Edit Extensions landing page. Use Expand
pane.

Click the link next to User Profile.
The Select User Profile window appears.

to view and edit the Extension Information

14
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6. Find a user profile from the list and click Select.
The user profile is assigned to the extension.

User Profile Supervisor Smith Create New User Profile | Clear User Profile | Reset Extension

External Caller ID: Enable Virtual Office ©
Phonge Number (408) 596-7728 (x1001) Ll Enable Virtual Office Mobile (7]
First Name Supervisor (7]
Last Name Smith (7]
Calling Mame Display Supervisorsmit (7]

Caller ID Option Locked to User? (7]

Phone Number (408) 596-7728

Extension 1001

Plan Unlimited Extensian

Equipment Polycom YVX 400 -‘

Group Paging Configure

Line Keys Configure

7. You can continue to configure the extension, or click Save at the bottom of the page to update user profile
assignment.
To reset the an extension to its default settings but keep the User Profile assigned, click Reset Extension.

To remove a User Profile from an extension, click Clear User Profile. Clearing a user profile resets the extension back
to the default unassigned state.

Note: Clearing a user profile only removes the user from the extension and the user profile is still active
and available to other features that it is assigned to. For details on disabling a user profile and to

removing it from all your system features, refer to Disable User Profiles.

Edit Individual Extensions

By editing an individual extension, you can view or configure:
m External caller ID, phone number and extension, calling plan, type of phone equipment, and group paging.

Note: Phone numbers appear in the E.164 numbering format.
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= Time zone, preferred Codec, emergency service address, calling options, Music on Hold selection, view billing
statements, etc.

= Voicemail password, and email notification options.

m Call recording, fax notification, and Internet fax numbers.
m Call forwarding types and destinations.

m  Membership information.

= Newsletters, product and promotion emails, surveys, and monthly bill notifications.

To access an Individual Extension:
1. Goto Phone System in the top navigation bar.
2. Click View All Extensions.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyword

@ Help
PHONE SYSTEM Extensions
3 Extensions
¥ Auto Attendant Quick Find / Edit Extension
> ;‘ﬁ:wl and Tol-Free Enter extension number, phone number or caller ID.
» Ring Groups
» Music on Hold

> Cafl Cmuses View All Edit Multiple Change Extension Download Call OGutbound Calling
» Shaved Lines Extensions Extensions Numbers Recordings Options
> Switchboard o
» Company Seftings 0
View

» Number Transfer
[ Dowioad |

» Call Recording
> Edit Voicemail / Fax
Hobfications

g

3. Click Edit next to the extension you want to edit.

HOME ||PHONE SYSTEM I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone Syslem > Manage Extensions Enter keyword
Manage Extensions © Help

PHONE SYSTEW Below is an overview of all extensions. You may edit the extension details individually be clicking Edit next to each extension or as a group by clicking on Edit

Multiple Extensions.
¥ Extensions

> Auto Attendant Edit Multiple Extensions | Change Extension Number | Download Call Recordings | Download Extensions (csv) | Download Activation Codes
¥ Virtual and Tol-Free Statu Service Type Ext  Phone Numbel Caller ID Caller 1D Devices Voicemail-to- E:
MNumbers First Name Last Name
> Ring Groups
» Music on Hold Edit | Activate Device Pending  Unlimited Extension 1001 (210)500-1794  John Smith Polycom SoundPoint IP 335  nalini@8x8.com -
» Company Seftings Edit | Active Unlimited Extension 1002 (210)500-1795  Reb Shasta Virtual Office Softphene miadace@8x3.com
» Number Transfer I Edit | I Active Unlimited Extension 1003 (850)000-0000 Unassigned  Unassigned  Virlual Office Sofiphene nalini@8x8 com
2 Call Recordin
= Edit | Active Unlimited Extension 1004 (850} 000-0010  Unassigned Unassigned  Virtual Office Softphone nalini@8x8.com
¥ Edit Voicemail/ Fax .
« [

Phone
System
Setup
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4. Use Expand | or Collapse u to view and edit the extension.

HOME \IPHONE SYSTEMI\ CONTACT CENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Phone System > Manage Extensions = Edit Extension
Edit Extension @ Help
PHONE SYSTEM
Use the Expand B3 and Collapse [ icons to view and edit this extension. Save Changes at the bottom of the page.
> Auto Attendant Expand All
> Virtual and Tol-Free 3 3
e — ¥ Extension Information
¥ Ring Groups = = =
> Music on Hold Exiension Settings
>
Call Queues [ P———
¥ Branches
PRSI B Virtual Office: Pro Information
> Company Settings
¥ Number Transfer ¥ Call Forwarding
Request
> Call Recording ¥ Extension Membership Display
> Edit \ioic email / Fax
e ¥ Communication Preferences
¥ Group Call Fickup
¥ Call Park Extensicns ¥ Barge Permissions

E Save Changes
Phone

Note: The panes displayed varies depending on whether the selected extension is Basic, Virtual, i
Fax, Shared, Unlimited, Unlimited Pro, Metered, etc. If you are editing a Shared extension, see Seté
up Shared Lines. ;

Edit Your Extension Information

In the Extension Information pane, you can:
m Assign an existing user profile to an extension, or create a new user profile.
= Assign an external or internal caller ID to the extension.

m Enable or disable access to Virtual Office applications.

To edit your extension information and set up a caller ID:

1. Click Expand H to display the Extension Information.

2. Choose a caller ID:

m External Caller ID: To select an optional caller ID displayed for outbound calls made to outside your PBX,
such as when you call your customers.
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m Internal Caller ID: To display the caller's first and last names for internal calls within the PBX, such as when
you call your coworkers in the company.

Expand All
= Extension Information ‘
I User Profile John Smith I Create New User Profile | Clear User Profile | Reset Extension
External Caller ID: Enable Virtual Office v 0O
Phone Number (210) 560-3922 (x1271048) v Q Enable Virtual Office Mobile 0
Caller ID Full Name lAcme Jets Inc (7]
Internal Caller ID:
First Name WJohn (7]
Last Name Smith (7]
Caller ID Full Name JohnSmith (7]
|Ca||er ID Option Locked to User? | | @
Phone Number (650) 646-2002
Extension 1003
Plan Unlimited Extension
Equipment Polycom SoundPaint IP 550 . ;
Group Paging Configure

W Extension Settings

¥ Voicemail Settings

¥ Virtual Office Pro Information
¥ Call Forwarding
B Extension Membership Display

¥ Communication Preferences

Save Changes | Cancel

3. Select a Phone Number from the list to display for the outbound calls.

Notes:

-If you choose a regular DID number, the company's name can be edited. If you choose a virtual
toll-free number, however, it is read-only and the name shows as populated.

-If you leave the external Caller ID Full Name blank, it displays the internal caller ID during the
outbound call without automatically populating the field.

-If you assign a user profile to an extension, the extensions internal caller ID is automatically
populated, but you can edit or change it as you wish.

4. Enterthe External Caller ID Full Name.
This name appears during an outbound call.
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5. Enterthe Internal Caller ID.
This name appears during an internal call.
6. Select the Caller ID Option Locked to User check box to prevent a Virtual Office desktop app or Virtual Office

mobile app user to change the caller ID settings.

: Note: By default, the Virtual Office desktop app is enabled for all unlimited, global, and metered

! S Virtual Office extensions. The Virtual Office desktop app allows extension users to manage and
i use their phone features, including accessing the corporate directory and call forwarding settings,

from any computer. A username and password are required to access these features.

7. Select the Enable Virtual Office check box to allow extension user access to the Virtual Office desktop app and
Virtual Office online app.
8. Select the Enable Virtual Office Mobile check box to allow extension user access to the Virtual Office mobile

app. This option is enabled by default.

9. Click Save Changes at the bottom of the screen.

Configure Extension Settings

In this pane, you can:
m Configure time zone.
m Choose a preferred compression/decompression (Codec).
= Edit the emergency service address.
= Allow international, domestic, or emergency calling options.

= And much more!

To configure extension settings:

Version 1.0
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1.
2.

Version 1.0

Set up Phone Systems

Click Expand N to display the Extension Settings pane.

Enter, select, or deselect from the list of options.

Edit Extension @ Help

Use the Expand [ and Collapse [ icons to view and edit this extension. Save Changes at the bottom of the page.
Expand All

¥ Extension Information

= Extension Settings

Time Zone US/Eastern v Travelling Outside the Country @ View Billing Statements (7]
Preferred Codec G.711U (90 kbps) v 0 Hide in Auto Attendant Directory ﬂ Enable Inbound Caller ID | ﬂ
EFJI:[LQ::CY Service | 2125 OMel DR, San Jose, CA 95131-2032 v Edit  AllowMusic on Hold Selection @ Do Not Disturb 7]
Outbound Calling Allow International Calling v Permanent Caller ID Blocking ©

Options

Language PBEX Default v

¥ Voicemail Settings

B Call Forwarding

B Extension Membership Display

¥ Communication Preferences

Save Changes | Cancel

Select a Language from the list.

This setting determines the language of Telephony IVR messages such as voicemail greetings. The display on the
user's desk phone also appears in this language. This setting overrides the default language of PBX or branch.
Review the following table for the available localization settings.

Summary of Localization Settings

The following table summarizes the localization settings in Account Manager:

Setting Description éConﬁgured At
Edit My The primary or secondary administrators who have access to Account User level
Profile - Manager can configure the Language setting in Edit My Profile to

: communicate emails in their language of choice.

This setting overrides the default PBX or branch language setting. It only
applies to the administrator's email communications.

Account > Configure the Language setting for extension users to communicate emails in§ User level
User - their language of choice. :

Profiles This setting in user profile overrides the default PBX or branch language. It
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Setting Description éConfigured At

- only applies to the user's email communications.

Phone Configure the Language setting for all users in the PBX to receive Telephony PBX level
System > IVR messages, such as voicemail greetings in the selected language. This :
Company setting is overridden by language settings at the branch and/or individual

Settings  : extension level.

In the absence of the individual extension user's language of choice, the
-language setting of branch overrides the PBX language setting.

Phone Configure the Language setting for users to receive Telephony Branch level
System > IVR messages, such as voicemail greetings in the selected language. :
Branches In the absence of the individual extension user's language of choice, the
(Add-on branch language setting overrides the PBX company language setting. In
subscription-é other words, if an extension belongs to a branch set to Japanese, and if you
based) have not defined another language at the extension level, Telephony
IVR messages are played in the Japanese language. If the extension belongs
to a branch with no other language defined, you inherit the PBX language. '
Phone Configure the Language setting for extension users to receive Telephony Extension level
System > IVR messages, such as voicemail greetings in the selected language. The :
Edit display on the user's desk phone also appears in this language.
Individual :

This setting overrides the PBX and branch language setting.
Extension

: — Note: If you need help with setting the user language in bulk,
contact 8x8 Support for help.

Note: To access localized versions of 8x8 Virtual Office

N — applications, refer to your computer or device manual to learn
/ how you can change the display language of your operating

system.

4. Click Save Changes at the bottom of the screen.

Define Voicemail Settings
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In this pane, you can edit a specific extension's voicemail password, and set up email notification options.

To define voicemail settings:

1.

Click Expand N to display the Voicemail Settings pane:

Edit Extension @ Help

Use the Expand D and Collapse D icons to view and edit this extension. Save Changes at the bottom of the page.
Expand All

¥ Extension Information
¥ Extension Settings

= Voicemail Settings

Voicemail Password (7] Voicemail Notification Via Email Attachment Cnly L]
Voicemail-to-Email Address  nalini@gx8.com 7]
MNote: To lock or unlock the Woicemail Notification Via Email setting, you MUST
go to Edit Voicemail /Fax Notifications page to change the setting.
*When using the ‘Attachment, Delete Orig. VI nofification option, customer
assumes risk that a Voicemail can be lost if their email is mishandled for any
reason.

B Call Forwarding

¥ Extension Membership Display

¥ Communication Preferences

2.

Version 1.0

Save Changes

Enter a voicemail password.

4-15 digits long.

Voicemail Password Security Guidelines

Note: The minimum required length of the voicemail password is set in the Company Settings. It is

To secure your voicemail password, the following password restrictions are enforced. The password:

m  Should be 4-15 digits long.

= Should not use same digits such as 1111, 2222.

m  Should not use years from 1900 till present.

= Should not be of ABAB format such as 1010, 2121,3131.

m  Should not use sequential numbers such as 1234, 4567.
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=  Should not use easy to key in numbers from the center of keypad. The following numbers are not allowed -
2580, 0582, 5683 (spells LOVE).

3. Select a voicemail notification via email:
m Disable Notification: An email notification is not sent.
= Attachment Only: An email notification is sent with an audio file of the voicemail attached.

= Notification Only: An email notification is sent without an audio file or link to the voicemail (recommended
for companies requiring HIPAA compliance).

m Link & Attachment: An email notification is sent with both a link to the voicemail and an audio attachments,
plus links to Delete Voicemail and to manage multiple voicemails.

m Link Only: An email is sent with a link to the voicemail and links to Delete Voicemail and to manage
multiple voicemails.

m Attachment, Delete Orig.VM*: An email notification is sent with an audio attachment, but the original
voicemail is automatically deleted.

: _.i Note: To configure multiple extensions at once, go to the Edit Voicemail/Fax Notifications
| page.

4. Enter an email address in Voicemail-to-Email Address to notify the user of a new voicemail.

5. Click Save Changes at the bottom of the screen.

Configure Virtual Office Pro Information

If your 8x8 business account includes extensions utilizing Virtual Office Pro, you are able to edit and configure
additional features in this pane.

Version 1.0 23



8x8

1. Click Expand N

to display the Virtual Office Pro Information pane.

Edit Extension

¥ Extension Information

¥ Extension Settings

¥ Voicemail Settings

B Virtual Office Pro Information

Call Recording
Call Recording Mode
Play announcement when calls are recorded

Allow user to purchase additional dial-in numbers for Virtual
Meeting
Fax Nofification Via Email

Fax-to-Email Address

page to change the sefting.

¥ Call Forwarding
¥ Extension Membership Display

® Communicafion Preferences

@ Hep

Use the Expand (+] and Collapse (=] icons to view and edit this extension. Save Changes at the bottom of the page.

Expand All

on[v| Internet Fax Numbers
Record On-Demand| v
[] TeMe [ To Other Party

Select Fax Number

®ves Ono @
Link & Attachment (7]

ramana.gottipati@gx8 co [+ ‘
(add up to 5 email addresses)

Mote: To lock or unlock the Fax-to-Email Address setiing, you MUST go to Edit\Vioicemail /Fax Motificalions

2. Select your preferred options for the individual extension:

m Call Recording

Set up Phone Systems

Note: Additional options to restrict extensions, such as the user's ability to listen and delete
recordings, are available in the Call Recording section under the Phone System tab.

Call Recording Mode

Fax Notification Via Email

Version 1.0

Play announcement when calls are recorded

Allow user to purchase additional dial-in numbers for Virtual Office Meetings

Note: The additional dial-in numbers can be domestic, international, or toll-free.
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m Fax-to-Email Address

Notes:
-To lock or unlock the Fax-to-Email Address setting, you must go to the Edit Voicemail/Fax
Notifications page to change the setting.

-To configure multiple extensions at once, go to Edit Voicemail/Fax notifications.

m Internet Fax Numbers for Virtual Office

3. Click Save Changes at the bottom of the screen.

Set up Your Call Forwarding

Call forwarding allows you to set up rules to direct how calls are forwarded to different destinations, either sequentially
or simultaneously.

owmmes — —

prward to o d to
‘One Number External or Phone Number
Access Extension

Forward to
Voicemail

Attendant

1 Always Forward

2 Busy Forward | vl
3 Mo Answer Forward T4 | 15
4 Internet Outage Forward | [

Y ou can manage call forwarding using:
m Manage Call Forwarding: Basic Setup

m Manage Call Forwarding: User Setup

Manage Call Forwarding: Basic Setup

Call Forwarding offers control over:

m Forward to Auto Attendant: Calls are answered by the Auto Attendant. Callers can select from available
options, such as: Press 1 to leave a message, press 0 to reach an operator, etc.

m Forward to Voicemail: Callers are forwarded to a destination voicemail box, where they will hear a greeting
and/or be able to leave a message.

m Forward to One Number Access (ONA): Calls can be forwarded to up to four destinations sequentially or
simultaneously. If a call is not answered at any of the target destinations, it will then be forwarded to voicemail.
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m Forward to External Number or Internal Extension: When you select this feature, a field appears in the

Phone Number column where you can enter the number you would like the calls forwarded to.

1 Always Forward ]

Forward to 0 d to
‘One Number Extemnal or
Access Extension

Forward to
Voicemail

Phone Number

(] (=] |+

(=]

Busy Forward

To Manage Call Forwarding:

1.

Click Expand N

to display the Call Forwarding pane.

2. Select the desired options for these call forwarding types:

3.

Version 1.0

Forward Type Note

Always
Forward

If you select the Always Forward check box, all other forwarding options will be disabled. To re-
-enable them, clear the Always Forward check box.

Busy Forward

No Answer
Forward

You can also select a delay time, in seconds, for this feature. The default time is 15 seconds.

Internet
Outage
Forward

If you select Forward to One Number Access:

= Call Forwarding

Auto
Attendant

um - External or
Extension

One Number Phone Number SE nds]

1 Always Forward B @] g =]
2 Busy Forward vl
3 No Answer Forward v
4 Internet Qutage Forward v

Ring Distribution () Sequential O) Simultanecus @

Call Screening () Disabled O Enabled @

pe—E—

Passwonrd Required

i Destination Number
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Option

Note

Select whether ring distribution is Sequential or

Simultaneous.

Select whether call screening is Disabled or Enabled.

- Enabling this feature requires callers to record
: their name so you can screen their calls before
‘answering.

Enter the first destination number your calls will be forwarded to.

The number could be a phone number,

- extension number, Ring Group number, call
' queue number, etc.

Select the Voicemail Password Required check box if you
want to ensure that only you can answer forwarded calls at a

target destination.

Selecting this option means you must enter
- your voicemail password before you can answer
' the call.

Enter the number of seconds the phone will ring before

forwarding to the next destination or to voicemail.

The default time is 20 seconds.

4. Click Add < to enter more phone numbers.

5. Click Save Changes at the bottom of the screen.

Manage Call Forwarding: User Setup

Users can set up their own call forwarding rules by logging in to the Virtual Office desktop app. When you edit an

extension that already has call forwarding rules, you have the option to click Revert to Basic Call Forwarding or

Manage Call Forwarding.

Fowarding or Manage Call Forwarding.

B call Forwarding

This extension user has their call forwarding set up in Virtual Office Online. To edit these rules click on Revert to Basic Call

Revert to Basic Call Forwarding

Delete this user's call forwarding rules and set
up basic forwarding rules for this extension
here

Manage Call Forwarding

This allows you to log in as the extension user and
update their call forwarding rules in Virtual Office
Online.

= Revert to Basic Call Forwarding

Deletes the user's rules, and allows you to set up basic call forwarding by following the steps in the Manage Call

Version 1.0
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Forwarding section.
Revert to Basic Call Forwarding (%]

& Are you sure you want to revert to Basic
Call Forwarding? This deletes any call
forwarding settings this user has set up in
Virtual Office Online and Allows you to set
up basic call forwarding rules for this
extension from here.

Yes, I'm sure Cancel

Manage Call Forwarding

Allows you to log in as the user, and manage rules using the advanced options in the Virtual Office desktop app. For
more details on this feature, refer to the Virtual Office desktop app user guide.

¥ call Forwarding

This extension user has their call forwarding set up in Virtual Office Online. To edit these rules click on Revert to Basic Call
Fowarding or Manage Call Forwarding.

Revert to Basic Call Forwarding Manage Call Forwarding

Delete this user's call forwarding rules and set This allows you to log in as the extension user and
up basic 1g rules for this update their call forwarding rules in Virtual Office
here. Online.

View Extension Membership

Refer to this display-only pane to view details about:
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m The extension's services such as Call Queue, Ring Group, and Shared Lines.

= Service group extension or phone number.

Edit Extension @ Help

Use the Expand D and Collapse D icons to view and edit this extension. Save Changes at the bottomn of the page.

Expand All

¥ Extension information

¥ Vvoicemall Settings

B Virtual Office Online User Profile
¥ Call Forwarding

= Extension Membership Display

§|
|
|

Call Queue Staffing 701 Primary Extension No
Ring Group ‘Quality Contrel 2003 Cyclic No
Shared Lines 15557983628 Line 3 No

16508463020 Line 4 No

¥ Communication Preferences

Save Changes

Choose Communication Preferences

Set up Phone Systems

This pane controls all 8x8 communication preferences for each individual extension user. User can opt in or out of
receiving updates, surveys, and promotional material from 8x8.

1.

Click Expand H to open the Communication Preferences pane.

= Communication Preferences

Check to optin to the following communications:

&x8 e-newsletters B8x8 satisfaction surveys and product trials

4} £l
Helpful tips with information on the latest news and features. Y nvite me to give feedback and try new products.

Product and promotion emails 0 Monthly bill notification (Admins only)
Emails about new products, special discounts and offers. ~  Email me when my monthly bill is available for viewing.

Users can update their communication preferences in their Virtual Office Online Accounts.
Note: 8x8 reserves the right to contact you regarding service, feature or policy announcements and information about your account.

2. Select or deselect options to determine whether the extension user receives the following communications from

Version 1.0

8x8 services:
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8x8 newsletters

m Product and promotion emails
m 8x8 satisfaction surveys and product trials
= Monthly bill notifications (administrator-only option)

Click Save Changes at the bottom of the screen.

F p— Note: Refer to Configure Company Settings to view and modify the company's preferences at the PBX

| — level.

Edit Multiple Extensions

By editing multiple extensions, you can:

Change the caller ID first and last name.

Hide the extension in the Auto Attendant when callers access the Company Directory or Dial-by-Name options.
Allow the extension users to select their own Music on Hold from the company library via the Virtual Office desktop
app.

Allow the extension users to view their billing statements in the Virtual Office desktop app.

Allow the extension users to access the Virtual Office desktop app.

Allow the extension users to access the Virtual Office mobile app.

Select a phone number to be displayed for outgoing calls.

.................................................................................................................................

.................................................................................................................................

Select time zones for phone display and voicemail time stamp.

Enter an emergency service address for emergency services. The address for each user must be accurate and
verified. This is needed whenever someone makes an emergency call from that extension.

Select a preferred Codec for upload and download bandwidth, voice quality, and compatibility with 8x8 devices.

To edit multiple extensions:
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1. Click Phone System in the top navigation bar.

2. Click Edit Multiple Extensions.

HOME ( PHONE SYSTEM I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyword

Extensions
PHONE SYSTEM

» Extensions. Quick Find / Edit Extension
> Auto Attendant m Enter extension number, phone number or caller ID.
? Virtual and Toll-Free

Numbers

> Ring Groups

» Company Settings Extensions Extensions Numbers Recordings Optians
» Number Transfer
> Edit Voicemail / Fax

Hotesons Dowrioas

Phane
System
Setup

Search

@ Helo

Set up Phone Systems

3. Using the gray navigation bar, configure options such as caller ID name, visibility in Auto Attendant, social

networks, hold music, billing statements, outgoing call number, and time zone.

4. Select or clear a check box in the top row to apply the change to the entire column.

de mn
Auto on Billing Virtual
Attendant Hold Stateme Office

Edit Multiple Extensions @ Help

Edit extensions as needed and click Save.

First [4] 1-10 of 223 [»] Last Extensions Per Page |10 ¥
Ex Phone Numbe: B : H \ y

oS0 (555) 000-6893 test (] (] (] ] ] (555) D00-6B93 (x0S0) USiEastern
1004 (555) 000-68%5 testemail ] ) )] )] ] (555) DOD-656 (x1004) US/Eastern
1005 (555) 0DD-BB57 testemail12 [m] 7} [m] 7] Il (555) DOD-6897 (x1005) US/Eastern
1008 (555) 0DD-8421 Unassigned ] ¥ ] [+ [+ (555) DOD-8421 (x1006) Afric a/Abidj
1007 (55%) 0003422 [Abigail o o 3 3 @ | (555) 000-8422 (x1007) USiEastern
1008 JEEE)L NON 84733 i A ELE)L OO0 9479 ETatiT-11 h
[ »

[Save [ Carcel|

5. Select the Enable Virtual Office check box to allow extension user access to the Virtual Office desktop app and

Virtual Office online app.

6. Select the Enable Virtual Office Mobile check box to allow extension user access to the Virtual Office mobile

app.

Version 1.0
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7. Click Save to apply your changes.

Note: Additional extension features can be configured by the phone administrator or by the
individual extension user.

Change Extension Numbers

The default extensions in 8x8 Virtual Office start at 1001. The Change Extension Numbers feature allows you to

change a selected individual extension number, or customize multiple extensions at once. You can change the

extensions to eight-digit numbers, for example, or start at 2001. You can enter a new extension number, or simply use
+=

auto-suggest  for the system to suggest one. The Extension Usage Map on the right side of the screen provides a

list of available and reserved extensions for your reference.

To change extension numbers:
1. Click Phone System in the top navigation bar.

2. Click Change Extension Number.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyword E=a

Extensions @ Help
PHONE SYSTEM

» Extensions Quick Find / Edit Extension
» Auto Altendant | Search | Enter extension number, phone number or caller ID.
> Virtual and Tol-Free
Humbers
> Ring Groups

> Company Seflings Extensions Extensions Numbers Recordings Options
> Number Transfer A
> Edit Voicemail | Fax o

[ View |

Phone
System
*y Selup
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3. Referto the Extension Usage Map to see available extension numbers.

Change Extensions

@ Help

Use the extension map to the right to select a new extension or range of extensions. Check the

extensions you would like to update. If you would like all extensions to be updated, make sure they are

all checked. Enter a preferred extension range and click Go. The system will suggest a range of

extension numbers available.

Suggest extensions for all regular voice lines to start at

Select All | Deselect All

Update Extension Type Extension New Extension
[} Unlimited Extersion 1001 <3
] Metered Extansion 1002 <3
L] Uniimited Extension 1003 <
[C] Global Extension 1008 %5
] Shared Extension 1005 4=
2] Basic Extension 1006 -+
] Unlimited Extersion 1007 &
2] Overhead Paging 1008 +
] Unlimited Extersion 1008 <3
L] Shared Extension 1010 <
] Ring Group Extn 2002 <3
2] Ring Group Exin 2003 43
] Virtual Extension 3001 h=l
e

Save Changes

Extension Usage Map

9-9: Reserved

90 - 89: Reserved

200 - 200: Reserved

400 - 443: Reserved

444 - 444: Resarved for Auto Attendant
445 - 499: Reserved

500 - 500: Reserved for Voice Mal
501 - 555: Resarved

556 - 556: Reserved for Conference Bridge

557 - 699: Reserved

700 - T10: Avallable

711 - T11: Reserved

2000 - 2000: Reserved for Ring Group

4440 - 4490 Reserved for Additional Auto Attendant

4500 - T999: Avallable

B00O - 9999: Reserved

4. To change multiple extensions:

Version 1.0

m Deselect all extensions by selecting the Update check box.

Set up Phone Systems

= Enter a starting number in the field provided, and click Go. We suggest regular voice lines start at 5001.

Change Extensionsl

Extension Type

Use the extension map to the right to select a new extension or range of extensions. Check the
extensions you would like to update. If you would like all extensions to be updated, make sure they are
all checked. Enter a preferred extension range and click Go. The system will suggest a range of
extension numbers available.

Unlimited Extension
Unlimited Extension
Fi Unlimited Extension 1003
Fi Unlimited Extension 1004
7 Unlimited Extension 1005

33



Setup Phone Systems
8x8

Note: Only regular lines are changed. Shared Lines, Call Queues, and Ring Groups must be

changed individually.

5. To change individual extensions:
m Select the check box next to the extension(s) you want to change.

m Enter an available number in the New Extension column, or click the Suggest icon to see the next available
extension number in the same range.

6. Click Save Changes at the bottom of the screen.

Reset Extensions

You can select an individual extension to reset to its default settings. This does not delete or clear the user profile and
extension, but only resets settings such as ONA rules, forwarding rules, voicemail greetings, messages, password, and

SO on.

To reset an extension:
1. GotoPhone System in the top navigation bar.

2. Click View All Extensions.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyviord B

@ Help

PHONE SYSTEM Extensions

» Extensions

? Aulo Attendant Quick Find / Edit Extension

3 Virtual and Toll-Free
el IEZEN IEEEN enter extension number, phone number or caller ID.

» Ring Groups
» Music on Hold

s View All Edit Multiple Change Extension Download Cail Outbound Calling

» Shared Lines Extensions. [ Numbers. Recordings Options

» Switchboard Py
» Paging @ S
» Company Seftings o =

¥ Number Transfer
onigure

» Call Recording

> Edit Voicemail / Fax
Hofifications.

g
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3. Click Edit next to the extension you want to edit.

HOME ||PHGNE SYSTEM I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Manage Extensions

Enter keyword

PHONE SYSTEM

> Extensions
» Auto Attendant
3 Virtual and Tol-Free

Manage Extensions

@ Help

Below is an overview of all extensions. You may edit the extension details individually be clicking Edit next to each extension or as a group by clicking on Edit

Multiple Extensions.

Edit Multiple Extensions | Change Extension Number | Download Call Recordings |

Download Extensions (csv) | Download Activation Codes

Actio

service Type

——

Caller I
Last Name

Set up Phone Systems

eriD
Humbers First Name
¥ Ring Groups
 Music on Hokd Edit | Activate Device Pending  Unlimited Extension 1001 (210)500-1794  John Smith Polycom SoundPeint IP 335 nalini@8x8.com -
» Company Seffings Edit | Active  Unlimited Extension 1002 (210)500-1795  Rob Shasta Virtual Office Softphane mfadase@8x8.com
¥ Number Transfer I Edit | I Ative Uniimited Extension 1003 (850)000-0000 Unassigned  Unassigned  Virtual Office Softphone nalini@8x8.com
> Call Recordi
- Edit | Active Unlimited Extension 1004 (850) 000-0010  Unassigned  Unassigned  Virtual Office Sofiphone nalini@8xe.com e
¥ Edit Vioicemall  Fax -
4 L

Phone
System
Setup

4. If necessary, click Expand  to view and edit the Extension Information pane.

HOME \IPHONE SYSTEMI\ CONTACT CENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Phone System > WManage Extensions = Edit Extension Enter keywo
Edit Extension @ Help
PHONE SYSTEM
Use the Expand & and Collapse [ icons to view and edit this extension. Save Changes at the bottom of the page.
¥ Auto Attendant Expand All
¥ \irtual and Toll-Free . -
Mumbers ¥ Extension Information

¥ Ring Groups
> Music on Hokd
¥ Call Quaues

¥ Extension Settings

¥ Voicemail Settings
¥ Branches
3 Switchboard B Virtual Office Pro Information
> Company Settings

¥ Number Transfer
Request

¥ Call Forwarding

> Call Recording

> Edit Voic email / Fax
Motific ations

¥ Extension Membership Display

¥ Communication Preferences
» Group Call Pickup

¥ Call Park Extensicns ¥ Barge Permissions

Save Changes

5. Inthe Extension Information pane, click Reset Extension.

6. Accept the confirmation prompt to reset the extension.

Define Outbound Calling Options

For your PBX outbound calls and IVR language, you can set your default calling option as domestic, international, or
emergency calls. You can apply the calling option to all your extensions at once, or configure each extension
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individually.

To define outbound calling options:

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Outbound Calling Options.

PHOMNE SYSTEM

¥ Extensions
? Auto Attendant

? Virtusl and
Toll-Free Numbers

¥ Ring Groups

? Music en Hold

¥ Call Quaues

? Shared Lines

? Switchboard

3 Paging

? Company Settings
? Humber Transfer
¥ Call Recording

> Edit Voicemail /
Fax Notifications

HOME PHOMNE SYSTEM BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System = Extensions

Extensions

Quick Find / Edit Extension

Enter extension number, phone number or caller 1D.

View All Edit Multiple ‘Change Extension Download Call
Extensions Extensions Numbers Recordings

Enter keyward

Edit Lists

@ Hep

Setup Phone Systems

3. You can define the outbound calling options at the PBX level using the PBX defaults drop-down menu.

OR

Click the link under Calling Options to define outbound calling options for any individual extension.

Version 1.0
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Outbound Calling Options

Outbound Calling Options | Domestic (in country) Calling A
Service Country United States

Edit Outbound Calling Options x

B PBX Defaults

¥ Extension Outbound Calling Options

- . — Select the Outbound Calling Options for this
extension,

1001 (650} 646-3018 Domestic (in country) Calling v | 650 Domestic (in country) Calling
T ———— PEX Default
1002  (550)648-2088 Domestec (in country) Caling 1850 Domestic {in country) Caling
1003 (850)646-2002 Allow International Calling OK | Cancel BRCEE Domestic (in country) Calling
\. Only Emergency Calling
1004 (650) 648-3008 Saran Thon INTERMATIONAL_USO SUNNYVALE 1650 Domestic (in country) Calling
1005 (650) 648-3020 Suzy White United States SUNNYVALE 1650 Do n country) Calling
1006 (555) 6480703 Specialty Cookies United States SUMNYVALE 1555 Dome: country) Calling
1007 (408)627-8740  Jean Andje United States SUMNNYVALE 1408 Domestic (in country) Calling
1008 (408) 328-7T176 Ramana Gottipati United States SUMMYVALE 1408 Allow International Calling
1010 (555) T98-3528 Sharing FromAccounting United States SUMMYVALE 1555 Domestic (in country) Calling
1011 (#08) 328-7138 Beth Camey United States SUMMYVALE 1408 Allow International Caliing

| Save [ Cancel |

Set up Phone Systems

The available options for outbound calling include domestic, international, and emergency calling. Based on your

service, US English or UK English languages may become available to you.

Manage Call Recording

8x8 Virtual Office Pro users can record, delete, and listen to calls from their extensions. Phone system administrators

can configure call recording settings by individual extension, or in bulk at the PBX level. Branch administrators can

access, delete, and listen to recordings made by users within their branch.

Version 1.0
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1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Call Recording.

Account Manager Company Name: Speciakty Coakies | Main Number: (510) 962-5321
% 8x8, Inc. Welcome, Phillip U | Sign Out
Email: pliu@&xs.com Account: Business ~

Edit My Profis

HOME i PHONE SYSTEM BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Hame > Phone System > Call Recording Settings. Emter reyword EX
Virtual Office Call Recording Settings Qe
PHONE SYSTEM
Set the call recording settings for individusl or ll extensions and dlick Save. Download Call Recorangs

» Extensions

> Auke Attendant

¥ Virual and Toll-Free
Mumibers.

» Ring Groups.
3 Music on Hald

3 Call Queves.
> Shared Lines,

> Switchboard 1001 (850)645-3018  Fhilip Lu o [~ ] [m] o [} m] o
P

)2:":;,,,%,“ 1003 (850545292 Sersh Thomas Record On.Demand [w] O O (m] o o o
> tumer Transier

1004 (8506453006  Phiip ™ Record On-Demand [ ] [m] [m] = (] (m] =]

3. Configure the following options for all extensions.
m Recording Mode: Recording mode sets the frequency of recorded calls to Off, Always Record, or Record
On-Demand.
m Play Announcement When Calls Are Recorded: Plays announcement either To Other Party or To
Extension User.
m Restrict Extension User Access To: Determines whether users can Enable/Disable Recording,

Change Announcement Settings, Delete Recordings, or Listen to Recordings.

4. Click Save to apply your changes.

Note: Select a check box in the header row to select and apply a change to all extensions.

Download Call Recording

If your 8x8 corporate account includes Virtual Office Pro, users can record calls from their extensions. Users and their
branch administrators can access and download call recordings. Extensions users can access their call recordings via
Virtual Office desktop app, while administrators can access recordings of extension users from Account Manager.

To download call recordings:
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1. Click Phone System in the top navigation bar.

2. Click Download Call Recording.

HOME | PHONE SYSTEM || BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyword Search
Extensions @ Help
PHONE SYSTEM
3 Extensions Quick Find / Edit Extension
» Auto Attendant EZIEN IEEZEN enter extension number, phone number or caller ID.
? Virtual and Tol-Free
Numbers

> Ring Groups

> Company Seftings Extensions Extensions Numbers Recordings Options
¥ Number Transfer
¥ Edit Voicemail / Fax -

[ View | [ Eat |

Phone
System
Setup

3. Select your filtering options. Enter the desired date range, time zone, and select the desired extensions. If you are

a branch administrator, you will see the extensions assigned to the branch only.

Download Call Recordings @ Help

Use the filter below to search for Virtual Office Pro extension call recordings. You must enter at least one search option.

Search Options

Date Extensions

Start Date [ select All
Sep 202011 08:12AM |5

[_] Accountant Annie (555) 792-4896 EXT 1009

End Date [] Becky Carmichael (650) 646-2988 EXT 1002
Sep 20 2011 08:12AM | () Lobby Manager (650) 646-3018 EXT 1001

Time Zone ) Diana Jay Smith (555) 648-0703 EXT 1006
USEa ) Ron Nader (408) 627-8740 EXT 1007 -
stern $ a
) shirley Beckmann (650) 646-3006 EXT 1004 3

1 Ml cnk Sl (S EAL S48 AAAD EWT 4AA%

Note: You must select at least one extension.

4. Click Search.
The search results are displayed.

5. Select the check box next to the recording(s) you want to access.
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6. When you access the recordings:

m Tolisten to a single recording at your desktop, click Play next to the desired recording.

m To download a single recording to your computer, click Download next to the desired recording.

To download the selected recording(s) to your computer, click Download Recordings.

To delete the selected recording(s), click Delete Recordings.

IDswmlaa:i Recordings | Delete Recordings I

First [4] 1-100 of 855 [¥] Last Recordings Per Page | 100 ¥
| From To Call Recording Date and Time ~ Call Direction  Call Duration  Recording Size (MB)

Rob Shasta 1020 01-27-2017 18:12:03 Outbound 00:03:38 16624 Play / Download

Sarah Thomas 1023 01-27-2017 19:07:29 Outbound 00:04:01 1.8417 Play / Download

Lisa Black 1029 01-27-2017 19:05:32 Outbound 000121 08177 Play / Download

Create an Auto Attendant Profile

Auto Attendant is a service that acts as an automated receptionist. Through profiles and rules, you can select which
phone menu options and recordings are used at specific times for callers to route themselves to an appropriate
destination. Auto Attendant profiles are created to define menu options and recordings for specific situations. Every
profile has rules associated with it. The rules define call flow and menu recordings within certain parameters.

Step 1: Create a New Auto Attendant Profile

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Auto Attendant.
3. Click Create Auto Attendant Profile.

PHONE SYSTEM

> Extensions

Home > Phone System > Auto Attendant Ea

Auto Attendant @ Help

The Auto Attendant is @ powerful automated service that replaces the need for a receptionist. You can create multiple profiles for your auto attendant to make it easy to

> Virtual and Tol-Free
Numbers

* Ring Groups
» Music on Hokd

» Call Queves

» Shared Lines

» Branches

» Switchboard

» Paging

» Company Settings

> Number Transfer
Request

» Call Recording

¥ Edit \ioic email / Fax
Notfications

» Group Call Pickup
» Call Park Extensions

switch between specific schedules and recordings.
I » Auto Attendant I

Create Auto Attendant Profile
SummerProfie 08152011 17:58:42  |On | Tum OFf | Edit|| Select v
FalProfile 08-08-201108:32:10  |OF  |TumOn | Edit|| Select v
Holiday Profile 08-25-2011 16:18:57  |OF | Tum On | Edit|| Select v

?ne;r"z'z%“me; (856) 950-6772, (556) 054-7455 | 444

WinterProfile 08122011 10:43:45  |OF  |Tum On | Edit|| Select v
business hours 10.05-2011 134628 |OF  |Tum On | Edit|| Select v
Techpub 10-14-2015 14:52:02 of Turn On | Edit| | Select v
Thanksgiving Holidays | 10-21-201513:17:22 | OF | Turn On | Edit || Select v

Need more Auto Attendants? Call your Account Manager or 8x8 Sales at (866) 879-8647.
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4. Review the Auto Attendant Profile Overview and complete the Auto Attendant Worksheet to outline how you
would like inbound calls directed when they reach the Auto Attendant. This step is optional. You can use this
worksheet to create your Auto Attendant rules.

WORK SHEET

88 8x8,Inc.

Auto Attendant Worksheet

inbound calls to b

Us ey reach the Auto Attendant. Then use the online
Normal Business Hours
What hours is your business open?
Day Open Time Close Time
Saturday
Business Hours Rules and Greeting
How would you like incoming calls to be directed during business hours?
g your normal business hours. Each menu can use numbers 0 thiough 3,
Create Auto Attendant Profile @ Help
Business Hours Greeting Example: Enter your script here:
The 8x8 Auto Attendant processes your incoming phone calls by allowing callers to self-direct their call to the options presented using @ pre-recorded s s ter v pthere:
recording. o o o
B begin
P en they call v
to the setup process. We
A

Now outline your menu actions. You can have from ane o Up to ten optins
e General Auto
Attendant Rules and Recordings Rules Example:
el Press  Description Action
@ fechnical Support up
@ |sa
3 in
a
‘Sub Menu (5) ]
e )
)

|
R o0ical 2H

Holiday Hours

ElEIEIE]

5. Once you are ready to configure your Auto Attendant, click Continue at the bottom of the page.

Name your Auto Attendant profile, and select the appropriate time zone.

Create Auto Attendant Profile @ help
STEPS: Profile Information » Hours of Operation » Business Hours » After Hours » Lunch Hours » Holiday Hours » Recordings

f Name Your Profile and Select Time Zone
~

,,‘ After entering the information below, click MNext to proceed to the next step.

Auto Attendant Name SpecialtyCookies

Auto Attendant Extension 444

Profile Name Summer Profile

Branch Office All Extensions v
Time Zone * UsS/Pacific A

* Required Field
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7. Click Next.

Step 2: Define Hours of Operation

You can define business hours and holiday hours.

To select business hour type:
m Select 24/7 Business Hours to define menus and recordings to be used at all times.

m Select Define Business Hours to create unique menu options and recordings for different times of the day such
as normal business hours, non-business hours, etc.

STEPS: Profile Information » Hours of Operation » Business Hours » After Hours » Lunch Hours » Holiday Hours » Recordings

@ Define Your Business Hours of Operation

Your Auto Attendant has multiple options for creating call flows based on day and time. Define your hours of operation below and then click Next.

Auto Attendant | Extension | Profile Name | Time Zone
Specialty Cookies | 444 | Summer Profile | US/Pacific

To create sep menus and gs for © 2477 Business Hours
when your business is open and when itis
closed, click Define Business Hours. To create
menus and recordings 1o be used at all times,
click 24/7 Business Hours.

Define Business Hours

Holiday Hours (Optional)

To create additi menus and dings to be used
‘when your business is closed for a holiday, enter dales
below (example: Jan, 1, 2013, New Year's Day). Use the ]
and ° butions 1o add and delele Holldays.

®

You can create additional menus and recordings for closed business hours such as holidays. This is optional, and
particularly useful if you decide to go with 24/7 Business Hours.

To define business hours:
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1. Click the drop-down arrows to set your business hours for each day of the week.

Create Auto Attendant Profile @ Help

STEPS: Profile Information » Hours of Operation » Business Hours » After Hours » Lunch Hours » Holiday Hours » Recordings

® Define Your Business Hours of Operation

Your Auto Attendant has multiple options for creating call flows based on day and time. Define your hours of operation below and then click Next.

Auto Attendant | Extension | Profile Name | Time Zone
Specialty Cookies | 444 | | Us/Pacific

Business Hours

To create separate menus and recordings for () 2417 Business Hours s o e

when your business is open and when it is @) Define Business Hours Week Day Start Timi - End Time_SIanTime End Time
closed, click Define Business Hours. To create Sunday L 4

menus and recordings to be used at all times,

click 24/7 Business Hours. Monday 08:00AN & | 05:00PH & (05:01PM  07:59AM

Tuesday | 0g.00AN & | 05:00P) & D501PM  O7:59AM

Note : Editing your Business Hours will

automatically change your After Hours. If your Wednesday | gg:00AN ¢ || o5:00P] ¢ JP5:01PM  07:59AM

business is closed on a particular day, leave Thursda : 2 5:01PM  07:59AM
Business Hours blank. The system will ¥ 08:00AM & | 05:00PN +
automatically use your After Hours menus and Frida 8 = 5:01PM  07:59AM
recordings on these days. Y 0B:00AM & || 05:00PH &
Saturday . .
v v
Lunch Hour (Optional) Business Hour Exceptions (Optional) Holiday Hours (Optional)
To create additional menus and Business Hour Exceptions allows you to temporarily modify the To create additional menus and recordings to be used
recordings for a dedicated lunch period, regular Business Hours defined above. Use the & and when your business is closed for a holiday, enter dates
enter hours below. buttons to add and delete exceptions. below (example: Jan, 1, 2013, New Year's Day). Use the &

and ° buttons to add and delete Holidays.
Week Day StartTime EndTime

Sunday : :
Monday + B @ 8
Tuesday ¥ :
Wednesday = =
Thursday = —
Friday v :
Saturday ¥ :

<Bac

Hours option.

3. Click Next to continue.

Version 1.0
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Step 3: Define Rules for Business Hours

Define the action the Auto Attendant should take when the option is selected by the user.

1.

Enter your phone menu rules for Business Hours:

a.
b.

C.

Select a Key.
Enter a Description of the function that key will enable.

Select a Call Routing function for the key you selected.

Drace
Key 9 E| Dial by Extension Dial By Extension E|

Clicklﬂ'.'1 and e to add and delete key settings.

Draft a script for your menu recording. You will have the opportunity to create or upload a menu recording
after the profile is created.

2. When you have finished configuring your business hour rules, click Next or Create Profile.

If applicable, repeat steps 1-2 above to configure menus for after hours, lunch hour and holiday hours.

When you are finished, click Create Profile.

Once you have created an Auto Attendant profile, you can create or upload recordings for each menu.

Step 4: Upload Recordings

You can choose to upload an existing recording or create a new one:
To upload a recording

To upload a recording, see Step 1: Create a New Auto Attendant Profile.

Version 1.0
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1. Toupload an .au, .wav, .vox, or .mp3 file from your computer:

Create Auto Attendant Profile i@ Help

STEPS: Profile ion » Hours of Operation » i Hours » After Hours » Lunch Hours » Holiday Hours » Recordings

Auto Attendant | Extension | Profile Name | Time Zone
Specialty Cookies | 444 1 | Us/Pacific

l Create or Upload Recordings
i

‘Your Auta Attendant profile has been created. Create ar upload your recordings for each menw. To have your audia prafessionally recorded, visit the
Audio Production S1ore. Once you have uploaded or recorded your recording, click the phone icon to test your meny,

Business Hours Menu [ Gorgumaion

Upload | Record | Edit/ Print Script | Test Menu CJ‘J‘;

Gantgens
Ic:l‘_l\.
o
'c.\\
1)
Configure

<k Gors

Click Upload under the appropriate menu.

Click the Add button.

T o

1

Select the audio file you want to upload.
d. Click Upload.

Accepted Formats .au, wav, voxand .mp3
File Restrictions. Upload one file at a time; No larger than 10MB

File Name

Set this recording as Active o
By Clicking the “1 Agree” button,
|, qatestblee2 gatestblee2 certify that the file | am uploading is not copyright protected. | certify that | have the right
to use this file legally. In case the file is deemed 1o be in violation of US copyright laws, | will be held responsible, 8x8

will notin any way be responsible for copyright violation, By signing below, | will be taking full responsibility for any
lawsuits regarding the file | am uploading and | will be held accountable in a court of law.

Date08-22-2012

e. Review the electronic signature text, and click | Agree.

f.  When the dialog box appears confirming that you have successfully uploaded the greeting, click OK.
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2. To test your new recording and menu options, click the Test Menu icon and follow prompts
To create your own menu recording
1. Torecord a menu:
a. (Optional) Click Edit/Print Script under the appropriate menu heading to draft or edit a previously written
script. Click Print to have a hard copy of the script available while you are recording your menu.

b. Click Record.

c. Enter your 10-digit phone number and click Start Recording.

Record Custom Greeting 0

You can record your greeting through your phone. Simply enter your 10-digit phone number
and click Start Recording. When you are done, click Done Recording to Stop recording
and hang up. You will then be taken back to the Manage Greeting section.

[ Enter Your Phone Number - -
; umbers on

Format : area code and phone number
Example : 408 555 1212

Start Recording |

d. When the dialog box appears confirming that the system is calling your phone number, click OK.
The system will call you at the number you entered. When the phone rings, answer it and follow the voice
prompts to record your menu recording.

e. Click Done Recording when you are finished.

f. When the dialog box appears confirming that you successfully recorded your greeting, click OK.

2. Totest your new recording and menu options, click Test Menu , and follow the prompts .

Step 5: Activate Your New Auto Attendant Profile
1. Return to the main Auto Attendant page.
2. Locate the profile you created in the list.

3. Click Turn On to activate your profile.
You have successfully configured your Auto Attendant.
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4. Click Phone System Setup to return to the Phone System Setup page.

Phone
System
Setup

Editing an Auto Attendant Profile

You can make changes to an existing Auto Attendant, test the menu options, print recording scripts, or delete the Auto

Attendant.

To

edit an Auto Attendant profile:

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Auto Attendant.

3. Locate the profile you want to modify in the list, and click Edit.

Auto Attendant

@ Help

The Auto Attendant is a powerful automated service that replaces the need for a receptionist. You can create multiple profiles for your auto attendant to make it

easy to switch between specific schedules and greetings.

Create Auto Attendant Profile

SummerProfile

08-15-2011

Turn Off

Edit

Select

.
-

FallProfile

09-08-2011

Turn On

Edit

Select

&
H

Setup Phone Systems

Note: If you try to edit an active profile, the system asks you whether you want to make a copy of
the profile before proceeding. This is to ensure you do not lose the desired information or functions.

You can proceed with or without copying.

Version 1.0
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4. Click Expand N and Collapse N to view and edit the panes.

Edit Auto Attendant @ Help

Use the Expand D and Collapse Dicons to make any changes to this Auto Attendant profile. When done, click Save
Expand All

¥ |Auto Attendant Information
-

¥ |Hours of operation
=
¥ |Business Hours Rules and Recordings

¥ |After Hours Rules and Recordings

¥ |Lunch Hours Rules and Recordings

¥ Holiday Hours Rules and Recordings

Set up Phone Systems

day.

Note: If you selected 24/7 Business Hours when configuring Auto Attendant, you cannot edit or
configure rules for After Hours, Lunch Hour, or Holiday Hours. 24/7 applies to all hours, every

5. After entering your changes in any of the panes, click Save.

To delete, copy or test Auto Attendant profile:

Delete, copy, test a profile, or print recording scripts, by clicking the drop-down arrows on the main Auto Attendant

page.

PHONE

> Virtual

> Group

> Extensions
> Auto Attendant

Humbers
¥ Ring Groups
> Music on Hold

» Call Queuss SummerProfile 09.15-201117:58:42  [On  [TurnOff | Edit {f Select v
% Shared Lines Select
3 Branches FalProfile 09-08201108:32:10 o [Turnon | Edit MECECNREIE
> Switc hboard - %;y;nrz\ﬁelg
Holiday Profie 08-25.2011 16:18:57  [off  [Turn©On | Edit [§ T

» Paging gﬁg%’z%ﬁg (856) 950-6772, (556) 054-7455 444 Print Greeting scripts.
> Company Seftings WinterProfile 09-12-201110:4345  [OF  |TurnOn | Edit|| Select v
> Number Transfer

Reguest business heurs 10-05-2011 13:46:20  |Off | Turn On | Edit || Select v

> Call Recording

> Edit Voic email | Fax Techpub 10-14201514:5202  [OfF  |TurnOn | Edit|| Select v
Notifications

Auto Attendant @ Help
SYSTEM

The Auto Attendant is @ powerful automated service that replaces the need for a receptionist. You can create multiple profiles for your auto attendant to make it easy to
switch between specific schedules and recordings.

and TollFree

Attendant

Create Auto Attendant Profile

Call Pickup Thanksgiving Holidays | 10-21-2015 13:17.22 off Turn Cn | Edit || Select v
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Configure Company Settings

Set up Phone Systems

Y ou can configure settings for phone system, company name, caller ID, SMS and IM, time zone, voicemail, and more

for your company under Company Settings.

Phone System Name, Language, and Caller ID

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Company Settings.

HOME | PHONE SYSTEM | BILLING | REPORTING | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Version 1.0

Hame = Phone System > Company Settings Enter ke
Edit Company Settings @ Help

PHONE SYSTEM

» Extensions
¥ Auto Attendant

¥ Viirtual and Toll-Free
Numbers

> Ring Groups

¥ Music on Hold

¥ Call Queues

> Branches

> Switchboard

¥ Company Settings

¥ Number Transfer
Request

> Call Recording

¥ Edit “oic email / Fax
Motific ations

> Group Cal Pickup
> Call Park Extensions

Phons
System
Setup

Phone System Name

Current Phone System Name Acmelets
New Phone System Name acmejetsine (7]

Language

Language | English (U.S.)

o

)
&
g
]
=}

o

Company Name AcmelJets, Inc
Main Number

o

:
|

Enable M + @ Allow Saving Message History
Enable SMS v @ Allow Deletion of Message History

<

e
[OR)]

®

g
N
g

Selecting Time Zone controls the PBX default time zone. PBX default time zane affects the Virtual Office Analytics reports below. By changing the time zone here,
time zone on the reports changes.

* Company summary
* Extensions summary
*DID Calls

All other Analytics reports have time zone selection from the report's user interface

US/Eastern v
Extension Dial Plan Settings

Extension Length o

Phone System Access Code (7]

Setting for Branch Code is under Branches [[CEEIIEY ©

Voicemail Password Length Setting

(]

Minimum voicemail password length 4 v

® Communication Preferences
B Corporate Directory

B System Call Recording

B Voicemail Display in Virtual Office Online

Note: 8x8 reserves the right to contact you regarding service, feature or policy announcements and information about your account.

Ea =
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3. Your company's phone system name, caller ID information, messaging settings, and time zone are displayed.

Enter a New Phone System Name if you wish to rename your current phone system.

Enter a new Company Name for your caller ID, if applicable.

8x8.

Select a Language from the list.
This setting determines the language of the Telephony IVR messages such as voicemail greetings. You can also
set the language for each user at the extension level. The extension level setting overrides the PBX-level setting.

! S Note: The PBX language does not affect the agent's desk phone display. You need to select the
preferred language for the individual extension. For details, refer to Edit Individual Extensions.

Review the following table for the available localization settings.
Summary of Localization Settings

The following table summarizes the localization settings in Account Manager:

Setting Description éConfigured At
Edit My The primary or secondary administrators who have access to Account User level
Profile - Manager can configure the Language setting in Edit My Profile to

: communicate emails in their language of choice.

This setting overrides the default PBX or branch language setting. It only
applies to the administrator's email communications.

Account > Configure the Language setting for extension users to communicate emails ini User level

User their language of choice.

Profiles This setting in user profile overrides the default PBX or branch language. It

- only applies to the user's email communications.

Phone Configure the Language setting for all users in the PBX to receive Telephony PBX level
System > VR messages, such as voicemail greetings in the selected language. This
Company : setting is overridden by language settings at the branch and/or individual

Version 1.0
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Setting Description éConfigured At

Settings ' extension level.

In the absence of the individual extension user's language of choice, the
language setting of branch overrides the PBX language setting.

Phone Configure the Language setting for users to receive Telephony Branch level
System > IVR messages, such as voicemail greetings in the selected language. :
Branches In the absence of the individual extension user's language of choice, the
(Add-on branch language setting overrides the PBX company language setting. In
subscription-é other words, if an extension belongs to a branch set to Japanese, and if you
based) have not defined another language at the extension level, Telephony
IVR messages are played in the Japanese language. If the extension belongs
to a branch with no other language defined, you inherit the PBX language. '
Phone Configure the Language setting for extension users to receive Telephony Extension level
System > IVR messages, such as voicemail greetings in the selected language. The :
Edit display on the user's desk phone also appears in this language.
Individual :

This setting overrides the PBX and branch language setting.
Extension

? Note: If you need help with setting the user language in bulk,
- contact 8x8 Support for help.

] Note: To access localized versions of 8x8 Virtual Office
? applications, refer to your computer or device manual to learn

/ how you can change the display language of your operating
system.

6. Click the Main Number drop-down arrow to select a new main number for your company, if desired.

Company Name |Specialty Cookies (7]

IMaIn Number Shirley Beckmann. Ext 1004, (650) 646-3006 . 0

7. Click Save.
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IMand SMS Messaging

When you enable IM and SMS messaging at the PBX level, 8x8 Virtual Office provides messaging access to your
company contacts. Once IM or SMS are enabled, agents can save and delete message history. Agents can then send
instant messages to one or multiple contacts, whether in the same conversation or separate conversations. They can
also view message history and export the conversations as text files.

Enable M + @ Allow Saving Message History = 7]
Enable SMS '+ 0 Allow Deleting Messaging History 7 0
Time Zone

Select a Time Zone to control the PBX default time zone. PBX default time zone affects the Virtual Office Analytics
reports:

= Company summary
m Extensions summary
= DID Calls

By changing the time zone here, time zone on the reports changes. Other Analytics reports have time zone selection
from the report’s user interface.

Extension Dial Plan Settings

Z _ﬁ Note: Extension dial plan settings are only applicable to enterprise customers with multiple PBXs and
= = branches.

In Extension Dial Plan Settings, enter the following:

m Extension Length: The combined length of the branch code and short code. For example, if the short code is four
digits long and the branch code is two digits long, then you must allow six-digit extension length.

m Phone System Access code: Identifies the PBX and is used for inter-PBX dialing. An access code must have
the same number of digits across all PBXs.
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Extension Dial Plan Settings
Extension Length 7
Phone System Access Code 17

Setting for Branch Code is under Branches FeRil=le1[8 =5 (7]

Voicemail Password Length Setting

Minimum voicemail password length 4 (7]

¥ Communication Preferences

B Corporate Directory

B System Call Recording

B Voicemail Display in Virtual Office Online

Mote: 8x8 reserves the right to contact you regarding service, feature or policy announcements and information about your account.

[Save I Carce'|

...........................................................................................................

Click Go to Branches to define or edit a branch code.

Voicemail Password Length Setting

Set up Phone Systems

Note: All PBXs within the company must be assigned a phone system access code.

......................

In Voicemail Password Length Setting, you can set the minimum required length for voicemail passwords. The
minimum chosen also affects passwords for Ring Groups and Call Queues. Changes to this setting do not impact

existing passwords, but take effect the next time the password is changed.

Communication Preferences

Go to Accounts > Communication Preferences to configure the company's preferences at the PBX or extension
level. The settings override the selected individual extension user's settings. Extension users, however, can update

Version 1.0
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their preferences in the Virtual Office desktop app.

88 8x8,Inc.

Account Manager

Company Name: Specialty Cockies | Main Number: (510) 962-5321

Welcome, Phillip Liu | Sign Out

ACCOUNTS

> User Profiles
3 Privileges

The company preferences below will override the selected individual extension user’s settings. Extension users can update their communication preferences in their

virtual Office Online Account.

Email: pliu@8x8.com Account: | Business v
Edit My Profile
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS ||ACCOUNTS| | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Accounts > Communication Preferences Enter keyword
Communication Preferences @ Help

Preferences

» Contact Directory
» Single Sign On
> Analytics Privileges

Request Number Transfer

1001 650) 646-3018  Phillip Liu Not Assigned -
1002 (650)646-2088  Sukhanya Rajan NotAssigned

1003 (650)646-2092  Neena Thomas SPECIALTYCOOKIES d

1004 (650)646-3006  phillip Liu Not Assigned

1006 (555)648-0703  Specialty Cookies Not Assigned

1007 (408)627-874D0  Jean Andje JEAN ANDJE@8X8.CC | o’ s

1009 (408)320-7176 Ramana Gottipati SPECIALTYCOOKIES.| =] ‘ v

1011 (408) 329-7136  Beth Camey SPECIALTYCOOKIES | v r Fl -

Note: 8x8 reserves the right to contact you regarding service, feature or policy announcements and information about your account.

Save

Set up Phone Systems

You can transfer your existing phone numbers from another service company to 8x8. Using the Account Manager

Number Transfer Request feature, you can:

m Check the transfer status of numbers being ported.

m Begin the number transfer.

m Cancel a current number transfer request.

Check Number Transfer Status

To access your number transfer status in Account Manager:

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Number Transfer Request.

Version 1.0
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3. Click Number Transfer Status.

HOME \IPHDNE SYSTEMI\ BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

PHONE SYSTEM

> Extensions
> Auto Attendant

> Virtual and Toll Free
Numbers

> Ring Groups
> Music on Hokd
> Call Queves
> Shared Lines
> Branches

» Swichboard
> Paging

> Company Settings

9

> Edit Voic email / Fax
Notifi ations.

> Group Call Pickup

3 Call Park Extensions.

Phone
5

Home > Phone System > Number Transfer Request

Number Transfer Request

Incomplete Transfer Request(s)

Date Started

08-12-2011 07:23 PM PDT Pending Cancel | Continue

Number Transfer Status

NUMBER TRANSFER STATUS > I

10-12-2011 09:14 AM PDT Pending Cancel | Continue

BEGIN NUMBER TRANSFER >

Before you begin:

Gather Phone Bills. Have copies of your current bill(s) handy (from within the last 35 days). If you are transferring toll-free
o numbers we will alsa ask you to fax or uplaad your bill during this process.

Know Your Service Address. It's important to know the exact Service Address for the numbers you want to transfer. For regular
e phone and fax numbers this is the actual service location of the numbers. For toll-free and mobile/cell numbers it's the same as
your Billing Address on your current provider's bill. For international number LiP, click hiere for mare information.

Have a Plan. Have a list of the numbers you want to transfer, and which 8x8 extensions or temporary numbers you want to
transfer them to.

Transferring mobile/cell numbers?. You will need either the last 4 digits of the Social Security Number associated with this
o account, OR the Account Number and PIN.
Please do not cancel your current phone service until after we confirm your numbers have been transferred. Disconnected numbers
cannot be transferred. In most cases, we can transfer your number within 10 business days. In some cases, number transfers can
take up to 4 weeks depending on when your current pravider releases your number(s).

PRINT NUMBER TRANSFER CHECKLIST >

Once you've begun the Number Transfer
process, check here for progress reports
or to update your transfer requests (Case
IDs).

4. Click View to see details about a case.

Check Number Transfer Status

Submitted case list

@ Help

Transfer Request
1o Former Provide

Submited | xrat 09-03-2011 12:22 AM GMT

[
]

BEGIN NUMBER TRANSFE

Request a Number Transfer

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Number Transfer Request.

3. If you started the request before, click Continue in the Action column of the page.

You are able to resume your number transfer request from the point you stopped.

Set up Phone Systems

4. Review the onscreen instructions and the 8x8 Number Transfer Checklist to ensure you have all required
information ready before you request a number transfer. Click Print Number Transfer Checklist to review and
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print the checklist for future use.

PHONE SYSTEM

» Extensions
> Auto Attendant

> virtual and Tol-Free
MNumbers

» Ring Groups

¥ Music on Held

» Call Queues

» Shared Lines

» Branches

¥ Switchboard

» Paging

¥ Company Settings

¥ Number Transfer
Request

» Call Recording

» Edit \oicemail / Fax
Notific ations

? Group Call Pickup
¥ Call Park Extensions

Phone:
System
Setup

Number Transfer Request

Incomplete Transfer R

Action
08-12-2011 07.23 PM PDT Pending Cancel | Continue
10-12-2011 08:14 AM PDT Pending Cancel | Continue

BEGIN NUMBER TRANSFER >

Before you begin:
Gather Phone Bills. Have copies of your current bill{s) handy (from within the last 35 days). If you are transferring toll-free
o numbers we will also ask you to fax or upload your bill during this process.

Know Your Service Address. It's important to know the exact Service Address for the numbers you want to transfer. For regular
phone and fax numbers this is the actual service location of the numbers. For toll-free and mobile/cell numbers it's the same as
your Billing Address on your current provider's bill. For international number LNP, click here for more information.

Have a Plan. Have a list of the numbers you want to transfer, and which 8x8 extensions or temporary numbers you want to
transfer them to.

account, OR the Account Number and PIN.

Please do not cancel your current phone service until after we confirm your numbers have been transferred. Disconnected numbers
cannot be transferred. In most cases, we can transfer your number within 10 business days. In some cases, number transfers can
take up to 4 weeks depending on when your current provider releases your number(s).

o Transferring mobile/ cell numbers?. You will need either the last 4 digits of the Social Security Number associated with this

PRINT NUMBER TRANSFER CHECKLIST >

5. When you have gathered all the required information, click Begin Number Transfer.

Version 1.0
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6. Answer the questions on the Begin Number Transfer page.

Version 1.0

Note: The answer to the first question must be Yes, and the answer to the last question must be

No in order for your requested transfer to go through.

Meed help? Click to chat with cur @

Begin Number Transfer Local Number Porting group

@ Help

Before you begin the number transfer process, please answer the following questions to determine whether your number(s) can be transferred to
Bx8.

Are the phene numbers you are transferring currently active with your currant provider?

Yes Mo Mare Info
Are you transferring a number to the 8x8 Virtual Contact Center service?
Yes Mo
More Info
v, " Are you porting a United States |local or toll-free number?
== e More Info
De you currently have DSL service on any of the phene numbers you are transferring to Bx87
Yes Mo
More Info
Do you have any of these features on the numbers you want to transfer: Centrex, Distinctive Ring, Ring Mate, Hunting, CustoPAK or ISDN?
Yes Mo
More Info
Have you recently requested any new services or features with your current provider?
Yes Mo
More Info
‘Cancel Request

Once you answer all the questions, click Continue.

Enter the number of service locations for the phone numbers.

Number Transfer @ Help

Need help? Click to
Step 1: Step 2: Step 3: Step 4: chat with our Local @
Service Locations & Numbers Review Information Authorize Transfer Confirmation MNumber Porting group

IDetermine How Many Service Address Locations I

Service addresses are the actual location of physical phone lines or the billing address{es) for mobile/cell and toll-free accounts.

You will have an opportunity to add or remove locations later.

Mumber of service address locations * |1

Cancel Requeet

Click Next.
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10. Enter the service address and service provider information for the number you want to transfer.

Service Location: Enter Service Address and Service Provider Information
Please enter the service address exactly as it appears on your bill. P.O. box addresses are not allowed
= & c
Is this location a busisness or residence? s
“How many providers are there for this location 1 7
RonEy = Service Provider Select =]
* Authorized -First Name (7]
* Billing )
* Authorized -Last Name Telephone
"Street Number Pre Directional "Street Name Post Directional Street Name Suffix
= I=| -]
Location Type Unit Suit #
2]
“City “State “Postal Code
=]
11. Click Next.

12. Enter or cut and paste the numbers you want to transfer.

Note: You must separate the numbers using commas, tabs, or line breaks.

B ATAT: Number(s) to Transfer

Enter number(s) you wish to transfer for AT&T.
4084925678, 4084927432

"AT&T" Numbers:
Type or Paste the
numbers you wish to
Transfer.

MNote: Numbers must
be seperated by
commas, Tabs or line
breaks.

13. Click Next.
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14.

15.
16.

Set up Phone Systems

Click the drop-down arrow to select a temporary number for each of the numbers you are transferring.

Use = and  toadd and delete phone numbers.

= ATAT: Number(s) to Transfer

Enter the number and type of number you want to transfer, then select the temporary number it will replace. Click the 0 Dr@tu add/remove additional lines.
Service Provider : AT&T Billing Telephone Number : (123) 456-7680
Type of Number to Transfer Number(s) To Transfer Temporary Number to Replace
Standard/Fax Number r H- -] [ (650) §46-3018 x1001 (Unlimited Extension)|
Standard/Fax Mumber v & &) sa027am2 (555) 648-0703 x1006 (Basic Extension)
Click Next.

Review the information you provided to ensure it is correct. To edit any of the information, click Back.

Review Information:

B Service Provider Name: AT&T ||| Billing Phone Number: 1234567890

Below is the list of all the numbers you wish to transfer and their service providers. Please review and make sure all the information is correct.

Location 1 of 1 Lei e DT it PRl Lo/l ) e i 4084925678 (650) 646-3018 X1001 (Unlimited Extension) u
123 Sunnyvale USA 94308 4084927432 (565) 648-0703 x1006 (Basic Extension) u

Review the Letter of Authorization carefully. We recommend you print it for your records using the button provided.
If you agree to all terms in the letter, click | Agree.

Note: You can select Save for Later after every step to complete the number transfer request later.

Canceling a Number Transfer Request

1.

Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Number Transfer Request.

3. To cancel a number transfer request, click Cancel in the Action column.

Version 1.0

Number Transfer

Number Tr fer Request

Date Started Status Action
09-12-2011 07:23 PM PDT Pending I Cancel | Continue I
10-12-2011 09:14 AM PDT Pending Cancel | Continue

59



Set up Phone Systems
8x8

Configure Virtual and Toll-Free Numbers

Virtual and toll-free numbers are secondary numbers that ring to an 8x8 extension and are not attached to a specific
phone or device. By default, numbers are directed to the Auto Attendant. In order to change the destination of these
numbers to a ring group, call queue, individual extension, fax, or Virtual Office Meetings, use the Virtual and Toll-
Free Numbers feature.

To change the destination of a virtual or toll-free number:
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, click Virtual and Toll-Free Numbers.

3. Click Edit to change the destination of the desired virtual or toll-free number.

Account Manager Company Name: Specialty Cookies | Main Number: (510) 962-5321
88 8x8, Inc. Welcome, Fhillip Liu | Sign Out

Email: pliu@8x8.com Account: Business [=]

Edit My Profile

HOME PHONE SYSTEM BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Virtual and Toll-Free Numbers Enter keyword

Virtual and Toll-Free Numbers @ Help
PHOME SYSTEM

Virtual and Toll-Free numbers are secondary numbers that ring to an 8x8 extension and are not attached to a specific phone o device. By default numbers are directed to the

? Bdsasion Auto Attendant.
> Auto Attendant Click Edit to change the destination of your virtual or toll-free number.
3 Virtual and
Toll-Free Humbers|
* Ring Groups
2 Music on Hold umb p o umb tinatio ce Addre
? Cal Queues E Virtual Number (510) 962-5321 Phillip Liu, Ext 1001 - (650) 646-3018 810 W MAUDE AVE SUNNYVALE CA 94085 -2910 =
> Shared Lines Edit Toll Free 100 Minutes. (886) 950-6772 Ext 444 - Auto Attendant 810 W MAUDE AVE SUNNYVALE CA 94085 -2810
> =
Switchboard Edit Virtual Number (556) 0547455 | Ext 444 - Auto Attendant 220 primeose DR san jose CA 85123 -4447 US
? paging
Edit Virtual Number unassigned unassigned W MAUDE AVE SUNNYVALE CA 84085 -2810 US4
> Company Settings =

2 Number Transfer

> Call Recording
Common Uses for Virtual and Toll Free Numbers
> Edi Voicemail / Fax

Notifications
+ Use as a main number that rings your auto attendant and routes callers to the right employee
« Establish avirtual presence in a specific market by obtaining a phone number with a local area code
= Tollree numbers allow US callers to call you for free

Phone * Use to rack markeling campaigns
System
Setup

4. From the Parent Destination drop-down, select the destination type you want to associate this number with:
m Business: The number becomes available for any of the following services:
o Auto Attendant
o Ring group (must be configured first)
o Call queue

o Individual extension
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m Fax: The number becomes available for the Virtual Fax extension. Fax extension is available on Virtual Office

Pro.

= Virtual Meeting: The number becomes available for use as a Virtual Office Meetings dial-in number. Virtual

Office Meetings is available on Virtual Office Pro.

Edit Toll-Free/Virtual Number (]

Please select the destination for this number

Number Type Virtual Number
Phone (510) 062-5321
Parent Destination Type | Business

Sub Parent Destination Type 9-"
ax

Destination | Virtual Meeting
Optional Caller ID Name: First
Allow User Access to Optional Caller ID [7]

Change Service Address
Country *
United States v

Street Number*
810

Pre-Directional Street Name*
W-West ¥ | |MAUDE
Secondary Location  Unit/Other
v
City* State*
SUNNYVALE California

Street Name Suffix  Post-Directional
Avenue hd

Zip Code* Zip+4
¥ | 54085 = 2910

5. From the Sub Parent Destination Type drop-down, select a service type (such as call queue or ring group)

associated with this number.

6. Select an Optional Caller ID Name.

7. Select Allow User Access to Optional Caller ID.

This option allows the extension user to access the caller ID number from the Virtual Office desktop app. If

selected, the optional caller ID number is displayed on each outbound telephone call made from this extension.

8. Enter anew location, or Change Service Address.

The service address describes a detailed location required by the emergency service providers.

9. Click Confirm.
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Create Ring Groups

Ring groups allow you to group a number of extensions together to share distribution of incoming calls. When a number
or extension is dialed, multiple phones ring. It is a great way for a business to share the distribution of incoming calls
among employees.

Note: If a Cost Center is bound to a Branch, selecting the Branch results in a read-only Cost Center
field. However, if there is no Cost Center bound to the selected branch, the Cost Center must be
selected manually.

Create Ring Groups
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, click Ring Groups.

3. Click Create Ring Group.

HOME |I PHONE SYSTEM I| BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Phone System > Ring Groups Enter keyword EXa
Ring Groups ©Q Hep
PHONE SYSTEM
» Exdensions Ring Groups allow you to group a number of extensions together ta share distribution of incoming calls
% Auto Allondant Create Ring Group || Delete All Ring Groups
> Virtual and Toll-Free ting Gro Group Extensic coming Gro ctio
Humbers CUSTOMER SUPPORT 2002 Pritip Liu 10+ | Edit | Delete
> Ring Groups Ring Patser: Creic
> Music on Hold No of Cycles: 3 . |
» Call Queues Busy Forwand 555 Vowemail Jesn Andje 1oa7
No Angwar Forwerd 535 Vocemel
» Shared Lines Neys Fonuare. -
> Switchboard et Outage Forward Sukhanya Rajen 1oz
3 Paging | | | |
> Company Sefings Guality Control 2003 P Lis 1w | Edt | Delete
3 Number Transfer 3‘“::’;‘""” “:"""
o of Cyclen:
> Call Recording Busy Forward 444 Auto Attencant
> Edit Voicemail / Fax Ne Answer Farusd 44 Auto Aniencant Soaciaty Cookies 1008
Hotifications Aways Forware
mternet Outage Forward

4. Enter or select Ring Group details, and make changes as desired through the Ring Group Details window.

e

5. For voicemail password, enter a password that meets the security guidelines. Ring group members use this
password to access the voicemails directed to the ring group.

Voicemail Password Security Guidelines
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To secure your voicemail password, the following password restrictions are enforced. The password:
= Should be 4-15 digits long.
= Should not use same digits such as 1111, 2222.
= Should not use years from 1900 till present.
= Should not be of ABAB format such as 1010, 2121,3131.
m  Should not use sequential numbers such as 1234, 4567.

=  Should not use easy to key in numbers from the center of keypad. The following numbers are not allowed -
2580, 0582, 5683 (spells LOVE).

6. Under Members of Ring Group, you can:

m Click the drop-down arrow to select an extension number.

-+

m Click ~ and ~ toadd or delete extensions.
7. To change the order a call goes to in a ring group, you must change the list order for the extensions in the ring
group, you can:
m Enter a new number in the List Order field, such as 1, 2, 3, etc.

m Click Update List Order.

Members of Ring Group

Use the 3 and O buttons to Add/Delete extensions to this Ring Group
—

1 Rob Shasta (210) 500-1795 Ext 1002 v v -}

2 John Smith (210) 500-1794 Ext 1001 v v -}

3 Jeff Powell (850) 000-0010 Ext 1004 v v -}

I Update List Order I

m Click Save. The list order for that ring group is changed.
Edit Ring Groups
1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Ring Groups.
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3. Locate the ring group you want to change, and click Edit.

Ring Groups

Ring Groups allow you to group a number of extensions together to share distribution of incoming calls

@ Help

Create Ring Group | Delete All Ring Groups

CUSTOMER SUPPORT

fon |

Phillip Liu 1004 Delete
Ring Patier: Cyeic
No of Cycles: 3
Busy Forward: 555 Vaicemail Jezn Ande 1007
No Answer Forward: 585 Voicemsil
Alwsys Forward
Internet Cutage Forward: Sukhenya Rajan 1002
Quality Control Phillip Liu 1001 Edit | Delete
Ring Patiemn: Cysiic
No of Cycles: 1
Susy Forward: 444 Auto Aftendsnt
Mo Answer Forward: 444 Auto Attendant Specisity Cookiss 1008
Always Forward
Internet Outage Forward:
Technical Support Sersh Themss 1002 Edit | Delete
Ring Pattemn: Cysic
Mo of Cyeles: 1
Busy Forward: 444 Auto Attendsnt
Mo Answer Forward: 444 Auto Attendsnt
Always Forward 444 Auto Aftendsnt
Internet Qutage Forward:

4. Edit the Ring Group Details.

5. Under Members of Ring Group, click':"'}'| and

Version 1.0

HOME | PHONE SYSTEM | CONTACT CENTER |

BILLING | REPORTING

ORDERS | ACCOUNTS | SUPPORT

VIRTUAL OFFICE ONLINE

PHONE SYSTEM

> Extensions
> Auto Attendant
> Virtual and Tol-Free

¥ Ring Groups

¥ Music on Hoki

¥ Call Queues

¥ Branches

> Switchboard

> Company Settings

> Number Transfer
Request

¥ Call Recording

> Edit Voo email | Fax
Notific ations

> Group Call Pickup
> Call Park Extensions

Home > Phane System > Ring Groups > Edit Ring Group

Edit Ring Group

Edit your Ring Group and then click Save

Ring Group Details

Ring Group Name
Ring Group Extension
Ring Group Caller ID
Ring Pattern

Branch

Cost Center Name
Receptionist Type:
Number of Cycles

Voicemail Password

It all lines are busy, forward
immediately to

If no one in ring group answers,
forward call to

Immediately Forward Calls to

Internet Outage Forward

test123

Ring Group Name and Ring Group Extension v @

Cyclic Repeitive

Branch 1

(7]

Warning : Any updates to voicemail password must adhere to the minimum

enforced length of 4 digits.

Voicemail Ext 655

Voicemail Ext 555

None

Voicemail Ext 555

v after 10 sec(s).

A -]

Ring Pattern

Cyclic pattem i also known ss roll
over and slows equsl distribution of
calls, making sure all extensions in
the Ring Group gat their tum in
snswering the calls. You can choose
how many times the call oycles
through the extensions before
sending cals to your no answer
destination

Cyclic Repetitive pattam
distributes calls among all extensions
in the group in the same order that
the extensions are listed. Each new
call starts at the first extension in your
list. You can choose the number of
times the call cycles through the
extensions before sending calls to
your na answer dastination

Simultaneous Ring rngs si
extensions in the group at the same
time. The first extension to pick up
the phona wil answer ths cal.

@ Help

to add or delete extensions.

Set up Phone Systems
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6.

7.

If you want to change the list order for the extensions in the ring group:

m Enter a new number in the List Order field, such as 1, 2, 3, etc.

m Click Update List Order.
Click Save.

Delete Ring Groups

1.

2.
3.

Click Phone System in the top navigation bar.
Under the Phone System menu, click Ring Groups.

Locate the ring group you want to remove, and click Delete.

Ring Groups

Ring Groups allow you to group a number of extensions together to share distribution of incoming calls

@ Help

Create Ring Group | Delete All Ring Groups

CUSTOMER SUPPORT
Cyclic

No of Cycles: 3

Busy Forward 555 Voice Mail

555 Voice Mail

Ring Pattern:

No Answar Farward
Always Forward:

Bagky Carmichael

Ron Nader

Delete

Shirey Beckmann 1004

When the dialog box appears confirming the deletion, click OK.

Access Music on Hold

You can play music or a message when you place a caller on hold.

Setup Phone Systems

The Virtual Office desktop app allows users to select their own music on hold from the Music on Hold library. As an

administrator, you can select which music is available to extension users, select the default music on hold for

extensions where no music has been selected, and upload new music to the Music on Hold library.

Provide Extension User Access to Music on Hold

1.

Click Phone System in the top navigation bar.

Version 1.0
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2. Under the Phone System menu, click Music on Hold.

HOME | |PHONE SYSTEM I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Phone System > Music on Hold Library Enter keyword EEE
Music on Hold Library @ Help
PHONE SYSTEM
SR Select hold music from 8x8's standard library or upload your own licensed file. For professionally-recorded greetings and hold music, visit our
% Auto Atisndant Audio Production Store.
R e Upload New Music on Hold —
Numbers
> Ring Groups File Szeand  Extensions
e A Status Date Added
> Company Seftings |
. 29MB .
> Number Transfer Ries of Spring -Original Standard 0420 Al I 09.26:2011 Z] Play
ETIGEEET Bright Vision -Centemperary Standard shss":,“na Nene Select 09-26-2011 )
> Edi Voicemail/ Fax -
Nofiications. Groovin -Jazz Standard 5055“3'0“ Hone Select 09-26-2011 =) Play
Into the Blue -Contemporary Standard e Hone Select 09-26-2011 = Play
@:{':,“ Lift -Contemporary Standard Some Mone  Select 09-26-2011 =) Play
Setup
- 5.50MB N
Port of Peace -Jazz Standard s Mone  Select 09-26-2011 z) Play

3. Review the music listed. To hear a sample, click Play.
4. Select the Extension User Access check box to enable users to select Music on Hold for their own extensions.

5. Click OK. Your selected phone extensions now have access to Music on Hold.

Select Default Music on Hold for Extensions
1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Music on Hold.

Music on Hold Library @ Help

Select hold music from 8x8's standard library or upload your own licensed file. For professionally-recorded greetings and hold music, visit our
Audio Production Store.

Upload New Music on Hold

Standard/ File Size and Extensions

Status Date Added Actions

File name Custom Duration Using
Rites of Spring -Original Standard s Al J' 019-26-2011 # Play
Bright Vision -Contemporary Standard SDSSDE"EF MNone Select 09-26-2011 || Play
Groovin -Jazz Standard 5 e None Select 09-26-2011 # Play
Into the Blue -Contemporary Standard SDSEDE"[F None Select 09-26-2011 || Play
Lift -Contemporary Standard 5 e Hone Select 09-26-2011 ¥ Play
Port of Peace -Jazz Standard 5 e Hone Select 09-26-2011 ¥ Play

3. Review the music listed. To hear a sample, click Play.

4. When you have made your selection, click Select. This music will become the default hold music for all
extensions.
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Note: Your selection shows  in the Status column. You can only make one music file the default§

music for all extensions in your phone system. However, extension users can change their default
hold music in the Virtual Office desktop app. '

5. When the dialog box appears confirming your selection, click OK.

6. Click Save.

Upload New Music on Hold

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Music on Hold.
3. Click Upload New Music on Hold.
4

Click Add and select the music file from your computer.

Upload New Music on Hold © Help

Accepted Formats .8u, .wav, .vox and .mp3

Upload one file at a time; Mo larger than 10MB

File Restrictions (All uploaded files will be converted to .au farmats)

4 Add
File Name
Set As Default If checked, this will become the default hold music for your phone system.

5. Click Upload.

6. If you want to make this music file the default music on hold for your phone system, select the check box at the
bottom.

Note: This does not override the music on hold other users have selected in the Virtual Office
desktop app. It only applies to extensions where no hold music has been selected.

7. Review the text in the Electronic Signature field. Click | Agree.
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8. The music you uploaded now appears in the Music on Hold library, with  indicating that it is the default music

on hold.
Upload New Music on Hold
Flle name m‘” “g:‘:'m‘“" E“’l_l"';:"‘ Status  Date Added UI Actions
Rites of Spring -Original Standard | 195MB None Select | 08-26-2011 [ Play
I Jazz Music (Jazz).mp3 I Custom | 5.50MB Al I ina-zg-zoﬁ @] Play | Delete
55008 ! o o
Set up Group Paging

8x8 Virtual Office offers two types of paging:
= Group Paging
m Overhead Paging: This is an additional service that can be purchased separately. For more information, refer to

Set up Overhead Paging.

Group Paging
Provides one-way paging to multiple extensions connected to the same router. Make real-time announcements to a
department, team, or work area using the intercom feature on a Polycom phone:

m Create and manage your paging groups using 8x8 Account Manager.

m Create up to 25 paging groups; the same extension can be included in multiple groups.

m Define who can broadcast pages and who can only listen.

m Set priority levels for your pages: Normal, Priority, and Emergency.

Notes:

-Polycom firmware version 4.0 or higher is required.

-Group paging uses |P multicast to send group pages to registered phones. This technology
requires that all phones in a group page must have access to the same multicast IP address. In
most cases, this requires that all phones receive their IP address from the same router.
Geographically-dispersed phones that are serviced by separate routers will not support uniform

access to intercom group paging.

Before using group paging, each telephone participant must be configured.

Version 1.0
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To set up group paging on the Polycom VVX500:
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, click Paging.
3. On Group Paging, click Configure.

HOME ||FHGNE 5V5TEM|I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Paging [Enter keyword Search
Paging @ Help
PHONE SYSTEM

» Extensions

it Overhead Paging Group Paging

> Virual and Toil-Free Configuration Configuration
Numbers

» Ring Groups J

> Music on Hold ))) C)}) J

> Call Queues J

> Shard Lines
» Switchboard

> Company Seftings
 Number Transfer
> Call Recording

> Edil Vioicemail / Fax
Motifications

4. To create a name or label for the group, click the Edit Group Label link. Then enter a new group name.
In our case, we have created a group called WorkGroup 1.

Group Paging - Master Label Template @ Help

The Master Label Template allows you to define the label for each of the paging groups. Click Edit Group Label to manage labels.

Edit Group Label

‘Onee you define the lahel for a paging group, you will then need in

Il Defautt select the extensions that will be paged for each group. Click the button
below to configure the extensions for each paging group.

WorkGroup 1

[El Undefined Configure Paging Groups

3 Uncefined

E Undefined

6 Once you define the label for a paging group, you will then need to
select the extensions that will be paged for each group. Click the button

Undefined below to configure the extensions for each paging group.

ﬂ Undefined Configure Individual Extensions

Bl Undefined

G uncefined

[EEl Undefined

A uncefined

5. Click Save at the bottom of the window.
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6. Click Configure Paging Groups.

Group Paging - Master Label Template © Help
The Master Label Template allows you to define the |abel for each of the paging groups. Click Edit Group Label to manage labels.
Edit Group Label
—_ Once you define the label for a paging group, you will then need to
[l Defauit select the extensions that will be paged for each group. Click the button
below to configure the extensions for each paging group.
Bl WorkGroup 1 _
Bl uncefined Configure Paging Groups
3 Undefined
H vncefined
I Urdsired Once you define the label for a paging group, you will then need to
select the extensions that will be paged for each group. Click the button
Undefinad below to configure the extensions for each paging group.
[E Urcefined Configure Individual Extensions
Bl Undefined
[l uncefined
[l Undefined
A undefined

7. Select the new group (in this case, WorkGroup 1) from Paging Groups. Make sure it becomes highlighted.
Next, select the extension that participates in the group by searching and selecting the extension numbers.

Configure Paging Groups and Extensions [x]
Paging Groups Configure Extensions for Paging Groups - WorkGroup 1

1. Click on the Paging Group you wish to 2. Select the extensions you wish to be paged when using this Paging Group. You can also choose if an
configure. @ extension is receive only or if they can initiate a page to the group by checking the Receive and/or Send
boxes.

[l Default

ﬂ WorkGroup 1 To select an extension, type the extension number, caller id or phone number and hit the search button.

BHK TestLab Quick Search @)

Marketing Dept Page 1003 Search

& Priority

B3 Emergency

No extensions are assigned to this group.

= Example 1

In this example, four extensions have been included in the group. As highlighted, the user has selected extension
1003 for the detailed configuration. On extension 1003, the user has selected the ability to send and receive two
normal groups and the ability to send in Priority and Emergency groups.
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Configure Paging Groups and Extenslons [x]
Paging Groups Configure Extenslons for Paging Groups - WorkGroup 1

1. Clicl
config|

k on the Paging Group you wish to
ure. &

[l cefauit

El WorkGroup 1

BK Test Lab
Marketing Dept Page
Priority

Emergency

2. Select the extensions you wish to be paged when using this Paging Group. You can also choose if an extension is
receive only or if they can initiate a page to the group by checking the Receive and/or Send boxes.

To select an extension, type the extension number, caller id or phone number and hit the search button.

Quick Search @

No extensions found matching the criteria.

[Soorcn oot |

To add an

ion to multiple paging groups, click on the extension number for the extension you wish to configure further.
Priority and Emergency Groups are set to default for all the extensions and receive paging is required for these groups.

1055 | (857)375-5405 VVX 500 Pilot Lab Bill K Ext 1085 [ [
1054 | (557)356-1270 VVX 500 Pilot Lab Bill K Ext 1054 o 4
1003 (555) 147-0181 Alfred Jones ™ [
1053 (557) 386-1221 VVX 500 Pilot Lab Bill K Ext 1053 Ic4 [c4

Set up Phone Systems

Note: You cannot unsubscribe from a Priority or Emergency group. A Priority page interrupts

enabled.

Normal pages or active calls. An Emergency page will interrupt Normal pages, Priority pages,
and active calls and plays out at near maximum volume even if Do Not Disturb (DND) is

Configure Paging Groups [x]
Configure Paging Groups for - Ext. 1003 - Alfred Jones

Select Receive andior Send for the Paging Groups you want this extension to be part of.

Default ] ]
Bl WerkGroup 1 ™ 4
BK Test Lab ] ]
Marketing Dept Page [C4 [C4
& Priority v ™
& Emergency v [C4

m Example 2

Version 1.0

In this example, the user has configured extensions 1003, 1055, 1054, and 1053, and can now save the

configuration. Users are given the option to save now or save at a time when it is more convenient to restart the

phone.
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Save required to push configuration to phone

The configuration changes needs to be applied to this extension.
You can have the changes applied immediately or schedule to apply the changes for a more convenient time.

(*) Apply changes now | Schedule to apply changes for a later time |, 15 2012 04:00 PM @
Pacific Time (US) |

= e

[1 055 I (557) 375-5405 I VWX 500 Pilot Lab I Bill K Ext 1055 ol ol
1054 (557) 358-1270 VWX 500 Pilot Lab Bill K Ext 1054 v ol
1003 (555) 147-0181 Alfred Jones v v
1053 (557) 356-1221 VWX 500 Pilot Lab Bill K Ext 1053 ol v

When a user returns to their Polycom VV X500 desktop phone, they can see Paging among the screen menus as
well as the paging group list. The new group (in this case, WorkGroup 1) is active, as shown below.

242 PM o )
Exit Paging Groups List

oo e 1 Recent: Marketing Dept Page (19)

?‘b 1003 Alfred Jones 2 Emergency (25)
3 Priority (24)

4 WorkGroup 1 (2)

New Call Redial Forward | Paging | More

Making a page from a Polycom VV X500 shows a preamble screen. During the preamble, the phone has located
all the phones in the page and is sending a short tone to all the phones in the group page.

331PM o

0:00

To:WorkGroup 1 (Group 2)

Park End Page New Call BlindXfer More

The phone quickly transitions to paging mode. At this point, a user can speak into the handset or speakerphone
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and a one-way page is transmitted to all participants. Receiving a page shows the name of the group page and

the status.

From:VWX 500 Pilo

Hold End Page New Call Park More

Configure Voicemail and Fax Notifications

Extension users can receive an email notification when they receive a new voicemail message or Internet Fax. Internet
Fax is available with Virtual Office Pro.

Manage Voicemail and Fax Notifications

There are several email notification options available. Extension users can manage their notification options using the
Virtual Office desktop app. Using Account Manager, system administrators can also manage notification settings and
prevent extension users from making any changes to settings.
Configure Voicemail and Fax Notifications

1. Click Phone System in the top navigation menu.

2. Under the Phone System menu, click Edit Voicemail/Fax Notifications.

HOME \lFHONE SYSTEM II BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Voicemail And Fax Settings Enter keyword
Edit Voicemail / Fax Notifications Q Help

PHONE SYSTEM

Edit extensions as needed and click Save.

» Extensions.

» Auto Attendant

>viaianaTobFres | [N e - SRS R Acdup o 5 email addresses
Humbers

> Ring Groups

3 Music on Hold

> Company Setfings

Disable Notification

John Smith

1001 (210) 500-1794 naiini@8x8.com

> Number Transfer Attachment Only
1002 (210)500-1795  Rob Shasta Hotificaticn Only
¥ Call Recording 2 (210)500- s Link & Attachment miadace@8x8.com
Link Onl

|)E=|§Vo|:=mllliF!:| 1003 (850) 000-0000 Unassigned  Unassigned | porreretergrerereysregrrg | nalinig8x8.com
1004  (850) 000-0010 Unassigned v

Unassigned | Attachment Only nalini@8x8 com

Phone
E g'“’u‘;’“ * When using the 'Attachment, Delete Orig. VM’ notification option, customer assumes risk that a Voicemail can be lost if their email is mishandled for any reason.

[sove Jf Concel |
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3.

4.

5.

Setup Phone Systems

In the drop-down boxes in the Voicemail Notification and Fax Notification columns, select the appropriate
option for each extension. The same option can be applied to all extensions using the drop-down box in the header
row. You can see the following choices under Voicemail and Fax Notification:

m Disable Notification: No email notification is sent.
m Attachment Only: An email notification is sent with an attached audio file of the voicemail.

m Notification Only: An email notification is sent without an audio file or link to the voicemail (recommended
for companies requiring HIPAA compliance).

m Link & Attachment: An email notification is sent with both a link to the voicemail and an audio attachment,
as well as links to delete voicemail and to manage multiple voicemails.

= Link Only: An email with a link to the voicemail is sent, as well as links to delete voicemail and to manage
multiple voicemails.

m Attachment, Delete Orig. VM*: An email notification with an attachment to the voicemail is sent. The

original audio file of the voicemail will be deleted.

Select the check box next to a setting if you would like to lock it. If locked, users cannot personally change their
notification settings.

== Note: According to HIPAA guidelines, it is considered unsafe to send an attachment that can be
= — forwarded. Therefore, administrators should set users to Notification Only. Be sure to lock the
: T__i setting so that users cannot change this setting from the Virtual Office desktop app.

Click Save.

Add-On Features

8x8 provides the following additional services and features. Contact your 8x8 sales representative to learn more about

the following:

Version 1.0

Overhead Paging

Call Queues

Branches
Barge-Monitor-Whisper (BMW)
Power Keys

Shared Lines
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m Switchboard Pro

m Call Park Extensions
Group Call Pickup
Hot Desk

Set up Overhead Paging

Overhead paging provides one-way paging to multiple locations within a single facility, nearby office building, or remote
locations. Overhead paging is an optional feature that can be purchased separately.

To set up overhead paging:
1. Click Phone System in the top navigation bar.
2. Underthe Phone System menu, click Paging.

3. On Overhead Paging Configuration, click Configure.

Account Manager Company Name: Specialty Cookies | Main Number: (510) 862-5321
% 8x8,Inc. Welcome, Phillip Liu | Sign Out

Email: pliu@8x8.com Account: Business [wv]

Edit My Profile

HOME I PHONE SYSTEM IBILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Phone System > Paging Enter keyword

Paging © Help
PHONE SYSTEM

> Exiensions.

: 3‘“"’ ““ET_:"‘ - Overhead Paging Group Paging
firtual and Toll-Free

Ntmbers Configuration Configuration
» Ring Groups J

» Music on Hold ))) C))} JJ

» Call Queues
» Snarea Lines
e

> Company Settings
3 Mwrhar Teanef

4. Locate the extension you want to modify, and click Edit.

Overhead Paging @ Help

8x8 Overhead Paging service enables one-way overhead paging to multiple locations within a single facility, nearby office building or remote
locations.

Overhead Paging 1008 003004112244 Active 810 MAUDE AVE W, SUNNYVALE CA 94085-2910 USA Edit

Mote: If your overhead paging system device has a dip switch that can toggle between Standard Mode and Trunk Mode, please be sure it is set to
Trunk Mode.

For more help setting up your overhead paging service, contact 8x8 Suppart at 888-898-8733.

5. The Change Password dialog box appears. Change the overhead paging password, if desired.
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6. Change the service address information, if applicable.

Change Overhead Paging

New Password
Confirm Password s

Change Service Address

Country*

United States v

Street Number*

810

Pre-Directional Street Name* Street Name Suffix Post-Directional

W - West ¥ | MAUDE Avenue v v

Secondary Location  Unit/Other

v

City* State* Zip Code* Zip+4
SUNNYWALE California ¥ | 94085 - 2810
[Save |
7. Click Save.

Manage Call Queues

A Call Queue places callers in a queue while agents handle other calls. The calls are then answered in the order
received as agents become available. Call Queues is an optional add-on feature that can be purchased separately.

Note: If a Cost Center is bound to a Branch, selecting the Branch results in a read-only Cost Center
field. However, if there is no Cost Center bound to the selected branch, the Cost Center must be
selected manually.

Create Call Queues
1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Call Queues.
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3. Click Create Call Queue.

Account Manager Company Name: Specialty Cookies | Main Number: (510) 962-5321
% 8x8,Inc. Welcome, Phillip Liu | Sign Out
Email: pliu@8x8.com Account: Business ~]

Edit My Profile

HOMEI PHONE SVSTEMl\ BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Call Queues [Enter keyword
call Queues © Help
PHONE SYSTEM
> Extensions. Your Call Queue service places your callers in line or queue while employees are on other calls. The calls are then distributed in the order received, when the next
% Auto Attendant employee becomes available.

> Virtual and Toll-Free |
Numbers Create Call Queue | | Delete All Call Queues

> Ring Groups

> Music on Hold Customer Support 700 uzy White 1017 |Ramana _ Gottipati 1009 | view | Edit | Delete
: in et 10
» Shared Lines Interval between calls. 45 seconds
% Hiumaa: [ 7o Bk L 1001 [Sukhanya_Rajan 1092 | view | Eit | Delete
» Paging Maximum callers in Queue: 10 Philip Liu 1004

Interval between calls: 45 seconds Ramana_Goftipati 1008

Note: If you would like the system to suggest the next available extension number, click "~ next
to Extension.

Call Queue Details

Call Queue Name * Call Queue
Lo = A call queue places callers in a queus whils sgents
Extension += handle othar calls. The calis are then answered in
Time Before Next Call * a5 @ (inscoonds) the order recaived as agents become svailable.
Max Callers in Queue * 10 v In 'Agent Assignment section, selact whether io
) . ) O (me;) allow agents ta log in and log out of their sssigned
If queue is full, forward immediately to Auto Attendant Ext 444 (7] gueues. If you select VES, agents can log
themselves in and out using their \irtual Office
If all agents logged out of call queue or Online accounts or an IP phone. If you select NO,
if all agents have server side DND None (7] TS i e e
status, immediately forward call to ==
Internet Outage Forward Nene NOTE: Agents tell Call Queue they are in DND (Do
Mot Disturb) mode ONLY from their Virtual Office
3 Orline accounts. If agents set DND from their IP
Immediately Forward Calls to MNone (7] Phone. the call queus will still consider theny an
) i aciive agent and send calls to their IP Phone.
Voicemail Password * (7]
*=Indicates Required Fields

5. For voicemail password, enter a password that meets the security guidelines. Ring group members use this
password to access the voicemails directed to the ring group.

Voicemail Password Security Guidelines

To secure your voicemail password, the following password restrictions are enforced. The password:
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= Should be 4-15 digits long.

m  Should not use same digits such as 1111, 2222.

m  Should not use years from 1900 till present.

m  Should not be of ABAB format such as 1010, 2121,3131.

m  Should not use sequential numbers such as 1234, 4567.

Setup Phone Systems

= Should not use easy to key in numbers from the center of keypad. The following numbers are not allowed -

2580, 0582, 5683 (spells LOVE).

6. Under Agents Assignment, assign agents to the call queue.

m Select whether to Allow agents to log in and log out of their assigned queues.

Note: If you select Yes, agents can log themselves in and out using the Virtual Office desktop
app or an IP phone. If you select No, agents are automatically logged in to the call queue.

m Select a Primary Extension number from the list.

m Select a Secondary Extension number from the list.

Note: You can assign a group of agents to both a primary and secondary queue extension. The§
secondary extension group can be set up to handle overflow calls from the primary extension
group. If all agents on the primary and secondary extension groups are busy and the maximum

number of calls in the queue is reached, the next call is forwarded to the queue voicemail box.

7. Select whether the primary extension receives voicemail.

Version 1.0

Agents Assignment

Allow agents to log in and log out from assigned queues.

You can assign a group of agents to both a primary and secondary queue extension. The secondary extension group can be setup to handle overflow calls from the
primary extension group. If all agents on the primary and secondary extension groups are busy and the maximum number of calls in the queue is reached, then the

nextcall will be forwarded to the queue voicemail box.

. N Receive

Primary Extension Voicemail
Phillip Liu (650) 646-3018 Ext 1001 v v -]
Sarah Thomas (650) 646-3006 Ext 1004 v v ]

Secondary Extension

John Smith (650) 646-2002 Ext 1003 v ti 4+
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8. Click Save.

Note: In order to upload or record greetings, you must first create your profile and then edit it to :
enable those features.

View Call Queues
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, click Call Queues.

3. Click View in the Action column for the call queue you want to see.

HOME | PHONE SYSTEM ]I BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Phone System = Call Queues Enter keyword
call Queues @ Help
PHONE SYSTEM
» Extensions Your Call Queue service places your callers in line or queue while employees are on other calls. The calls are then distributed in the order received, when the next
3 Auto Aftendant employee becomes available.

> Virtual and Toll-Free
Create Call Queue | Delete All Call Queues

» Ring Groups el 1 tio
> Music on Hold Customer Support 700 [y Winite 1017 Ramanz _Gottipzi 1009 Yviev, | Edit | Delete
Mazimum callers in Queue; 10
> Sthared Lines Inferval between callss 45 seconds
» Switchboard Human Resources 701 Philip_Liu 1001 [Sukhanya Rajan 1002 Yviiew | Edit | Delete
i Maximu calers in Queue: 10 Priip Liv 1004
) Inferval between calls: 45 seconds Ramana _Gottipati 1009
» Company Settings
» Number Transfer
> Call Recording
» Edit Voicemail | Fax
Nolifications.

4. Both agent and caller status is displayed.
5. Click Refresh.
If you want the display to refresh automatically:
m Select the Auto Refresh Data Every check box.
= Enter how often you want the display to refresh. The default is 20 seconds.

7. Click Close to close the display.

“ Rel'mshlllDAmoRel'mshData Every:" 0 seoondsl Close All
Group Name: Staffing | Group Extension: 701 Close °

Average Wait Time: 00:00 Status as of: %/26/11 8:20:50 PM
Callers In Queue: 0
Agents Status

1004 Shirley Beckmann ) 4 9122111 3:32:31 PM

1009 Accountant Annie v v 9122111 3:32:31 PM

1002 Becky Carmichael v 9122111 332:31 PM
Callers Status
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Edit Call Queues
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, click Call Queues.

3. Click Editin the Action column for the call queue you want to change.

HOME | PHONE SYSTEM || BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Call Queues

Enter keyword Search

Call Queues @ Hep
PHONE SYSTEM

» Extensions Your Call Queue service places your callers in line or queue while employees are on other calls. The calls are then distributed in the order received, when the next
> Auto Atfendant employee becomes available.

¥ Virtual and Toll-Free
Create Call Queue | Delete All Call Queues

» Ring Groups Group Name Group Ext a cond
» Music on Hold Cwatomes Suppart 700 Sy Wnite 1017 Ramana Gottipai 1009 |00, | Eqit | Delete
Maximum calers in usue: 10
> Shared Lines Inferval befween calls: 45 seconds
» Switchboard Human Resources 701 |[Phillip Liu 1001 Sukhanya Rajan 1002 }view | Edit | Delete
> Paging Maximum callers in Qusue: 10 |Philip_Liu 1004
Interval between calls: 45 seconds |Ramana_ Gatlipali 1009

» Company Settings
> Number Transfer
> Call Recording

> Edit Voicemail / Fax
Notifications.

4. Edit Call Queue Details.
5. Under Agents Assignment, you can:

m Select or clear the radio button controlling whether to allow agents to log in and out of their assigned queues.

Note: If you select the radio button, agents can log themselves in and out using the Virtual
Office desktop app or an IP phone. If you clear the radio button, agents will automatically be
logged in to the call queue.

m Click the Primary Extension drop-down arrow to select different extensions.

m Click = and ~ toadd and delete primary extensions.

m Click the Secondary Extension drop-down arrow to select different extensions.

m Click = and = toadd and delete secondary extensions.
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6.

Select whether the primary extension receives voicemail.
[hoents pssignment ——————————— — |
Allow agents to log in and log out from assigned queues.

You can assign a group of agents to both a primary and secondary queue extension. The secondary extension group can be setup to handle overflow calls from the
primary extension group. If all agents on the primary and secondary extension groups are busy and the maximum number of calls in the queue is reached, then the
next call will be forwarded to the queue voicemail box.

. N Receive Secondary Extension

Primary Extension Voicemail
Phillip Liu (650) 646-3018 Ext 1001 v 4 ce John Smith (650) 646-2982 Ext 1003 v [« 4]
Sarah Thomas (650) 646-3006 Ext 1004 v vl -]

Set up Phone Systems

7. Upload or record an initial greeting that callers hear when they enter the call queue, if all agents are busy.

Delete Call Queues

1.
2.
3.

Click Phone System in the top navigation bar.
Under the Phone System menu, click Call Queues.
To delete all call queues:

m Click Delete All Call Queues.

Account Manager

Welcome, Phillip Liu | Sign Out
Email: pliu@8x8.com
Edit My Profile

IR s

HOME l PHONE SYSTEM I[ BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Account: | Business

Company Name: Specialty Cookies | Main Number: (510) 962-5321

Home > Phone System > Call Queues Enter keyword

call Queues
PHONE SYSTEM

[ Search |
© Help

> Extensions Your Call Queue service places your callers in line or queue while employees are on other calls. The calls are then distributed in the order received, when the
next employee becomes available.
¥ Auto Attendant
»Virtual and Tol.Free Create Call Queue | Delete All Call Gueue4
Numbers
Extensio
O Suzy White 1017 R Gottipati 1002
uzy amana_Gol
$ Wusic on Hold Customer Support 700 Viey Delete
Maximum callers in 10
> Call Queues Queue.
 Shared Lin . .
) ared Lines Intervalbetween cals: 32 o
> e Human Resources 701 Philip_Liu 1001 Sukhanya Rajan 1002 | vigw | Edit | Delete
g Maximum callers in 0 Phlip L ___ 1004
» Corapany Setings Queve: Ramana_Gottipati 1008
> T .8
Number Transfer Interval between cals: 2
¥ Call Recording

2 Edit Voicemail / Fax
MNetifications

m  When the dialog box appears to confirm your deletion, click Delete All.

4. To delete an individual call queue, Click Delete in the Action column of the call queue you want to remove.

Version 1.0

Create Call Queue | Delete All Call Queues

Group N Group Ext Primary Exte 0 Secondary Exte ons Actlo
Staffing 701 [Lobby Manager 1001 |Becky Cullen 1002 | vview | Edit| Delete
Maximum callers in Queue: 10 Shirley BBC'L"“”" }g
Interval between calls: 45 seconds untant e
sales 700  Mahesh Swami 1003 Annie 1008 | view | Edit | Delete
Maximum callers in Queue: 10 Ron_Mader 1007
Interyal hetween calls 45 seconc
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Initial Queue Greeting

Set up Phone Systems

The initial queue greeting is played when a caller first joins the queue. If all agents on the primary and secondary queue
extension groups are busy and the maximum number of callers on the queue has not been reached, the next caller

hears the initial queue greeting.
Upload an Initial Queue Greeting

1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Call Queues.

3. Click Editin the Action column

for the call queue you want to change.

HOME | PHONE SYSTEM || BILLING | REPORTING

| ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

> Virtual and Toll-Free
Numi

Home > Phone System > Call Queues Enter keyword Search
Call Queues @ Hep
PHONE SYSTEM
» Extensions Your Call Queue service places your callers in line or queue while employees are on other calls. The calls are then distributed in the order received, when the next
% Auto Allenuiagt employee becomes available.

Create Call Queue | Delete All Call Queues

» Ring Groups
» Music on Hold Cwatomes Suppart 700 Sy White 1017 Ramana Gottipati 1009 |00, | Eqit | Delete
Mazximum callers in Queue: 10
> Sthared Lines Inferval between callss 45 seconds
» Switchboard Human Resources 701 Philip_Liu 1001 |Sukhanya Rajan 1002 Yyview | Edit | Delete
i Maximum callers in Queue: 10 Phiip Lu 1004
Inferval between calls: 45 seconds Ramana _Gottipati 1009
> Company Settings
» Number Transfer
> Call Recording
» Edit Voicemail / Fax
Nolifications.
4. Click Manage Greetings.
IVR Message
Initial Queue Greeting )
Incoming Call
> 5‘ Play this greeting when all agents are busy 0 Manage Greetings
I « Current IVR Setting: Custom Message

Play this

= Current

Play this

On Hold Music @)

Repeating Queue Message @)

every available agent 0 Manage Greetings
« Current IVR Setting: Custom Message
Leave Message in Voicemail {optional) Loave volcomall ofioa Bt

(Caller may press * 2 " to leave message).

music while caller waits for next avallable agent © Manage Grestings

IVR Setting: Custom Message

peating ge |39 d(s) as a caller walts for the next

Version 1.0
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5.

10.
1.

Click Upload Custom Greeting.

Upload Custom Greeting | Record Custom Greeting
e ]

"Current '
Greeting Name Date Uploaded / Recorded Greeting Actlon
System_Default.au 07-13-2011 0700 AM GMT I Play / Download
Click Add.

Select the audio file you want to upload.
Click Upload.

Select the Set as Default check box.

Accepted Formats .au, .wav, .vox and .mp3
File Restrictions Upload one file at a time; No larger than 10MB

File Name

I Set As Default || If checked this will become the default greeting for the Queue I

Review the Electronic Signature text, and click | Agree.

Set up Phone Systems

Click OK when the dialog box appears confirming that you have successfully uploaded the greeting.

Record an Initial Queue Greeting

1.
2.
3.

Version 1.0

Click Phone System in the top navigation bar.
Under the Phone System menu, click Call Queues.

Click Edit in the Action column for the call queue you want to change.

HOME | PHONE SYSTEM || BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

> Auto Aftendant employee becomes available.
¥ Virtual and Toll-Free

Home > Phone System > Call Queues Enter keyword
Call Queues @ Hep
PHONE SYSTEM
» Extensions Your Call Queue service places your callers in line or gueue while employees are on other calls. The calls are then distributed in the order received, when the next

Creale Call Queue | Delete All Call Queues

% Ring Groups =
pilskertes Customer Support 700 [Swy VWi 1017 Ramana - Gottipati 1003 \ieys | Ecit | Delete
Maximum callers in Quaue: 10

> Shared Lines Interval betwaen callss 45 seconds |
> Switchboard Human Resources 701 Philip _Liu 1001 /Sukhanya Rajan 1002 [ \view | Edit | Delete
» Pagil Maximum callers in Queue: 10 Philip Liu ) 1004

it Inferval between calls: 45 seconds Ramana_Gotiipafi 1009
» Company Settings
> Number Transfer
> Call Recording
> Edit Voicemail | Fax

Nefifications.
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4. Click Manage Greetings.

IVR Message
Initial Queue Greeting @
I ing Call
" N Ef Play this greeting when all agents are busy © WManage Greetings
= « Current IVR Setting: Custom Message

On Hold Music @)

Play this music while caller waits for next available agent 0 Manage Greetings

« Current IVR Setting: Custom Message

Repeating Queue Message )

Play this rep g o (s) as a caller walts for the next
every 30 avallable agent 6 Manage Greetings

« Current IVR Setting: Custom Message

Leave Message in Voicemail (optional) Poais voicer aN DI S8

(Caller may press "2 " to leave message).

5. Click Record Custom Greeting.

Date Uploaded / Recorded

System_Default.au 07-13-2011 0700 AM GMT I Play / Download

6. Enter your phone number if you want your recorded greeting to be the default initial greeting for the queue.

7. Click Start Recording.

Please enter a valid phone number and click Start Recording to call your phone. Once you pick up your extension, you can record your custom greeting.
When you are done click Stop Recording below and hang up. You will then be taken back to the Manage Greetings section.

| Phone Number

Enter a valid 10 digit phone number. Example: 4085551212

Start Recording

8. The system calls you at the number you entered. When the phone rings, answer it and follow the voice prompts to
record your message.

9. Click Done Recording when you are finished.

10. Your custom greeting now appears in the Initial Queue Greetings list witha | indicating that it is the default

greeting for the call queue.
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On Hold Music or Message for Use in a Queue

Set up Phone Systems

If all agents are busy, the caller continues to hear On Hold Music, which can be a music or a message. This plays

immediately after the Initial Queue Greeting.
Upload On Hold Music or a Message

1. Click Manage Greetings.

IVR Message

Initial Queue Greeting @

« Current IVR Setting: Custom Message

On Hold Music )

Inceming Call
fF Play this greeting when all agents are busy

0 Manage Greetings

« Current IVR Setting: Custom Message

Repeating Queue Message @)

Play this music while caller waits for next available agent

0 Manage Greetings

Play this a0

« Current IVR Setting: Custom Message

Leave Message in Voicemail (optional) Do a JCierm N e Tices

(Caller may press " 2 " to leave message).

) as a caller waits for the next
every available agent

® ves O No

0 Manage Greetings

2. Click Upload Custom Greeting.

"Current '
Greeting

Greeting Name Date Uploaded / Recorded

System_Default.au 07-13-2011 07:00 AM GMT I

Upload Custom Greeting | Record Custom Greeting
e ]

Action

Play / Download

3. Click Add.

4. Select the audio file you want to upload.

Note: An audio file can be a greeting or a piece of music.

5. Click Upload.

Version 1.0
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6. Select the Set as Default check box if you want this to be the default custom greeting.

Accepted Formats .au, .wav, .vox and .mp3
File Restrictions Upload one file at a time; No larger than 10MB

File Name

I Set As Default If checked this will become the default greeting for the Queue I

7. Review the Electronic Signature text, and click | Agree.
8. When the dialog box appears confirming that you have successfully uploaded the greeting, click OK.

Record On Hold Music or a Message
1. Click Manage Greetings.

IVR Message

Initial Queue Greeting @

Incoming Call
fF Play this greeting when all agents are busy 0 Manage Greetings

Sy
1 « Current IVR Setting: Custom Message

On Hold Music )

Play this music while caller waits for next available agent 0 Manage Greetings

« Current IVR Setting: Custom Message

Repeating Queue Message @)

Play this ) as a caller waits for the next
every 30 available agent 0 Manage Greetings

« Current IVR Setting: Custom Message

Leave Message in Voicemail (optional) Pntis Volerm N Dol BB

(Caller may press " 2 " to leave message).

2. Click Record Custom Greeting.

Upload Custom Greetingl Record Custom Greeting

T

Greeting Name Date Uploaded / Recorded

System_Default.au 07-13-2011 0700 AM GMT I Play / Download

3. Enter your phone number if you want your recorded greeting to be the default greeting for the queue.

4. Click Start Recording.
The system will call you at the number you entered. When the phone rings, answer it and follow the voice prompts

to record your message.
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6. Click Done Recording when you are finished.

7. Your custom greeting now appears in the list of queue greetings with a

for the call queue.

Repeating Queue Message

Set up Phone Systems

, indicating that it is the default greeting

A message plays at intervals within the hold music. The default interval is 60 seconds. You can also give callers the

option to leave a voicemail by pressing the 2 key.
Upload Music or a Message to Use in the Queue

1. Click Manage Greetings.

VR Message
Initial Queue Greeting

Incoming Call

On Hold Music )

(7]

Play this greeting when all agents are busy

« Current IVR Setting: Custom Message

Play this music while caller waits for next available agent

« Current IVR Setting: Custom Message

Repeating Queue Message @)

Play this

d(s) as a caller walts for the next

every

Leave Message in Voicemail (optional)

« Current IVR Setting: Custom Message

Leave volcemall option

(Caller may press " 2 " to leave message).

30 available agent

® ves O No

0 Manage Greelings

0 Manage Greetings

6 Manage Greetings

2. Click Upload Custom Greeting.

System_Default.au 07-13-2011 07:00 AM GMT

Upload Custom Greeting | Record Custom Greeting

Play / Download

Click Add.
Select the audio file you want to upload.

Click Upload.

Review the Electronic Signature text,

Version 1.0

and click | Agree.

Select the Set as Default check box if you want this audio file to be the default recording for the queue.
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8. When the dialog box appears confirming that you have successfully uploaded the greeting, click OK.

Record a Repeating Queue Message
1. Click Manage Greetings in the Repeating Queue Message section.

IVR Message

Initial Queue Greeting @

Incoming Call
'5 Play this greeting when all agents are busy o Manage Greetings

« Current IVR Setting: Custom Message

On Hold Music )

Play this music while caller waits for next available agent 0 Manage Greetings

« Current IVR Setting: Custom Message

Repeating Queue Message @)

Play this ) as a caller waits for the next
every 30 available agent 0 Manage Greetings

« Current IVR Setting: Custom Message

Leave Message in Voicemail (optional)

Leave voicemail option ® ves O No

(Caller may press "2 " to leave message).

2. Click Record Custom Greeting.

Date Uploaded / Recorded

System_Default.au 07-13-2011 0700 AM GMT I Play / Download

3. Enter your phone number if you want your recorded greeting to be the default greeting for the queue.
4. Click Start Recording.
5. The system calls you at the number you entered. When the phone rings, answer it and follow the voice prompts to

record your message.

6. Click Done Recording when you are finished.

7. Your custom greeting now appears in the Initial Queue Greetings list witha , indicating that it is the default

greeting for the call queue.
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Branch Office - An Overview

Branch Office gives 8x8 phone system administrators the ability to segment extensions on their PBX into groups that
can represent physical or virtual branches of your company. This results in better caller experience and easier, more
efficient call management. Each branch has its own unique branch directory consisting of regular extensions and
service extensions, and branch-level presence management.

Branch Office also allows you to customize the “zero-out” function, giving you more options for routing calls to other
extensions besides just the receptionist at the primary location. For example, you can set it up so that callers into a
specific branch are sent to the branch receptionist instead of the headquarters receptionist if they dial <O#>.

The Branch Office feature is especially useful for systems with multiple auto attendants or for businesses using the 8x8
Switchboard Pro app. Using Branches, a business with geographically-distributed offices or logical groups located in the

same building gains the efficiency of branch call flow.
You can grant branch-specific privileges to an administrator role. The branch administrator can:
m  Oversee configuration of an assigned branch only.
m View the regular extensions and service extensions assigned to the branch.
= Assign the unassigned regular and service extensions to the branch if they have the right privileges.

m Access call recordings of extensions that are assigned to their branch(es) only.

Audience

This guide is intended for 8x8 iPBX administrators. It provides an overview of 8x8 Branch Office and its benefits. The

document details the steps involved in setting up a branch office in Account Manager.

Call Flow for a Branch Office

Branch call flow begins with a Virtual Number on your PBX and flows to the receptionist at the branch office. In this
case, the receptionist can be a live operator, an Auto Attendant, or several live operators assembled in a ring group or
call queue. In summary, a receptionist for Branch Office receives inbound calls through one of the following roles:

= Auto Attendant
= Live Attendant (receptionist)
m  Multiple receptionists with a call queue

m  Multiple receptionists with a ring group
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Call flow within a branch office may be explained as follows:

1. The branch is assigned a Virtual Number. The Virtual Number points to the receptionist extension that is assigned
as the Receptionist of the branch office.

2. Overflow calls to branch office receptionist can go to voicemail, Auto Attendant, or any forwarding phone number.
The receptionist extension is where you set call overflow rules, if required.

3. The caller can leave a voicemail or dial <O#> to be directed to the Branch Receptionist in order to ensure the caller
gets a desired response.
A branch office call flow may be represented as shown here:

PSTM Call Will Flow to
AA Transfer Virtual Number Virtual Number
Ext. Transfer Routing

Extension Number Extension Number Extension Number Extension Number
Receptionist Attendant Call Quevue Ring Group

Extension Mumber
Employee

Hit ZERO # Branch Con RUCREe
fero # 1
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Receptionist Tools

The receptionist receives branch phone calls. 8x8 provides receptionist with tools to distribute calls using:
= 8x8 Switchboard Pro, an HTMLS5 browser-based call management client
o Switchboard Pro is an application specially designed for handling inbound calls, voicemail, chat and notes.
Switchboard Pro enables your receptionist to view real-time presence, manage multiple calls (call park, hold,
transfer), coordinate with other receptionists, and toggle Auto Attendant.
o Switchboard Pro is currently designed to work alongside Polycom desk phones.
o Call Parking has three modes:

= Public Call Parking, which parks the call on an extension that is available for anyone on the PBX to pick up

the call.

m Branch Call Parking, which parks the call on an extension only available for pickup by an extension defined

as part of the affected branch office.

m Extension or Private Call Parking, which parks the call on a specific extension, only allowing retrieval from
that particular extension.
For example, the receptionist parks the call on extension 1101, which belongs to Jane Davis. As a result,
the parked call can only be picked up from Jane's extension.

m BLF keys on Polycom desk phone to monitor and transfer calls
m Paging (over speakerphone or overhead PA system) to announce call parking

m Public Call Parking from desk phone

Use Case

Let's consider a business with five branch offices. Specialty Cookies has set up 5 stores in California, with a small group
of employees at each store. Their main store in San Francisco is a larger operation. Specialty Cookies wants to
segment its Company Directory for each branch to streamline branch-specific calls.
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Let’s look at the requirements for Specialty Cookies, and review how the 8x8 solution can meet the requirements.

N7
!HEQExI.

BRANCH DFFICE

Ext. "ﬁaﬂ"
CENTRAL SITE |||| ’”«‘

- xt. 39 Ex
BRANC

Each store requires:
= Live Attendant to answer calls during business hours
= Auto Attendant for after hours
m  Outbound Caller ID to show local area number when calling customers from the branch

m Extension dialing between stores

The main store in San Francisco requires:
= Auto Attendant for business hours

= Ring group to answer calls after hours

8x8 Solution
Virtual Office can meet Specialty Cookies’ requirements using:
m 5 branch offices

1 Auto Attendant

4 Additional attendants (one each for the branch store)

5 Virtual Numbers

1 ring group

Version 1.0
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Set up Branches

Setting up branches requires you to select a branch main number from your pool of virtual numbers, define a branch
receptionist, and point the virtual number to the branch receptionist.

Preparation
1. Determine a receptionist for each branch:
m [f the receptionist of a branch is a live attendant, gather the extension number.
m If the receptionist of a branch is an auto attendant, define an auto attendant.
m If the receptionist of a branch is a ring group or a call queue, define the desired ring group or call queue.
2. Determine a virtual number for each branch.

3. Determine the number of extensions for each branch.

Main Tasks to Set Up

m Create your call queue, ring group, or auto attendant as desired.
m Select a virtual number for each branch.

m  Specify a receptionist for the branch; if a call reaches voicemail, the caller can either leave a voicemail or dial <O#>
to reach the branch receptionist.
Your receptionist can be:

o An extension (live receptionist)
o An auto attendant
o A call queue (multiple live receptionists)
o Aring group (multiple live receptionists)
=  Add extensions to the branch.
m Point the branch virtual number to the branch receptionist.

= Segment the auto attendant options (dial by name, extension, or Company Directory) to streamline searching if a
branch virtual number points to an auto attendant.

Configure a Branch

Configuring a branch involves the following steps:
Step 1: Log in to Account Manager

1. Log in to Account Manager.

2. Click Phone System.
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Step 2: Set up a Branch

1. Under the Phone System menu, click Branches.
A set of branches is waiting to be configured.

Branch Office - An Overview

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT |

VIRTUAL OFFICE ONLINE

Home = Phone Sysiem > Branches

> Company Setlings

> Edit Voic email / Fax
Notifications:

3 Group Call Pickup

3 Call Park Extensions

PHONE SYSTEM Branches
3 Extensions = S = =
> auto Attendant d d d d

— none selected - 0 — none selected - — none selected - — none sekected — SetUp
% Virtual and Tol-Free

Humbers - none selected - 0 - none selected - — none selected - — none selected SetUp

> Ring Groups - none selected 0 - none selected - none selected — none selected — SetUp
> Music on Hoki o 5 o o o

- none selected - - none selected - - none selected - - none selected - _
3 Call Queues Setip
> Shared Lines — none selected - 0 — none selected - — none selected - — none sekected — SetUp
> Branches
> Switchboard
> Paging

2. Select a branch and click Set up to begin defining a branch.

3. EnteraBranch Name.

4. EnteraLanguage.

This language is set as your branch default language. Telephony VR messages, such as voicemail greetings, are

played in this language. You can also set the language at the PBX level.

Individual Extensions.

Note: The PBX or branch language does not affect the agent's desk phone display. You must
select the language of preference for the individual extension user. For details, refer to Edit

Summary of Localization Settings

The following table summarizes the localization settings in Account Manager:

éConfigured At

Setting Description
Edit My The primary or secondary administrators who have access to Account
Profile - Manager can configure the Language setting in Edit My Profile to

- User level

Version 1.0
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Setting Description éConfigured At
communicate emails in their language of choice.
This setting overrides the default PBX or branch language setting. It only
applies to the administrator's email communications.
Account > Configure the Language setting for extension users to communicate emails ini User level
User - their language of choice.
Profiles . —_— ) .
: This setting in user profile overrides the default PBX or branch language. It
only applies to the user's email communications.
Phone Configure the Language setting for all users in the PBX to receive Telephony PBX level
System >  |[VR messages, such as voicemail greetings in the selected language. This
Company setting is overridden by language settings at the branch and/or individual
Settings  : extension level.
In the absence of the individual extension user's language of choice, the
-language setting of branch overrides the PBX language setting.
Phone Configure the Language setting for users to receive Telephony Branch level
System > |VR messages, such as voicemail greetings in the selected language.
Branches In the absence of the individual extension user's language of choice, the
(Add-on branch language setting overrides the PBX company language setting. In
subscrlptlon—é other words, if an extension belongs to a branch set to Japanese, and if you
based) - have not defined another language at the extension level, Telephony
' IVR messages are played in the Japanese language. If the extension belongs
to a branch with no other language defined, you inherit the PBX language. '
Phone Configure the Language setting for extension users to receive Telephony Extension level
System > ' |VR messages, such as voicemail greetings in the selected language. The
Edit - display on the user's desk phone also appears in this language.
Individual This setting overrides the PBX and branch language setting.
Extension

: = Note: If you need help with setting the user language in bulk,
- contact 8x8 Support for help.
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Setting Description éConﬂgured At

Note: To access localized versions of 8x8 Virtual Office
applications, refer to your computer or device manual to learn
how you can change the display language of your operating
system.

6. Enterthe branch address.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Branches > Set up Branch

Set up New Branch
| Branc |

PHONE SYSTEM

Edit Branch Address

“all Branch extensions

Change Branch Address

Country *
United States. v
7 Branches street Number*
> Switchboard
Pre-Directional Street Name™ Street Name Suffix ~ Post-Directional

v v v

E Secondary Locatien  Unit/Other

v
| Manage Extensions |
| City* State” Zip Code™ Zip+4
v -

Note: The Address field is for reference purposes, and does not have any impact on the
functionality.

7. Select a Receptionist Type.

Receptionist type points to the branch receptionist, which defines the destination for calls landing in an extension
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voicemail. On reaching an extension voicemail, callers can leave a voicemail or dial <0#> to be directed to the

branch receptionist from the following choices:
m Extension (local receptionist)
= Ring Group (multiple receptionists)
= Auto Attendant
m Call Queue

8. Select a Receptionist based on the type.
If the receptionist type is Extension, select an extension from the available list.

Note: The branch administrator appears under the view-only Admin list. You can determine the
secondary administrator for a particular PBX under Accounts > Privileges > PBX.

9. EnteraBranch Code. A branch code must be unique within the same PBX, but can be used in a different PBX.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Branches > Edit Branch

Edit Branch

PHONE SYSTEM
Branch Info

¥ Extensions
¥ Auto Attendant *Branch Name: San Francisco Address:  Add
¥ \irtual and Tol-Free
Numbers Language: English (U.5.) v Set Main Number as outbound caller ID for all Branch extensions
¥ Ring Groups
> Music on Hold Main Number: Virtual Number. Ext 41002 {408) 555-3679 v
> Branches }
—— Receptionist Type: | Extension v
7 Humber Transfer Receptionist: Alias Curry (408) 555-3663 Ext 41003 v
Request
> Gall Recording Tom Brent
> Edit \Voicemail / Fax Admin(s): Jason Bogut
Notfic aticns : Jason Bogut
> Group Call Pickup EaSyHCOi e
> Call Park Extensions Branch Code: n
Extension Length: 5 [7]
Phone
= ions
Setup

Fully Qualified
Extension

41003 (4D8) 5553683 Alias Curry Branch Default v

‘ 41002 (408) 555-3662 Jim Toreye Branch Default v

External Contacts

10. Enter an Extension Length. This is the combined length of the branch code and short code. This is specific to the
branch only.
The short code will now transform to a fully-qualified extension, which includes the branch code and the short
code. For example, if you assigned branch code 4 to the San Francisco branch office, branch users with short
codes (such as 1001) will be assigned with a fully-qualified extension number (such as 41001).
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multiple PBXs and branches.

Note: Branch Code and Extension Length are only applicable to enterprise customers with

Step 3: Assign Extensions to the Branch

You can assign regular extensions as well as service extensions to a branch. Assigning a service extension is managed

in the respective configuration page for ring groups, call queues, and auto attendants. For details, refer to Assigning
Service Extensions to a Branch.

To assign regular extensions:

1.

Version 1.0

Click Manage Extensions.

HOME | PHOME SYSTEM | BILLING | REPORTING | ORDERS | MYACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Phone System = Branches = Edit Branch » Manage Extensions Enter keyword

Manage Extensions - Mountain Yiew Branch
PHOMNE 5YSTEM

¥ Auto Attandant Ho Extensions are assigned yet to this branch
> Virtual and
Toll-Free Humbers

¥Ring Groups

¥ Call Queues
> Shared Lines To select an extension, type the extension number, caller ID first name, caller ID last name, branch name or phone number and hit the search button
» Branches Quick Search @

? Switehbaard Search by name, ext, branch name or phone number

> Paging
> Company Settings

¥ Humber Transter Select the extensions and click add button

B Existing Extensions
> Extensions

S — B Auvailable Extensions

> all Recording
> Edit Voicemail /

Hadioticaiicns 1018 (557) 5289660 qatestbles2 qatestblesz Branchi_RENAME
? Cordless Devices
1012 [667) 203-7678 QA Testz34 Branch1_RENAME
1008 (665) 801-6721 qatestblee2 1008 Branch2
Fhone
System
Mo [A0E) 532-5339 atestblee2 110 Hugo Test
Setup s i o
109 (408) 532-6338 qatestblesZ 108 Hugo Test
1010 (557) 282-4405 Lanore Testf2 Lanore Test Branch Los Gatos
D 102 (402) 6272674 San Francisco 102 San Francisco Branch
| 1014 (557) 3762118 Austin 1014 Austin Branch
I:l 103 [408) 532-5374 Hew Yorc 103 Mews ot Branch

A list of all extensions within the iPBX is displayed.

Select the desired extensions, and click Add.

The extensions are now mapped to the branch.

Click Save.

Repeat the setup process to define all other branches in your iPBX.

The next step is to assign a destination for the branch virtual number. If you already assigned the destination,

make sure it matches the receptionist type defined for the branch.
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Step 4: Select a Destination for Branch Main Number (Virtual Number)
1. Click Phone System in the top navigation bar.
2. Under the Phone System menu, select Virtual and Toll Free Numbers.
3. Select the virtual number assigned to a branch, and click Edit.
4

Select the destination to match the receptionist type defined for the branch in Step 3: Assign Extensions to the
Branch.

o

Optionally, change Service Address to match the branch address.

6. Click Confirm to save.

EditTol-Freertual Nmber : ”7 : 7 7 e @

N

Please select the destination for this number

Number Type Virtual Number
F = Phone (510) 248-1000+
Destination Ext 1040 - Unassigned Unassigned, (209) 315-1007

a»

Optional Caller ID Name: First Last
Allow User Access to Optional Caller ID [ (7]

i
i Change Service Address [N &
n Country * _c
" United States o ‘(
n Street Number* q
a 810 "
@ Pre-Directional Street Name* Street Name Suffix Post-Directional -
a W - West 4+ MAUDE Avenue o o :
A Secondary Location  Unit/Other i
q A
v
a -
City* State* Zip Code* Zip+4 -
@ SUNNYVALE California 4 94085 - 2910 _
a -4
a b

[Con ] Gl [

................. —r—r——r— ——r—— e ——— e
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Note: The destination for the branch virtual number must match the receptionist type defined for thé
branch. '

Manage Extensions in a Branch
You can add or remove regular extensions to a branch and change branch assignment any time. Click Manage
Extensions within the branch settings.

m Add: From the available extensions, select extensions and click Add.

m Change Branch: Select a branch extension. In the Change Branch drop-down, select a desired branch from the
available branches.

Ext ions - M ain View Branch

B Existing Extensions

Change Branch
Change Branch
Specialty HQ
Hugo Test

Branch1_RENAME Austin 1014

Branch2

San ra"msco Branch qatestblee2 gatestblee2

Austin Branch

New York Branch qatestblee2 qatestblee2

test to delete

McLarens Young International Lanore Test123 Los Gatos

Duplicate Ext Bug Test
~ Branch3

Lanore Test Branch

%X X X X

s Remove Branch: Click to remove a branch.

Note: Adding or removing service extensions should be managed via the respective service extension

configuration page.

Assign Service Extensions to a Branch

The 8x8 PBX administrator can now assign the following types of service extensions to a branch:
= Ring Group
= Call Queue

= Auto Attendant
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f— Note: A branch administrator with privileges to service extension features can assign service
| extensions to the branch they manage.

Assigning these service extensions allows a branch receptionist to access these extensions from the contact directory
and route calls easily.

To assign these service extensions to a branch, you must go to the feature configuration page. For example, to assign a
ring group you must create a new ring group or edit an existing ring group, and select the branch and receptionist type.

B Note: Assigning service extensions to branches must be handled via the configuration pages for service§
;:ﬁ extensions. In the branch configuration page, you can view the list of assigned service extensions. This

information is read-only.

To assign a ring group extension to a branch:
1. Log in to Account Manager.
Go to Phone Systems > Ring Groups.

From the list, select a ring group to edit.

Bl A

Select the desired branch from the drop-down menu.
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Select the Receptionist Type from the available choices.

Branch Office - An Overview

HOME | | PHONE SYSTEM || CONTACTCENTER | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Phone System > Ring Groups > Edit Ring Group

Edit Ring Group
PHONE SYSTEM

Edit your Ring Group and then click Save
> Extensions

¥ Auto Attendant o Groms Dotals
Ring Group 1
3 Virtual and Toll-Free

Numbers

¢ Ring Pattern
> Ring Groups Ring Group Name Paints

Cyclic pstter is aiso known as roll
3 Music on Hokd over and alows equsl distribution of

Ring Group Extension calls, making sure all extensions in
> Call Queves

> 5 snswerng the cals. You can choose
Branches Ring Group Caller ID Ring Group Name and Ring Group Extension LN 7] how many times the call cycles
% Switc hboard through the extensions before
= sending calls to your no answer
> Company Settings Ring Pattern Cyclic Repetitive v destination.
> Number Transfer
Branch Branch 1 v . .
Request Cyclic Repetitive psiien
> Call Recording distrbutes calls smong all sxtansions
Cost Center Name v in the group in the same order that
> Edit \ioicemail | Fax the extensions are listed. Each new
Motific ations call starts at tha first extansion in your
fonis : v fist. You can choose the number of
> Group Call Pickup EEcephon=liveed times the call cycles through the
N xtansions befora sending cals to
> Call Park Extensions Number of Cycles 7 v your no snswer destination.
Voicemail Password (7] simultaneous Ring rings all
extansions in the group st the same
‘Warning : Any updates to voicemail password must adhere to the minimum time. The first extension to pick up
enforced length of 4 digits. the phone will answer the call.
If all lines are busy, forward
- 5 b Vi v
immediately to bicemail Ext 555
If no one in ring group answers, . -
. e v
e bicemail Ext 555 after 10| sec(s).
Immediately Forward Calls to None L]
Internet Outage Forward Voicemail Ext 555 v

@ Helo

Based on the receptionist type chosen, select the Receptionist.

Click Save.

To assign a call queue extension to a branch:

1.

LIS

Version 1.0

Log in to Account Manager.
Go to Phone Systems > Call Queues.
From the list, select a call queue to edit.

Select the desired branch from the drop-down menu.
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5. Select the Receptionist Type from the available choices.

HOME ||FHONE SYSTEMIl CONTACT CENTER | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System = Call Queues > Edit Call Queue m

PHONE sYSTEM Edit Call Queue © Hele

? Extensions
> Auto Atiendant Call Queus Details

> Virtual and Tol-Free

— Call Queue Name * Delivery Call Queue
- P A call queue places callers in s queus while
? Ring Groups Extension sgents handle other calls. The calis are then
3 Music on Hold Time Before Next Call * 45 0 {in seconds) snswered in the order received as agents become
st k _ svaiable
¥ Call Queues Max callers in Queue * 10 v| @ (max20)

Branch = In YAgent Assignment!’ saction, select whether to
> Branches BraE sllow agents to log in and log out of their assigned
> Swite d Cost Center Name v queues. If you select YES, agents can log

Switc hboard themselves in and out using their Virtual Gffice
e Receptionist Type: = Onine socounts ar an IF phone. If you select NO,
» Company Seftings agents wil sutomatically b logged in to the cal
> Number Transfer If queue is full, forward immediately to Voicemail Ext 555 v @ queus
Reguest i
i It all agents logged out of call queue or if . . NOTE: Agents tell Call Queus they are in DND (Da
» Call Recording all agents have server side DND status, | “oicemail Ext 555 v @ Mot Disturb) mode ONLY from their Virtus| Office
- immediately forward call to Onine scoounts. If agents set DND from their 1P
> Edit \oicemail / Fax v . . Phone, the call queue wil stil consider them an
Motific ations Internet Outage Forward Voicemail Ext 555 v sctive agent and send calls to their |P Phone.
* Group Call Pickup . TR YEIAD

mmediately Forward Calls to

> Gal Park Extensions None L2

Voicemail Password * (7]
‘Warning : Any updates to voicemail password must adhere to

the minimum enforced length of 4 digits.
Prons s=Indicates Required Fields
System
2% Scup

6. Based on the receptionist type chosen, select the Receptionist.

7. Click Save.

To assign an auto attendant extension to a branch:
1. Log in to Account Manager.
Go to Phone Systems > Auto Attendant.
From the list, select an auto attendant profile to edit.
Select the desired branch from the drop-down menu.

Click Save.

o &~ oD

To view the service extensions available to a branch:

After assigning the desired service extensions to the branch, you can view the read-only list.
1. GotoPhone System > Branches.
2. Select the branch to edit.

3. Note the service extensions assigned to the branch are listed under Extensions.

Change Branch Receptionist at Extension Level

When a call reaches an extension voicemail, callers can choose to leave a voicemail or dial <O#> to be directed to the
branch receptionist. By assigning a receptionist at the extension level, you can make sure calls requiring immediate
attention get a live response rather than landing in the voicemail box. For example, if a customer tries to reach Tier 1

Version 1.0
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Support after hours, the branch receptionist for Tier 1 Support may point to the ring group of Tier 2 Support with
extended hours.

During branch definition, the Receptionist Type determines how to route the calls reaching voicemail. If you need a
different routing for a specific extension, you can specify the desired destination at the extension level to another
extension, a ring group, call queue, auto attendant, or a different branch.

Note: The receptionist type for service extensions should be configured in the service extension
configuration page.

To change the branch receptionist for an extension:
1. Within the branch setup, click Manage Extensions.

2. Click to choose a different receptionist from the drop-down list, instead of the branch default.

Edit Branch
Branch Info

*Branch Name: Mountain View Branch Address: Add
Main Number: Virtual Number. Ext 444, (559) 817-3516 |
Branch Default
Type:  Auto E] 1P PHONES Ext 2001
MGCP Ext 2002
Receptionist: AA #2 Ext 4440 | VE RG Ext 2003
ALL RG Ext 2004
Admin(s): - none selected — Support Tier 1 Ext 2005
Specialty Cookies Ext 444
| AA #2 Ext 4440
A £
AA#4 Ext 4442
ReynaTest Ext 4443
Branch2Sam2_AA4444 Ext 4444
Lanore Branch Test Ext 4445
- it o ey TestAAupload Ext 4446
Branch1Sam1_AA4447 Ext 4447
1014 (557) 376-2116 Austin 1014 | San Francisco Branch Ext 4448 |
New York Branch Ext 4449
1019 (557) 629-9660 qatestblee2 qatestblee2 Austin Branch Ext 4450
1018 (557) 620-2581 gatestblee2 gatestblee2 San Francisco 102 (408) 627-8674 Ext 102
New York 103 (408) 532-5374 Ext 103
1020 (101) 131-6679 gatestblee? qatestbles2 Branch Default =
3. Click Save.

Auto Attendant Segmented by Branch

Auto Attendant can be customized to your branch, which saves callers time while they search contacts by name,
extension, or Company Directory. You can customize the following call routing options in an auto attendant to point to a
specific branch or to the whole PBX.
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i &=, Note: IfaCost Centeris bound to a Branch, selecting the Branch results in a read-only Cost Center
;:ﬁ field. However, if there is no Cost Center bound to the selected branch, the Cost Center must be
selected manually.

= Dial by Name
o Segmented by Branch

o Use Case: When you select a branch, the caller who opts to dial by name goes through the names for the

specified branch instead of the whole PBX.
= Dial by Extension
o Segmented by Branch
= Play Company Directory
o Segmented by Branch

To customize Auto Attendant for a branch:
1. Goto abranch auto attendant in Account Manager under Phone System > Auto Attendant.

2. Click Edit next to the desired auto attendant profile.
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3.

4.
5.

Callers going through these Auto Attendant options now search through extensions assigned only to the branch.

Version 1.0
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In the Auto Attendant Information pane, select a branch from the drop-down choices.

B Auto Attendant Information

Auto Attendant AA #2 Profile Name with Greetings
4440 Time Zone  US/Pacific |

Austin Branch l'_|

¥ Hours of operation

¥ Business Hours Rules and Recordings

Below are your business hours rules and recordings menu settings for this profile. Test Menu

(8)
Auto Attendant at a Glance Auto Attendant: Main Menu

Use the menu options below to define the action the Auto Attendant should take when the option is
selected by the user. Use the &» and @ buttons to add and delete menu options.

v Business Hours

(@ company Directory

n Conference Bridge Dialpad Key Settings Re-order Dialpad Keys'
g Dial By Extension Press Description Call Routing
© Dial By Name Key0o ~| Company Directory | [All Extensions I~ —]
BO>ram All Extensions

Key1 ~ Conference Bridge = Branch1_RENAME
>621: Sales y1 = 9 £ Branch2 e
@ > 1001:qatestblee2 1001 Key2 ~| Dial By Extension ~| gfzﬁgﬁ =]
> 2001 : IP PHONES Lanore Test Branch

Key3 ~ Dial By Name hd
@ Voice Mail System o3 x| ial By 2l testto delete ) e
€ No Action Keyd ~| Transfer to Auto Attendant - | Austin Branch e

N % Branch
Key5 ~ Transfer to Call Queue  ~ Mountain View Branch - —]
= J J McLarens Young International
Keys ~| Transfer to Extension ~| guﬂg::te 52 Bug Test M| =]

Expand the Business Hours Rules and Recordings pane.
In the Auto Attendant page, select a branch for:

a. Company Directory

b. Dial by Name

c. Dial by Extension

Note: All the options mentioned above within an auto attendant must point to the same branch.
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Define a Branch Administrator

You can grant branch-specific privileges to an administrator role. The branch administrator can oversee configuration of
an assigned branch only. A branch administrator can view the regular extensions and service extensions assigned to the
branch. Additionally, they can assign the unassigned regular and service extensions if they have the right privileges.
They can access call recordings of extensions that are assigned to their branches only.

To assign branch-specific privileges:
1. Click Accounts in the top navigation bar.
Under the Accounts menu, click Privileges.
Click Assign New Privileges to manage user profile privileges.
Select an administrator from the existing user profiles.
Select desired privileges for the administrator.
Select the branch office under PBX.
Click Add.

N o o w0 DN

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts > Privilages > Assign Privileges

Assign User Privileges @ Help
ACCOUNTS
ST To allow ather peaple to view or manage this account, first select a User Profile, then define which areas of this account they can access.
ser Profies
> Privileges
: Account Manage Privicges pax
¥ Communication
Preferences To assign privileges to existing user(s), selectthe user Selectthe account privileges for this Apply privileges to these PBXs
» Contact Dirsctory profileis). Otherwise choose to Create New User Profile user(s).
Single Sig | SpecialtyCookiesinc
:"'”='-_-"=” & Create New User Profile 8l sometan ey
Arelytis Frvieges Phil Test | Phone System Services I San Jose
#| Annie Thomas I Billing . San Francisco
Phillip Liu ¥ Reporting Cupertino
James Murphy #l Orders Santa Clara
Angelique Yu ¥ Accounts Palo Alto
Nalini Ananthamurthy ¥ Support

Ramana Gottipati
Melissa Browns
Anil Verma

(A Cancel

You can assign multiple branch offices to an administrator.

View Branch Specific Extensions

When a branch administrator logs in to Account Manager, they can view regular and service extensions assigned to the
branch. If they have privileges to the service extension features, they can create and assign service extensions to the
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branch they manage. For example, if the branch administrator has privileges to manage ring groups, they can create a
new ring group and assign it to the branch.

In the branch page view, the branch administrator can view:
m Regular extensions assigned to the branch
m Regular extensions available for assignment to the branch

m Service extensions assigned to the branch
In the service extensions (ring groups and call queues) page view, the branch administrator can view:

m Service extensions assigned to the branch

= Service extensions available for assignment to the branch (applicable if you have the privileges for service
extension features)
Access Call Recordings

Branch administrators are allowed to access call recordings of extensions assigned to their branch(es) only.

To download call recordings:
1. Click Phone System in the top navigation bar.

2. Click Download Call Recording.

HOME PHONE SYSTEM || BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Extensions Enter keyword | Search |
Extensions @ Help
PHONE SYSTEM
> Extensions Quick Find / Edit Extension
> Auto Atiendant [EZIEN EEE] enter extension number, phone number or caller ID.

> Virtual and Tol-Free
Numbers

» Ring Groups

» Company Setings Extensions Extensions Numbers Recordings Options
> Number Transfer o
> Edit Voicemail | Fax =

[ View | [ Eat | [ Change |

Notifications
Dounioad [Contoure |
Phone
Syslem
Setup

3. Select your filtering options. Enter the desired date range, time zone, and select the desired extensions. If you are

a branch administrator, you will see the extensions assigned to the branch only.
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Download Call Recordings @ Help

Use the filter below to search for Virtual Office Pro extension call recordings. You must enter at least one search option.

Search Options

Date Extensions

Start Date [ select All
Sep 29 2011 08:12AM =]

) Accountant Annie (555) 792-4996 EXT 1009

End Date [ Becky Carmichael (650) 646-2988 EXT 1002
Sep222011 08:12 M FEH [ Lobby Manager (650) 646-3018 EXT 1001

[_| Diana Jay Smith (555) 648-0703 EXT 1006

Time Zone
=
e r [ Ron Nader (408) 627-8740 EXT 1007 T
() Shirley Beckmann (650} 646-3006 EXT 1004 :
M Rk mmbe Bricmma] IBEEAL LS AL ARNRA VT 4AATD
Soa

Note: You must select at least one extension.

4. Click Search.
The search results are displayed.

5. Select the check box next to the recording(s) you want to access.

6. When you access the recordings:
m Tolisten to a single recording at your desktop, click Play next to the desired recording.
m To download a single recording to your computer, click Download next to the desired recording.
m To download the selected recording(s) to your computer, click Download Recordings.

m To delete the selected recording(s), click Delete Recordings.

IDswmIaa:i Recordings | Delete Recordings I
First [4] 1-100 of 855 [3] Last Recordings Per Page | 100 ¥

Phone
System
Setup [ ] From To Call Recording Date and Time ~ Call Direction  Call Duration  Recording Size (MB)

Rob Shasta 1020 01-27-2017 19:12:03 Outbound 00:03:38 1.6624 Play / Download

Sarah Thomas 1023 01-27-2017 19.07:29 Outbound 00:04:01 18417 Play / Download

Lisa Black 1029 01-27-2017 19:05:32 Outbound 00:01:21 08177 Play / Download

Barge-Monitor-Whisper

8x8 Barge-Monitor-Whisper is an add-on service that helps office managers and supervisors to monitor phone
conversations of employees on 8x8 PBXs with customers or others. Whether it is to ensure quality of customer service,
coach new agents during a conversation, or interrupt a live call for an emergency, 8x8 Barge-Monitor-Whisper gives you
flexibility. For more information, refer to the Barge-Monitor-Whisper User Guide.
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This option is available to you only if you have subscribed to the 8x8 Barge-Monitor-Whisper service. Barge permissions
are provisioned to extensions at the time of ordering the barge service with 8x8. In Account Manager, these extensions
show configurable barge permissions.

- Note: Barge permissions are granted to primary extension users only, which excludes extensions
associated with call queues, ring groups, virtual extensions, or auto attendants.

Once provisioned, extension users have the following permissions:
= Ability to monitor all extensions within the PBX.
= Ability to secretly monitor and barge in on all extensions.

= Ability to monitor without entering voicemail password.

As a phone system administrator, you can restrict or change the permissions as follows:

m Restrict or disable barge permissions for an extension through barge lists. A barge list specifies the extensions of
agents whose conversations you can barge in on.

m Enable barge tone that alerts the agent about the barge action.

m Prevent misuse of barge by prompting for an access code.

Configure Barge Permissions for an Extension User

As a phone system administrator, you can select an existing barge list to monitor or create a barge list, enable barge
monitoring tone, enable barge voicemail password, and select the extensions to be monitored.

1. Click Phone System in the top navigation bar.
2. OnView All Extensions, click View.

3. Select the extension you need to change barge permissions for.
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4. Click Edit to view the extension settings.

Account Manager Company Name: Specialty Cockies | Main Number: (510) 962-5321+
% m"'c’ Welcome, Phillip Liu | Sign Out
Email: pliu@8x8.com Account: Business i |

Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Manage Extensions Enter keyword
Manage Extensions @ Help
PHONE SYSTEM

Below is an overview of all extensions. You may edit the extension details individually be clicking Edit next to each extension or as a group by clicking on Edit
Multiple Extensions.

*» Extensions
» Auto Anendant
Edit Multiple Extensions | Change Extension Number | Download Call Recordings | Download Extensions (csv) | Download Activation Codes
3 Viniel nd FoR-F7ee = ot Sorvice T B = = Ser 1D — Volcamalido-Email Addres,
Niisiaay ctions Stat Service Typ = E C: D C: D Devic
» Ring Groups

» Music on Hold

Edit |

Unlimited Extension Pro 1016 Virtual Office Softphone 'shantanu. garud@8x8 com

Active J Shantanu Garud
148+
>ca | : (408) 329-7148 d —
Ry * Edit | Active  Unfimied Extension Pro 1017 ieep, 04 gy ) Sarah Thomas Virtual Office Softphone ‘nalini ananthamurthy @8xB.cq
» Switchboard Edit | Actve  Unlimited Extonsion Pro 1018 (40q) 3007449’ David Leach Virtual Office Softphone david leach@8x8.com
? Paging Edit | Active Uniimited Extension Pro 1019 (408) 3287150+ Maricn Dutay Virtual Office Softphone imarion.culay@8x8.com
>
)c‘"”"'"" b Edit | Actve  UnimiedExtonsionPro 1020 (40 176 74510 Dve Provenza  Vinual Offce Sofiphone _ dave provenza@8xa.com
Number Transter

3 Catl Recording ‘ Edit | Actve  Unlimitod Extonsion Pro 1021 (404 10 7185+) E Smith Virtual Office Softphone erik archer@8x8.com
» Edit Voicemail / Fax Edit | Actve  Unlimied Extension Pro 1022 404 30g.7159+" Mk Reinhart Virtual Office Saftphone mike. reinhart@exs.com

Edit | Active Unlimied Extension Pro. 1023 459, 355 719 Chistine Richardson  Virual Office Softphone: christine.richardson@8x8.cor

5. Click to expand the Barge Permissions pane.

Version 1.0

= Extension Settings

Time Zone US/Eastern v Travelling Outside the Country [ | @ View Billing Statements | | @
Preferred Codec G.729A (30 kbps) v | @ Hide in Auto Attendant Directory || @ Allow Social Networking [ | )
Ef;:rgr::cv Service | 2125 ONEL DR, SAN JOSE, CA05131-2032 v | Ecit  AllowMusic on Hold Selection | | ) Enable Inbound Caller D |y @
Outbound Calling | Allow International Calling v Permanent Caller ID Blocking (1) @

Options

Language PEX Default v

B Voicemail Settings

B virtual Office Pro Information
B Call Forwarding

B Extension Membership Display

¥ Communication Preferences

= Barge Permissions

Configure Barge permissions for this extension View, Edit, Delete, Barge List{s): RUELED RGN ()]
Monitor Tone Enabled 0 Select which extensions can be monitored. ® A  List ' None @

Barge Password Enabled @

Save Changes
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6. Select or change the desired barge settings.

Barge Permissions Description
Monitor Tone Enabled If enabled, relays a beep tone to the agent, signaling a barge session.
Barge Password Enabled If enabled, prompts the supervisor to enter the voicemail password before

beginning to monitor.

View, Edit, Delete, Barge List(s) Lets you create, manage, and delete barge lists.

Select which extensions can be = All allows barging in on all extensions.

monitored = Listallows barging in on extensions in a specific barge list.

m None disables barging.

7. Click Save Changes.
Create a Barge List
A barge list includes extensions which you can barge in on. You can create a barge list and assign it to an extension with
barge permissions. It allows the extension user to barge in on extensions in the barge list.

1. Click Phone System in the top navigation menu.

2. OnView All Extensions, click View.

3. Click Edit by the extension you wish to manage.

4

Click to expand the Barge Permissions pane.
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5. Click Manage Barge Lists.

= Extension Settings

Time Zone US/Eastemn v Travelling Outside the Country @ View Billing Statements [7]

Preferred Codec | G.720A (30 kbps) v | @ Hide in Auto Attendant Directory @) Aliow Social Networking [7]

El:;lwnﬁi' Service ' 2125 ONEL DR, SAN JOSE, CA95131-2032 v | Edit Allow Music on Hold Selection @ Enabie Inbound Caller ID & @
ess

Outbound Calling | Aliow International Calling v Permanent Caller ID Blocking (7]

Options

Language FBX Default v

¥ Voicemail Settings

¥ Virtual Office Pro Information

W Call Forwarding

¥ Extension Membership Display

¥ Communication Preferences

= Barge Permissions

Configure Barge permissions for this extension  View, Edit, Delete, Barge List

Monitor Tone Enabled

Barge Password Enabled
[Cancel

(7] Select which extensions can be monftored. = 2 List None @

o

6. Click Create New List. Name your list, and add extensions to barge in on.

Version 1.0

% 8x8,Inc.

HOME | PHONE SYSTEM

Home > Phone System > Lists

List
PHONE SYSTEM

» Extensions

Create lists of extensions 2

Account Manager

Company Name: Specialty Cookies

Welcome,
Email: pliu Lists define what extesnions are addressable by other extensions for use with services such as
Edit My Profi Barge.

| BILLING | R 1-NameyourList {E
Tier1SupervisorList ¥
2. Select the extensions to be induded in the white list Enter ke

First [4] 1-10 of 50 [3] Last

» Auto Attendant Extension Name Phone number
» Virtual and Toll-Free
Nisiiee Create New List S R
» Ring Groups
» Music on Hold 1002 16506462988
> Call
Call Queues - = — ’ 2092
» Shared Lines First [4] 1-1 of 1 [¥] Last 650646
» Switchboard 1004 165064630068
» Paging SupenvisorBargelist
» Company Settings 1005 16506463020
» Number Transfer
1006 15556480703
* Call Recording
» Edit Vioicernail / Fax 1 1007 1 78740
Notifications -
~ 1009 14083297176
£4 1010 15557983628
Phone s
System
o) o 1011 14083207136

Copyright 2011 8x8, Inc.  www.8x8.com | Refermals | Privacy | Temme o oo
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7. Click Save.

Set up Power Keys

8x8 Power Keys (formerly known as Virtual Receptionist) is an add-on service that provides powerful call handling and
work group monitoring abilities using any Polycom phone with four or more line keys, using your new VVX phones, or
using your new VVX phones with SideCars attached. Using the Power Keys service, a manager or a power user can
handle multiple calls simultaneously and monitor the availability of other extension users on the same PBX.

For more details, refer to the Power Keys User Guide.

Configure Line Keys

As a Virtual Office PBX administrator, you can set up the initial configuration of line keys in Account Manager, and
push these settings to the Power Keys enabled extension phone from Account Manager.
You can assign:

m Line Appearance Key (LAK): to receive and handle multiple live calls.
m Busy Lamp Field Key (BLF): to track the status of other extension users on the same PBX.

m Speed Dial Key: to quickly dial out to most frequently used number.

Configure Line Keys for a Power Keys-Enabled Extension

1. Click Phone System in the top navigation bar.
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2. OnLine Key Configuration, click Configure.

Account Manager Company Hame: pelycambk
88 8x8,Inc. Welcome, Bill Korbe WX Test 2010 | Sign Out
Email: bkorbe@8x8 com Rccount: Business =
Edit My Profile
BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Phone System > Extensions Enter kayword
Extensions @ Hep
PHONE SYSTEM
:f“mm;:':m Quick Find / Edit Extension
t
» Vibstand Tobobres BEETH Enter extension number, phone number or caller 1D,
Numbers
3 Ring Groups

R bin i View Al Change Extension
3 Call Qususs Extensions Extensions Humbers Recordings

2 Paging

T Ry Qo

> Number Transfer

> Call Recording .
| View | [ Eait | Change Download
» Egit Vorcemal/ Fas y . —
INotifcations

Outbound Calling
e

» Cordoss Dovices

System

Copyright 2011 Bx8, Inc.  www.8x8.c0m | Referrals | Priacy | Terms & Condaons | Gantact Us | Feodonck Suppornt: (888) 196-6733~

A list of extensions eligible for line key configuration displays.

3. From the list, select an extension and click Configure Line Keys.

Ext  Phone Number Caller ID First Name Caller ID Last Name

1005 (555) 148-2556+ BillKorbe 1005 PolycomTest Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:01 PM (PST) Configure Line Keys
1010 (415) 508-5060+ BillKorbe 1010 Pilot-Test-550 Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:02 PM (PST) Configure Line Keys
1054 (557)358-1270+° VWX 500PilotLab  Bill K Ext 1054 Polycom VWX 500 Rebooted 2012-06-27 03:25 PM (PST) Configure Line Keys
1053 (557)356-1221+ VVXSO0PiotLab  Bill K Ext 1053 Polycom VWX 500 Rebooted 2012-06-27 02:23 PM (PST) Configure Line Keys
1056 (567)377-5541+ VVXS500Pilotlab  Bill K Ext 1056 Polycom VWX 500 Rebooted 2014-05-07 01:16 PM (PST) Configure Line Keys
1055 (s57) 375-5405+ VVX 500 PilotLab  Bill K Ext 1055 Polycom VWX 500 Rebooted 2014-01-10 04:58 PM (PST) Configure Line Keys
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You are prompted to back up the Contact Directory or speed dials on the phone.

BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE
figuration Enter keyword Search

Configuration @ Heb

he extensicns that are eligible for Line Key Configuration through the Account Manager.

BillKorbe 1005 FolycomTest Faolycom Sou oint IP 550 Rebooted 2013-03-22 03:01 PM [PST) {

in
o

508-5068 Billkorbe 1010 Filot-Test-550 Pelycom SoundPeint IP 550 Reboot 2013-03-2203:02 PM {PST) C

356-1221 ¥ 00 Filet Lab  Bill K Ext 1053 Polycem VWi 500 Rebooted 2012-06-27 02:23 PM {FST) C

358-1270 VWX 500 FilotLeb  Bill K Ext 1054

2012-06-27 0 PM {PST)

Configure Line Keys
375-5405 VVX BDO Pilot Lab Bill K Ext 1055 Polyoy
131-8378 VX 400 Lab Ext 1057 Folyo 8x3 has a new Line Key feature to backup each phone’s local Contact Directory. Account
Manager can now allew centralized line key editing. In order to access the Line Configuration
131-8383 Bill Korbe WV Test 2010 Polyd page with the new features, users have to make one update to their local phone Contact
Directory on their &t to initiate that backup. Please click on the Confirm button if you have
3429981 VK 400 Lab 1088 Polyo already done so. Otherwise, please click on No button and try the centralized line key editing
St i = ~ | feature again later.
123-5078 BK Lsb 1080 Polyo
532-5383 BK Lab 1081 Polyo _ — =
244-1471 BK Lsb VWX 800 x1066 Pelycom VWX 800 2014-04-28 09:44 AM (PST) (
545-1290 BK Lab WK 800 x1087 Polycom WX 800 2014-04-28 10:19 AM (PST) L

Perform the back-up process on your device. For details, refer to Appendix B.

After completing the back-up on the phone, click Confirm to continue in Account Manager.

Branch Office - An Overview

The Line Key Configuration page shows the device key map with assigned keys and unused spare keys on your

phone.

HOME | PHOMNE SYSTEM | BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Line Key Configuration > Extension 1066 Enter keyword %
Line Key Configuration for Extension 1066 - BK Lab VVX 600 x1066 - Polycom VVX 600
PHONE SYSTEM
Plan : Virtual Receptionist 14 Deuble-click (or) Drag and drop
? Extensions. the Line Key types onto the
A e . unassigned keys to configure.
? Virtual and Toll-Free Line s
Numbers Appearance “ | | e
Line o a
? Ring Groups Ext. 1066 Appearance h
* Music on Hoid
# Available
» Gall Queues i (3]
? Paging —_—
» Gompany Satings Appgar:':nce &" ‘ BLF ﬁ
> Numbor Transfer ' : . - m
n Ext. 1066
» Gall Recording # availasle (B
» Edit Voicemail / Fax
Notifications
? Cordless Devices [r—
Line L Speed 7]
Appearance | N8 fil | | | Dial
Ext. 1066 # Available B
IE S
m
Sotup. Caas, idar

This key map corresponds to the keys on your phone.
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7. On the right side of the page, you have the following assignment key types:
= Line Appearance Key (LAK): to receive and handle multiple live calls.
m Busy Lamp Field Key (BLF): to track the status of other extension users on the same PBX.

m Speed Dial Key: to quickly dial out to most frequently used number.

Note: The number of LAK and BLF keys allowed for the extension depends on the Power Keys
planit is associated with.

8. Referto Appendix A for the table for details on the Power Keys Plan and corresponding LAKs and BLFs. There is
no limit on the number of speed dials.

9. Drag and drop a desired key type to an unused key in the map.

Line Key Configuration for Extension 1056 - VVX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 500

Plan : Virtual Receptionist 6 Double-click {or) Drag and drop
( 1 e
Line ] T 'y @
Appearance M Pickup Enabled L— ]‘E-T]'j Line i
Ext. 1056 Ext. 1067 Appearance “

BK Lab VWX & # available [E)
Line .
Appearance h: BLF = L
Ext. 1056
# availabie ()

ﬁpp:i:reance s ‘ e
Speed
# Available B Sf:. w o

Ext. 1058 # Available a

Note: Chrome does not support the drag-and-drop functionality. Click the key for the key type
options.

10. Add Line Appearance Key

Drag and drop Line Appearance Key on an unused key, or click on a key for the key type option.
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Account Manager co
Welcome, Bill Korbe VVX Test 2010 | Sign Out
Email: bkorbe@8x8.com Account|
Edit My Profile
| BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE
v Configuration > Extension 1056 Enter keyword

line Key Configuration for Extension 1056 - VVX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 5

App{
Ext. 10!

Appt
Ext. 10!

To select an extension, type the extension number, caller |0 or phone number and hit the search button. [
You can also use the dropdown to search for a specific number type from the directory. B '\f. L
|-
Quick Search @
Extensions el
o
|—

'] Double-click (or) Drag and d

pes onto the
| Select the extension to monitor with this key (%) to configurd

Add Busy Lamp Field Key

a. At the prompt, select an extension to monitor.

b. Enter a desired extension number, or caller ID, or phone number or click Search.

!

Account Manager

Welcome, Bill Korbe VWX Test 2010 | Sign Out
Email: bkorbe@8x8.com
Edit My Profile

BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFIC

Account]

E ONLINE

Configuration > Extension 1056

he Key Configuration for Extension 1056 - VVX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 5

Appt

Ext. 10

Appt

Ext. 10

To select an extension, type the extension number, caller 1D or phone number and hit the search button.
‘You can also use the dropdown to search for a specific number type from the directory.

Quick Search @
Extensions |
Actions  Ext Phone Number Caller ID First Name Caller ID Last Name
Select 1061  (408) 532.5363 BK Lab 1061
Select 1066 (559) 044-14T1 o BK Lab VX 600 %1066
Select 1067  (559) 945-1290+ BK Lab VVX 600 x1067
o W

'j Double-click (or) Drag and d

to th
Select the extension to monitor with this key @ etsoorn i

Enter keyword

g'\r‘
L .
| —
B

Branch Office - An Overview
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C. From the search result, select an extension.
d. Edit the label that shows on the phone.

€. Optionally, enable the user to answer calls for this monitored extension.

12. Add Speed Dial Key

a. Drag and drop the Speed Dial Key, or click on a key for key type option.
b. At the prompt, select an extension from the contact directory or enter a new number.

C. To add a new contact, add additional details as desired.

Select the number for this speed dial key Q

Enter extension, or type the phone number or caller ID and click Search.
Use the dropdown to search the directory for a specific number type.
(Search is optional, for Internal extensions only)

Quick Search @

Extensions - [Search

Contact Phone Number 14086750258

First Name John

Last Name Smith

Label John Smith (12 characters maximum)
Ring Type Default ~|

Auto Divert Disabled Ll

Divert Contact To

Auto Reject | Disabled |

Branch Office - An Overview

13. Click Save or continue to configure SideCars.

Version 1.0
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Configure SideCars

A SideCar is a phone accessory device that attaches to a business phone for additional line call handling and group
monitoring. Using the Polycom VVX Expansion Modules known as SideCars, a desktop phone can handle additional
Busy Lamp Field (BLF) keys, Line Appearance Keys (LAKs), and Speed Dial keys. With SideCars, you can accept,
screen, dispatch, and monitor calls and reduce the number of lost customer calls, shorten transaction times, and
increase the accuracy of call routing.

8x8 supports:

m 28-key color display SideCar: Shows a color display of assigned keys.
m 40-key paper label SideCar: Requires a paper label of assigned keys. For information on how to print a paper

label, refer to Generate Configured Line Key Information.

The supported SideCars are compatible with Polycom VVX 300/310, VVX 400/410, VVX 500, and VVX 600.
The SideCars can be configured to support additional pages of either 28 or 40 line keys. By obtaining a VR28 or a VR40
add-on plan, you can match the SideCar size and the number of SideCar keys that a customer requires:

m Each 28-key SideCar supports three logical pages of 28 line keys. Three physical SideCars can be cascaded
together for a maximum configuration of up to nine logical pages of 28 additional line keys.

m Each 40-key SideCar supports a single page of 40 line keys. Three physical SideCars can be cascaded together for
a maximum configuration of up to three logical pages of 40 additional line keys.
Configure Line Keys for a SideCar

1. Click Configure SideCar under the extension's Line Key Configuration.

Account Manager Company Name: polycombk
% Bxs, Inc. Welcome, Bill Korbe VWX Test 2010 | Sign Out
Email: bkorbe@8x8.com Account: Business |

Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Line Key Configuration > Extension 1056 Enter keyword m

Line Key Configuration for Extension 1056 - VWX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 500 @ Help

Double-click (or) Drag and drop

PHONE SYSTEM

» Extensions the Line Key types onto the
P
% Auto Attendant Une 3 BLF 1 ',J‘ unassigned keys to configure.
» Virtual and Toll-Free Appearance gy Pickup Enabled ] (i
Ui Ext. 1056 Ext. 1067 Line )
3 Ring Groups BK Lab VWX 6 Appearance | =
? Music on Hold # Avallable B
» Call Queues P,
> Paging A \ PP ﬁ- fid
% Oo y Sottings Appearance | = C Dial - .
» Number Transter Ext. 1056 (408) 6750258+ =7
> Cal Recording Jsmith # Avaitable €3
» Edit Voicomail / Fax
Notifications.
Line
* Cordless Devicos 4 5 Ed
Al I
ppearance z Dmial m (7]
Ext. 1056

# available ()

;nom
ystem
Setup 7 Configure SideCar
F L

BL
pickup Enabled [l i)
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2. At the prompt, update the number of SideCars attached to the phone.

Branch Office - An Overview

3. Depending on the SideCar model attached to the extension, the corresponding key map appears on the Line Key

Configuration screen.

Account Manager

‘Welcome, Bill Korbe VWX Test 2010 | Sign Qut
Email: bkorbe@8x8.com

Company Name: polycombk

88 8x8, Inc.

Account: Business

=

Line Key Configuration for Extension 1056 - VVX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 500 @ Help

PHONE SYSTEM

Double-click (or) Drag and drop
3 Extensions. Previous SideGar 1 0f 1 LW | the e Kgifvﬂﬂts Mh’n‘h’-
unassigne: eys to configure.
2 Auto Attendant Page 1 of 3 pages of keys = g 9
> Virtual and Toll-Free
Numbers Line i 7]
> Ring Groups Appearance | h
DR # Available €1
2 Gall Queues
2 Paging
» Company Settings BLF = L
3 Number Transfer =
> Call Recording # Available ED)
> Edit Voicemail / Fax
Netifications
> Speed &
Cordless Devices Bl ﬁ (7]

Edit My Profile
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | MYACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Phane System > Line Key Gonfiguration > Extension 1056 Enter keyword

m Foreach SideCar 28, three map pages of 28 keys.
m Foreach SideCar 40, single map page of 40 keys.

delete an existing key definition.
Follow the process to:
m Add Line Appearance Key
m Add Busy Lamp Field Key
m Add Speed Dial Key

Repeat the configuration for all pages of one or more SideCars.

only and not available on the phone.

Click Save to complete the configuration.

BLF key assignments are validated for any missing extension numbers.

It takes a few minutes for the phone and SideCars to restart.

Version 1.0

Drag and drop the desired key type to the key map or click on the key for the key type options. You can edit or

M p— Note: Within each page, drag and drop to reposition line keys. This flexibility is limited to SideCars

At the prompt, click Reboot Phone to push the initial line key configuration to the phone and SideCar.
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Add Call Pickup Option to a BLF Key
1. To configure Call Pickup, select the BLF key you want to enable call pickup for and click to Edit.

' (¢
" B @

Ext. 1055

BK Lab 1055

2. Select the Enable this user to pick up calls for this monitored extension check box, and select Ok.

Click on the lookup icon to select an extension.

Extension 1{
Label BK Lab 1055 (12 characters maximum)

@Enabfe this user to pick up calls for this monitored extension

[or] | Cancer

- — =

3. The key should now read Pickup Enabled.

— E?‘
[Pickup Enabled |ﬁ @

Ext. 1055
BK Lab 1055
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Change BLF Notification Option

If desired (for live receptionists), select the Enable call screen notification check box. You can also select the
Enable call audio tone check box.

Additional BLF Call Ringing Nofifications

Additional BLF Call Ringing Noftifications
In addition to the flashing red BLF phone ringing notification, you can optionaly enable additional BLF phone
ringing alerts. (These alerts will apply to all BLF keys for this extension)

In addition to the flashing red BLF phone ringing notification, you can optionaly enable additional BLF phone
DEnable call screen notification

ringing alerts. (These alerts will apply to all BLF keys for this extension)
Enable call audio tone

V| Enable call screen notification |v||Enable call audio tone

m Normal BLF screen notification (this is default for normal users).

‘_F' n 350PM .

Tuesday, November ¢
35m 330
Angela 'y Angela

330

Angela ¥

New Call Redial Forward Paging More

BLF Key flashes to alert you when a monitored set is ringing.

m Call Screen Notification (the splash screen option is recommended for live receptionists).

Incoming Call

To: 1007(BillKorbe 1007 Pol...

From: 1002(BillKorbe 1002 Pol...

FREEN  ignore

Silence  Dial

New Call

The full splash screen alerts you when a monitored extension is ringing

Version 1.0
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Edit Speed Dial Keys Using Phone Interface

End users can edit speed dials from the phone user interface using indexes for the key positions, and assign to Contact

Directory entries.

Identify Line Key Assignments

With your phone in front of you, you can identify which Line Appearance Keys, BLF contacts, and Speed Dials are
assigned to each line key on your SideCar from your VVX phone. It gives you the physical line key number.

To identify line key assignments:

1. Press to display the Home view.

2. Goto Settings > Status > Line Key Information.

3. Press a line key. The assignment and line number for the line key you pressed display on your phone screen.
4. Pressthe line key twice to return to the previous menu, or tap or select Back.

Generate Configured Line Key Information

......................................................................................................................................

......................................................................................................................................

Using the Polycom Web Configuration Utility, you can generate and download a PDF file with the configured line key
information for each 40-key SideCar. The generated PDF enables you to print line key information for line keys on your
SideCars, and insert the PDF as a directory card on your 40-key SideCar.

Generate Line Key Information PDF

1. In your Internet browser, enter your phone's IP address into the browser's address bar.

Version 1.0 124



Branch Office - An Overview
8x8

2. Login as a user with the default password 123, and select Submit.

Welcome to Polycom Web Configuration Utility

Enter Login Information

Login As Admin

Password see

3. Goto Utilities > EM Directory.

4. Select the expansion module you want to generate a PDF for.

Polycom | vvx 410

Home Simple Setup Preferences Settings Diagnostics Utilities

Home

Phone Information
Phone Model
Part Number
MAC Address
IP Address

UC Software Version 4

BootROM Software Version 5,

5. Inthe confirmation dialog, select Yes to download the PDF for the configured lines for your expansion module.

6. Goto Save > Open.
The configured line key information for your SideCar displays as a PDF file.

7. Download the PDF, print it, and insert it as the directory card template for the 40-key SideCar.

Download Extensions (CSV)

For your convenience, a Comma-Separated Values (CSV)file is available for download. This file provides information
on all extensions.
Access the CSV File
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1. Click Phone System in the top navigation bar.

2. OnView All Extensions, click View.

3. Click Download Extensions (csv).

Branch Office - An Overview

HOME I| PHONE SYSTEM || BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Manage Extensions

Manage Extensions
PHONE SYSTEM

¥ Auto Attendant

Enter keyword

@ Help

Below is an overview of all extensions. You may edit the extension details individually be dicking Edit next to each extension or as a group by dlicking on Edit Multiple
Extensions.

¥ Virtual and Toll-Free

Edit Multiple Extensions | Change Extension Number | Download Call Recordings ||Dcvwnluad Exte ns (csv)l\ Download Activation Codes

Humbers
> Ring Groups
¥ Music on Hold Edit | |[Replace Device Active Unlimited Extension Pro 1001 (650) 645-3018  Phillip Liu Aastra IP 6755i Deskphone  pliu@8x8 com
» Call Queues
% Shxsed Limes Edit | |Replace Device Active  Metered Extension 1002 (650) 6462988  Sukhanya Rajan Polycom SoundPoint IP 335 sukhanya rajan@Bxs com
» Swilchboard Edit | |Replace Device Active  Unlimited Extension Pro 1003 (650) 6462892  Sarah Thomas Polycom 1P 550 nalini_anantt
» Paging Edit | |Replace Device Active  Global Extension Pro 1004 (650) 646-3006  Phillip Liu Polycom SoundPoint IP 550  phillp.iu@exs.com
» Company Settings
T TR Edit | Active  Shared Extension 1005 (650) 646-3020  Sarah Thomas nalini.ananthamurthy@ax:
» Call Recording Edit | |[Replace Device Active Basic Extension 1006  (555)648-0703  Specialty Cookies Aastra IP 6755i Deskphone  drowel|@8x8 com
> Edit Voicemail / Fax
Hotifications Edit | Active  Uniimited Extension Pro 1007 (408) 627-8740  Jean Andj Virtual Office Softphone Jean andjz@axs.com
Edit | Active  Uniimited Extension Pro 1008 (408) 329-7176  Ramana Gottipati Virtual Office Sofiphone ramana gotlipati@axs cor
Edit | Active  Shared Extension 1010 (555)796-3628  Sharing FromAccountin sbeckmann@SpecialtyCo
Phone
System Edit | IReplace Device Active  Unlimited Extension Pro 1011 (408) 3297136 Beth Gamey Polycom VWX 1500 beth camey@8x3.com
Setuy
v Edit | Aclive  Unlimited Exdension Pro 1012 (408) 329-7137  Angela York Virtual Office Sofiphone angela york @88 com
Cot s L iolicoias F o Do anin panei o Teas B sl e Sonch il zh

A file named Extensions.csv is downloaded to you computer. The file can be opened in most spreadsheet

software, such as Microsoft Excel.

Y g C 3 3 T T G T T T o W ) ¥ ) 3
1 sums  SenieType  fn Name Cafler Hide i Auto Mhusic on Mol Désmiay No. for Ovtgaing Call Time Zone 911 Service Address

2 Actie  Usimited Extensor 1007 14086218140 Bon Nader 12123 mader @SpeciatyConkies.com v N v ¥ el US/Misuntai £10 W MAUDE AVE SUNNYVALE CAS8085-2910
3 lacwve  Rasc Enension 1008 15558430703 Soeciaky Gosties 9876 croweli@fescom ¥ N v ¥ el USfPacic  10W MAUDE AVE SUNNYVALE CA94085-2910
A Acthe  Unbmited Crienso 1001 16506461018 Loody Manager 9876 LobbyMsnsge@SpeciatyCockiescom ¥ N 1 ¥ el USfastern 10 W MAUDE AVE SUNNYVALE CA94085-2010
5 lacve  snareo tatension 1005 16506461020 Sharing, FromKitcnes 9876 sheckmann@SpecaryCookies.con N N v ¥ ol us/Pacnc

£ Acthe  Giobsl Erension 1004 18506461006 Swirieyn Becimanna 8876 shiederman@ucom ¥ N v ¥ el USfPacific K10 W MAUDE AVE SUNNYVALE CA94088.2610
T Acve  Umimied Exiensor 1003 16506462992 Maesh Swami 9471 sbiederman@udcom ¥ N v ¥ il US/Pacic 10 W MAUDE AVE SUNNYVALE CA9408S-2010
B At Meteredtatenson 1002 16506463588 Becky Carmichael 876 Becky Callen@SpeciahiyCoskicsom ¥ N v v el US/Paciic  E10W MAUDE AVE SUNNYVALE CAS4083-2810
S |Acte Vil Extension 3001 15556487180 Remote Nader 987 mader @5oeciatyCookies com ¥ N N ¥ ol UsiPag

10 |acte demited Dxtensor 1009 15557924996 Accountant e 987 a0 @speciatycooke.com ¥ N N ¥ el US/Lastern 10 W MAUDE AVE SUNNYVALL CA94085-2010
10 At Shares Btensien 1010 18557581628 Sharing Fremaccouting 987 sheckmasn@SpecultyCoskiescom W N ) ¥ il us/Pacne

The CSV file shows details for each extension.

Setup Shared Lines

The Shared Lines feature allows a maximum of eight users to share one extension number for outgoing calls. Shared

lines are optional, and must be ordered separately.

To set up shared lines:

1. Click Phone System in the top navigation bar.

2. Underthe Phone System menu, click Shared Lines.

Version 1.0

Note: All shared line extensions must use Aastra phones.
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3. Click Edit by the desired shared line.

Branch Office - An Overview

Account Manager

‘Welcome, Phillip Liu | Sign Out
Email: pliu@ax8.com
Edit My Profile

Company Name: Specialty Cookies

Account: Business

HOME * PHONE SYSTEM II BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

| Main Number: (510) 962-5321

v

Home > Fhone System > Shared Lines

PHONE SYSTEM

> Extensions

Shared Lines Assignment

Enter keyword

Shared Lines allow a maximum of eight extension users to share one extension number to receive incoming calls.

> Auto Altendant

2 Virtual and Tol-Free
Numbers

> Ring Groups
> Music en Hold
> Cal Queues

(650) 646-3020 1005

Specialty Cookies (555) 648-0703 Ext 1006

Line 4

Delete

Edit

Philip Liu (650) 646-3018 Ext 1001

Line 4

Delete

> Shared Lines

> Switchboard
> Paging

(555) 788-3628 1010

Philip Liu (650) 646-3018 Ext 1001

Line 3

Delete

Specialty Cookies (555) 648-0703 Ext 1006

Line 2

Delete

Edit

> Company Settings
> Number Transfer
> Call Recording

> Edit Voicemail / Fax
Notifications

© Help

In the Shared Line Assignments pane, click the drop-down arrow to select a Line Key Assignment for the

shared line extension.

Diana Jay Smith (555) 648-0703 Ext 1006

" LineKey

Assignment

Line Mumber 4

Lobby Manager (650) £46-3018 Ext 1001

Line Mumber 4

= Shared Line Assignments

Plezse assign a line key on the extension users phone to access the shared line.

Click Save Changes.

Set up Switchboard Pro

8x8 offers Switchboard Pro, a web-based application that gives a graphical overview of all incoming calls to help you

manage your phone system. Once you assign Switchboard Pro to a user profile, a receptionist or switchboard operator

can route callers to the desired destination right from the desktop.

Switchboard Pro is an optional feature that can be purchased separately.

Configure Switchboard Pro

To configure Switchboard Pro, you need to name your switchboard first, and then assign a user profile to it.

To configure a switchboard:
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Rl

5.

6.

Version 1.0

Click Phone System in the top navigation bar.
Under the Phone System menu, click Switchboard.
On Switchboard Users, click View.

Click under the Switchboard Name column.

HOME [ PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Fhone System > Switchboard

Switchboard Pro Qe
S .
» Auto Attendant. e
s | v
L ¥

Swichboard o Login
Name fieid and select the User Profle. from your browser. Select the links below to get
NOTE: started

[Swihboars Pro Login Page]

erian Tost SPECIALTYCOOKEES BOSULLIVAN (Swichbosrd Pro User Guideforbrowser
VS Test STIRUTHANIGEXS COM
> CorRecaraing Swichboard for Jarn SPECIALTYCOOKIES JORN
e Swihboard or Saah SPECIALTYCOOKIES STHOMAS
> Greup Cal Pk Swchboardvane SPEGIALTYGOOKIES
Swchboardvane SPECIALTYGOOKIES

SPECIALTYGOOKIES
SPECIALTYGOOKES

SPECIALTYCOOKES

SwichboardName SPECIALTYCOOKIES

Enter a name, and click Edit.

User Name License Assignment

First, add a name for your Switchboard, such a "Home Office” or "Sales Team”. Next, click on the User
Name field and select the User Profile.

MNOTE: Flease select a unigue user name for each Switchboard Pro license.

Brian Test SPECIALTYCOCKIES BOSULLIVAN

TVS Test STIRUTHANI@8X8.COM
Switchboard for John SPECIALTYCOOKIES.JOHN

Switchboard for Sarah

SwitchboardName

SwitchboardName |Main Office Switc hboard| ]
SwitchboardName
Edit | Cancel
SwitchboardName S s =
SwitthboardName SPECIALTYCOCKIES
Charite bk b oo, SDOOIAL TV OOIIT O -
»

Click under the User Name column.

Branch Office - An Overview
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7. Click Select by the desired user profile for the switchboard.

hacy Switchboard

itchboard Settings ‘Switchboard Software

| BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
board
Select User Profile 6
itchk
To search for a user profile, type the user profile information and click on the search button. You can also click
on the view all button to see all the user profiles.

Virtua
r orgar
tLiIQII1qaL|IE Actic Last N Fmail Addres: User N

Select  Saly Baker sbeckmann@SpecialtyCookies.com 1010.SPECIALTYCOOKIES -
m Select  Abbie Jackson sgarud@ax8.com AANNIE
rst adc Select Annie Thomas Adnnie@Specialtty Cookies.com ACCOUNTANNIE
pme fie
bTE: B Select  Alan Marac hino sgarud@8x8.com AMARACHING
— Select  Angela York angela.york@8x8.com ANGELAYORK
S Select  Angelique Y sgarud@ex8.com ANGELIQUEY
= Select Al Soto asoto@c hampionhomes.com ASOTO@CHAMPIONHOMES.C
o Select  alerie Fletcher valerie fletcher@Bx8.com BARSIMI

Select Becky Cullen sgarud@8x8.com BCULLEM
F Select  Brent Snyder sgarud@8x8.com BECKYC
F Select  Brylee Cullen sgarud@8x8.com BRYLEEC

Select  Shirley Beckmann sgarud@8x8.com BSHIRLEY
— Select  Chin Baker ChinBaker@yahoo.com CHINESEBAKER
[ Select  Darren Hakeman darren. hakeman@&x&.com DARREN HAKEMAM@EXE8.COM
— Selact  Denise IMartin denise.martin@8x8.com DENISE.MARTIN@SX8.COM 7

Switch)

nigue
d Pro il

o Log
a hostg]

allow |
Select

ogin P

ser Gui

astpra

Branch Office - An Overview

For information on how to launch and use Switchboard Pro, refer to the Switchboard Pro User Guide.

Set up Call Park Extensions

Call Park Extensions is an 8x8 phone system feature, and allows users to park and retrieve calls by pressing a Busy
Lamp Field (BLF) key on the phone.
For more information, refer to the Call Park Extensions User Guide.

Step 1: Add a Call Park Extension

In this step, add a call park extension for every single department you want to monitor. In other words, you add a label

for each department, and the system automatically assigns a call park extension number for each label you add.

To add a call park extension:
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1. Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Call Park Extensions.

Branch Office - An Overview

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

PHONE SYSTEM

» Extensions
> Auto Attendant

¥ Virtual and Tol-Free
Numbers

» Ring Groups

¥ Music on Hokt

¥ Call Queues

> Switchboard

> Paging

> Company Settings
¥ Number Transfer

Call Park Extensions

Call Park Extensions allow users to park and retrieve calls by pressing a key Busy Lamp Field (BLF) BLF key.

Home = Phone System > Call Park Extensions

To start using Park Extensions:

s Add a Park Extension
« Assign the Park Extension to a BLF Key on the phone

Enter the number of call park extensions you would like to add (4390) extensions left

First [4] 1-10 of 10 [¥] Last

Extensions Per Page All ¥

Requast | | Extension Action
¥ Call Recording
> Edit Voic email{ Fax 185000 [Paints Delste
Notifications
» Group Cal Pickup 185001 Construction Delste
| ’ E:(”e::\r:ns | 195002 Delivery Delete

@ Felp

3. Enter the number of call park extensions to create, and click Get.
The extensions are automatically added and listed in the Extension table.

Note: Call Park Extensions are added in order: 195000 through 199999. The existing call park
range 491, 492, 493, through 699 remains valid but no new extensions are created in that range.
Extensions 500, 551 through 559, are reserved for use with other services.

4. Edit the extension names under the Label column as needed.

Step 2: Assign the Park Extension to a BLF Key on the Phone

The next step is to assign call park extensions to BLF keys on phone sets. In the use case described here, you need to

configure three BLF keys on the phone used by front desk associate. For other departments, however, you add only one

BLF key, such as Paints for the Paints department, Lumber for Lumber, and so on.

To assign call park extensions to a BLF key:
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1. Click Phone System in the top navigation bar.

2. OnLine Key Configuration, click Configure.

Account Manager Gampany Name: polycombk
88 8x8,Inc. Welcome, Bill Korbe WX Test 2010 | Sign Out
Email: bkorbe@8x8.com Recount: Business d
Edit My Prefile
HOME | PHONE SYSTEM BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Pnene System > Extensions Enter kayword
Extensions @ rep

PHONE SYSTEM

: |
iy Quick Find / Edit Exténsion
::malm:‘:d?;‘l{ 2 Enter extension number, phone number or caller 1D.
res
Numbers
3 Ring Groups

M. Hokd View All Change Extension
> Call Queuss Extensions Extensions Humbers Recordings Configuration Opt
? Paging

e By Qe o

> Numbar Transfer

3 Call Recording .
View Edit Change Download Canfigure Corfigura
o I
INotifcations.

3 Cordoss Dovices

ghsm

ystem
Setup

Copyright 2011 B8, Inc.  www.BxB.c0m | Referali | Privacy | Terms & Gondaions | Centact Us | Feodoack Suppor: (888) $98-8733%

A list of extensions eligible for line key configuration shows.

3. From the list, select an extension, and click Configure Line Keys.

Ext  Phone Number Caller ID First Name Caller ID Last Name

1005 (555) 148-2556+ BillKorbe 1005 PolycomTest Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:01 PM (PST) Configure Line Keys
1010 (415) 508-5060+ BillKorbe 1010 Pilot-Test-550 Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:02 PM (PST) Configure Line Keys
1054 (557)358-1270+° VWX 500PilotLab  Bill K Ext 1054 Polycom VWX 500 Rebooted 2012-06-27 03:25 PM (PST) Configure Line Keys
1053 (557)356-1221+ VVXSO0PiotLab  Bill K Ext 1053 Polycom VWX 500 Rebooted 2012-06-27 03:23 PM (PST) Configure Line Keys
1056 (567)377-5541+ VVXS500Pilotlab  Bill K Ext 1056 Polycom VWX 500 Rebooted 2014-05-07 01:16 PM (PST) Configure Line Keys
1055 (s57) 375-5405+ VVX 500 PilotLab  Bill K Ext 1055 Polycom VWX 500 Rebooted 2014-01-10 04:58 PM (PST) Configure Line Keys
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You are prompted to back up the Contact Directory or speed dials on the phone.

BILLING

figuration

| REPORTING | ORDERS

Configuration

MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

he extensicns that are eligible for Line Key Configuration through the Account Manager.

8 BillKorbe 1005

olycomTe:

508-5063

BillKorbe 1010 Pilot-Test-550

2868-122

00 Filet Lab  Bill K Ext 1053

-27 02:23 PM {PST) Co

358-127

Bill K Ext 1054

Polhyoo

A7E-5405

tLab Bill K Ext 1055

Folyc

M {PST) Confi

-27 03.25

Configure Line Keys Q

131-8378 VWX 400 Lab Ext 1057 Polyo 8x3 has a new Line Key feature to backup each phone’s local Contact Directory. Account
Manager can now allew centralized line key editing. In order to access the Line Configuration

1218383 Bill Korke WV Test 2010 Folys | Page with the new features, users have to make one update to their local phone Contact
Directory on their &t to initiate that backup. Please click on the Confirm button if you have

213.3281 VX 400 Lab 1088 Fal already dun.e s0. Otherwise, please click on No button and try the centralized line key editing
feature again later.

1235078 BK Lab 1080 Polyo

532-5383 BK Lab 1081 Polyo m

544-1471 BK Lsb VK 800 x1066 Palycon Rebooted 2014-04-25 09:44 AM (FST) Configurs Ling Keys

545-1290 BK Lab WK 800 x1087 Pohycom VWX 800 Rebooted 2014-04-28 10:19 AM (PST) {Configure Line Keys

Perform the backup process on your device. For details, refer to backup process below.
Back up Contact Directory from Your Phone Device

Branch Office - An Overview

Backing up the Contact Directory on the phone device is essential before editing any keys on Account Manager for

the first time. It is done automatically once the backup server launches.

Configuring line keys in Account Manager allows central editing after the local directory is saved once to prevent

accidental loss of locally-saved contact data on the phone. You can add a dummy new entry on the phone and

save it for a quick backup.

To back up Contact Directory from your phone device:

A P

ress

to display the Home view on the phone.

B. From the menu, go to Directories > Contact Directory.

C. Select a contact to edit, or use

to create a new contact.
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D. To edit a contact:

Branch Office - An Overview

a. Select a contact, and press Edit. Scroll down the list of options, and press Favorite Index if you wish to

put the contact on Speed Dial.

b. Assign an index according to where you want the contact to display on phone or SideCar.

E. Save the contact, and back up the Contact Directory.

5. After completing the backup on the phone, click Confirm to continue in Account Manager.

6. The Line Key Configuration screen shows the device key map with assigned keys and unused spare keys on

Version 1.0

your phone.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS

| MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Line Key Configuration > Extension 1066

Line Key Configuration for Extension 1066 - BK Lab VVX 600 x1066 - Polycom VVX 600

Plan : Virtual Receptionist 14

PHONE SYSTEM

Enter keyword

Double-click (or) Drag and drop

? Extensions
2 Auto Attendant

> Virtual and Toll-Free
Numbers.

» Ring Groups

¥ Music on Hold

? Call Queues

? Paging

> Company Settings
> Number Transfer
> Call Recording

> Edit Voicemail / Fax
Notifications

> Cordless Devices

Line 1
Appearance | s

Ext. 1066

Line 1
Appearance é a

Ext. 1066

Line 1
Appearance | N ff)

Ext. 1066

the Line Key types onto the

unassigned keys to configure.
Line 1 7]
Appearance &
# available [ED
BLF = L
=
# Available ()
Speed L
ol
# Available B
idar.

[ Zoucin |

This key map corresponds to the keys on your phone.

Drag and drop (or double-click) the BLF key to an unused key in the map.
You can also edit an existing line key.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Line Key Configuration > Extension 1066

Line Key Configuration for Extension 1066 - BK Lab VVX 600 x1066 - Polycom VVX 600

Enter keyword

PPHONE SYSTEM
Plan : Virtual Receptionist 14

> Extensions ¢
2 Auto Attendant
» Virtual and Tol-Free Line 1

Numbers Appearance : E
» Ring Groups Ext. 1066
> Music on Hold
? Call Queues
> Paging

Line
» Company Setiings .
Appearance

> Number Transter —t
> Gall Recording Bd. 1008
» Edit Volcemail / Fax

Notifications.

? Cordless Devices

_EE\ S
1
i

Line 1
Appearance |28 T}

Ext. 1066

Double-click (or) Drag and drop
~ the Line Key types onto the
unassigned keys to configure,

Line
Appearance ;’ 3
# Available [E)
BLF = L
—
# Available )
Speed -
= Ke
# Available (B

[ Zearc |

The extension selection prompt appears.
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Plan : Power Keys 6

Line Key Configuration for Extension 1055 - VVX 500 Pilot Lab Bill K Ext 1055 - Polycom VVX 500

Select the extension to monitor with this key

¢ | Quick Search 7]

Extensions

-

Line " ~ BLF ] F:.)
Appearance | - Pickup Enabled B___J [‘E
Ext. 1055 Ext. 1067
BK Lab 1067
Line . BLF ] r:-’

rd
Speed - -
T
1010
1010 BillKo
rd
Speed

configure.

Line

To select an extension, type the extension number, caller ID or phone number and hitthe search button. -
You can also use the dropdown to search for a specific number type fram the directory.

Appearance = o
2 available B3
BLF L0
-
zilable (B3
Speed - =
S @

nore Speed Dial Keys

© Help

Double-click the Line Key types to

able

Ext 100 | |Extensions
BL Lab Group Call Pickup

Call Park Extensions gure SideCar

=  EEEEEE——E— - -
BLF 4 Speed = [E Speed =, @
— Dial ﬁ Dial

Ext 1010 1047 2222
BK Lab 1010 8K ATA Fanstel BK CQ 2222

Notes:

key type options.

Power Keys plan it is associated with.

-The Chrome browser does not support the drag-and-drop functionality. Double-click the key for theé

-The number of Line Appearance Keys and BLF keys allowed for the extension depends on the

8. Select Call Park Extensions from the menu.
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9. Enter the call park extension label you created earlier, and click Search.
r'4 i L g
e C oo T O Speed d & o < b
@l  Select the extension to monitor with this key (%} 2vailzble £
105
Enterthe Call Park Extension label. You can find the list of Call Park Extension labels, or create e
a new one from Call Park Extensions. You can also use the dropdown to search for a specific Spf_»ed 5 @
number type from the directory. Dial
g Quick Search @ o more Speed Dial Keys
railabl
00 Call Park Extensions ¥ Paints Search Reset -
ab Actions Ext Call Park Extension Name : .
mfigure SideCar
* Selact 491 Paints
E
1
0
ab
You can also create a label by clicking Call Park Extensions.
10. Click Ok.

The assigned BLF key appears.

For the front desk associate's phone, repeat the above procedure for Lumber and Lighting as well.

Plan : Power Keys 6

Line Key Configuration for Extension 1056 - VVX 500 Pilot Lab Bill K Ext 1056 - Polycom VVX 500

-

Line

[
Appearance n

Ext. 1086

Line

[
Appearance “

Ext. 1056

Line

. Appearance “ @

Ext. 1056

Ext. 1066
BK Lab 10466

BLF
Pickup Enabled ﬁ

Ext 1067
BK Lab VWX &

e —

BLF
Pickup Enabled ﬁ

Ext 491
Paints

BLF
Pickup Enabled ﬁ

Ext. 492
Lighting

BLF
Pickup Enabled ﬁ

Ext. 493
Lumber

il

~

Double-click the Line Key types to
configure.

Line

i
Appearance n (7]

2 Available B

BLF ﬁ (7]

# Available

Speed
Dial

(Sl

£ Available n

Configure SideCar

© Help

For phones used in every other department, you need to create only one BLF key. The following example shows

Version 1.0
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How Can | Monitor Calls Using a Call Park Extension?

Monitoring calls via call park extension is performed via desk phone.

To monitor calls using a call park extension:

Version 1.0

the configuration for the Paints department phone.

Branch Office - An Overview

' BLF 9 ]
Pickup Enabled || fi

Ext. 10656

Plan : Power Keys 6
Line i
Appearance n
Ext. 1055
Line i
Appearance “
Ext. 1055
BLF 4 “
Ext. 1002
BL Lab 1002
BLF 4 4
Ext. 1010
BK Lab 1010

BK Lab 1066
BLF 9 4
Pickup Enabled || ) @
Ext. 1067
BK Lab 1067
BLF L) @
Pickup Enabled || o) @
Ext. 481
Paints ‘
'

s
i

2N

DN

BN

Line Key Configuration for Extension 1055 - VVX 500 Pilot Lab Bill K Ext 1055 - Polycom VVX 500 @ Help

Double-click the Line Key types to
configure.

Line

L
Appearance “ o
# Available @3
BLF L@
# Available
Speed
Dial

No more Speed Dial Keys
available

Configure SideCar
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1. Receive an inbound call using the phone for front desk associate.

2. If the call is for Lighting, press the BLF key for the Lighting department.

Monday, October 1!
&y, 1066 BK : £ Lighting | | & BKDesk
PR—; e

e‘*b 1066 BK | P Lumber | ®

ﬁb 1066 BK . | o Barge

oy 1066BK & jo5 & EnterCall

New C.al.l“ 548 MRediaI” Forward Paging

The call is parked to be retrieved by associates in Lighting.

3. Use an intercom call or paging to announce the waiting call.
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4. An associate in the Lighting department retrieves the call by pressing the BLF key.

Polycom

1058 BK " Labx1024 §
, 1058 BK Lab x1025 &
Lab x1055 » Lab x1026 &
Lab x1010 Lab 1066 £
 Lab x1002° ] ATA x1047 £

), Lighting il Lead 0 2.
New Caii Redial Forward & . More
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Notes:

Branch Office - An Overview

-To hear the phone ring, select the Enable call audio tone check box when assigning the BLF key§

in Account Manager.

PHONE SYSTEM

» Extenslons
> Auto Atendant

> Virtual and Toll-Free
Numbers

2 Ring Groups

3 Music on Hold

3 Paging

> Company Settings

3 Number Transfer
Request

? CallRet

2 Group Call Fickup
¥ Call Fark Extensions

Copyright 2015 8x8, Inc.

W,

Plan : Power Keys 4

> .
BLF s W5 BLF y B L%
= 0 Pickup Enavied [F | il
Ext 1002 Ext 491
BL Lab 1002 shoes ‘
c4 = s
BLF . & Speed T
| == ) Dial ’
Ext 1010 ma
BK Lab 1010

Double-click the Line Key types to
configure.

Line e
Appearance |8

= Available |1
Double-tlick to assign BLF.

BLF Vi@
-

= availzble [

Speed
Dial ﬁ o

= Available [

Additional BLF Call Ringing Notifications

In addition to the flashing red BLF phone ringing notification, you can optionally enable ional BLF phong
ringing alerts. (These alerts will apply to all BLF keys for this extension) :

« Enable call screen notification | Enable call audio tone

Last rebooted on 2015-10-15 01:37 PM (PST)

-If the call is not answered within five minutes, the call will be diverted back to the front desk
associate. If the front desk associate is not available, the call goes to the front desk answering

machine.

Set up Group Call Pickup

8x8 Group Call Pickup is a simple device-based feature that allows an extension user to answer an incoming call for a
teammate in their absence from their desk phone. Group Call Pickup involves creating a Pickup Group with extension
users. All members of this group are permitted to pick up incoming calls for other group members in their absence.

For details, refer to the Group Call Pickup User Guide.
Step 1: Create a List of Desired Extension Users

The list determines the group members who are permitted to pick up calls for others.

To create a list of desired extension users:

1.

Click Phone System in the top navigation bar.

2. Under the Phone System menu, click Group Call Pickup.
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3. Click Create Group Call Pickup.

Account Manager Company Name: Specialty Cookies | Main Number: (510) 962-5321
% 8x8,Inc. Wwelcome, Sarah Thomas | Sian Out
Email: pliu@8x8.com Account: Business v

Edit My Profile

HOME \lPHONE 5Y5TEM|\ BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Group Call Pickups

Group Call Pickups @ Help
PHONE SYSTEM
R Group Call Pickup allows users to answer calls that come in on a number other than their own. The call can be answered by dialing *66+Group Call Pickup Extension
number.
» Auto Attendant

> Virtual and Toll-Free »
Numbers

> Ring Groups

> Music on Hold

> Call Queues

> Shared Lines

> Branches

» Switchboard

» Paging

> Company Settings

> Number Transfer
Request

> Call Retording

> Edit \bicemail | Fax
Notific at

Call Park Extensions.

4. Click Manage List(s).

Create Group Call Pickup @ Help
Please enter your new Group Call Pickup information below.

Create, View, Edit, Delete, Listi:

Group Call Pickup Details

Group Call Pickup Name

Group Call Pickup Extension spp3 = Suggest

Members of Group Call Pickup

Create a new group by picking a list

Use the &5 and & buttons to Add/Delste an existing list to this Group Call Pickup

‘Group Call Pickup List Add/ Delete
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Click Create New List.

Branch Office - An Overview

Home > Phone System > Lists

List
PHONE SYSTEM

> Auto Attendant

> \irtual and Tol-Free Create New List | Return to Previous Page

Numbers

> Ring Groups | 'search || Reset |
> Music on Hold —

» Call Queves No Lists Available

¥ Shared Lines

¥ Branches

¥ Switc hboard

» Extensions Create lists of extensions addressable by another extensions for use with services such as Group Call Pickup.

[Enter keyword

o

Enter a name for the list.

Select the extensions you would like to add to the list.

Create New List @

Use lists with services such as Group Call Pickup..

1. Name your List
ICust{:mer Support I
2. Search for extensions or lists.

First [4] 1-51 0f51 [] Last

Phone number

[ 1001 Unlimited Extensicn Phillip Liu (650) 645-3018
| 1002 Metered Extension Sukhanya Rajan (650) 645-2588
L 1003 Unlimited Extensicn John Smith (650) 646-2542
| 1004 Global Extension Sarah Thomas (650) 645-3008
J 1006 Basic Extensicon Spetialty Cockiss (555) 648-0703
[ 1007 Unlimited Extensicn Jean Andje (408) 627-8740
I 1009 Unlimited Extension Ramana Gottipati (408) 3287178
|## 1012 Unlimited Extensicn Angela York (408) 328-T137
J 1013 Unlimited Extension Julia Zhu (408) 2287144
(] 1014 Unlimited Extensicn Rika Tandean (408) 328-T148

-
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Notes:
-Being a group member denotes permission to answer someone else's phone.

-An extension can belong to multiple groups.

8. Click Save.
A new list appears on the List page.

List

Create lists of extensions addressable by another extensions for use with services such as Group Call Pickup.

Create New List § Return to Previous Page

First [4] 1-1 of 1 [¥] Last

Customer Support List View/Edit | Copy | Delete ‘

Step 2: Create a Pickup Group by Assigning One or More Lists

To create a pickup group:

1. Click Return to Previous Page if you are still on the List page.

OR
Go to the Phone System page, and click Group Call Pickup under the Phone System menu.

2. Click Create Group Call Pickup.
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3. Enter a name for the new call pickup group.
A Group Call Pickup Extension (such as 5000) is automatically assigned to your group.

Create Group Call Pickup @ Help
Flease enter your new Group Call Pickup information below.

Manage List(s)
Create, View, Edit, Delete, Listis): JUELELCANEES]

Group Call Pickup Details

Group Call Pickup Name Customer Support Group

Group Call Pickup Extension |spog| L] Suggest

Members of Group Call Pickup

Create a new group by picking a list

Use the & and @ buttons to Add/Delete an existing list to this Group Call Pickup

Group Call Pickup List Add/ Delete

I Customer Support List v <o

[Sove Cance' |

4. Select and add the extension list you just created.

Note: If you have created the extension lists before, you can view and add them here.

5. Click Save.

6. Under the Phone System menu, click Group Call Pickup to see the new group.

Group Call Pickups @ Help
PHONE SYSTEM

3 Exiensions. Group Call Pickup allows users to answer calls that come in on 3 number other than their own. The call can be answered by dialing *66+Group Call Pickup Extension number.

>
Auto Attendant Create Group Call Pickup | Delete All Group Call Pickups
3 Virtual and Tol-Free

e Group Call Pickups Group Extension Group Members Action

> Ring Groups Customer Support Group 5000 Customer Support Lst | Edit | Delste
> Music on Hold
> Call Queves
> Shared Lines
3 Branches

> Switchboard
> Paging

> Company Settings

3 Number Transfer
Request

3 Call Recording

> Edit Voicemail / Fax
MNotific ations

I 3 Group Call Pickup I

When a pickup group is created, the users get an email notification regarding the group, the group extension
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number, and how to use the extension number.

% 8x8, Inc.

Subject: You have been added to Group Call Pickup

Dear <User Name>

The Group Call Pickup extension number is : 5000
To pick up a phone call for your group, dial *66 + Group Call Pickup Extension.
You can also add: *66 + Group Call Pickup Extension to your phone as a speed dial either directly on the phone (for

more info see: link) or in account manager (for more info see: link)

Sincerely,
Customer Support

Step 3: (Optional) Define BLF and Speed Dial Keys for Group Call Pickup Number

BLF is an add-on feature that is bundled with the 8x8 Power Keys functionality. You need to subscribe to 8x8 Power
Keys to perform the following procedure:

To define BLF keys Group Call Pickup number:
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1. Click Phone System in the top navigation bar.

2. OnLine Key Configuration, click Configure.

Account Manager Gampany Name: polycombk
88 8x8,Inc. Welcome, Bill Korbe WX Test 2010 | Sign Out
Email: bkorbe@8x8.com Recount: Business d
Edit My Prefile
HOME | PHONE SYSTEM BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Pnene System > Extensions Enter kayword
Extensions @ rep

PHONE SYSTEM

: |
iy Quick Find / Edit Exténsion
::malm:‘:d?;‘l{ 2 Enter extension number, phone number or caller 1D.
res
Numbers
3 Ring Groups

M. Hokd View All Change Extension
> Call Queuss Extensions Extensions Humbers Recordings Configuration Opt
? Paging

e By Qe o

> Numbar Transfer

3 Call Recording .
View Edit Change Download Canfigure Corfigura
o I
INotifcations.

3 Cordoss Dovices

ghsm

ystem
Setup

Copyright 2011 B8, Inc.  www.BxB.c0m | Referali | Privacy | Terms & Gondaions | Centact Us | Feodoack Suppor: (888) $98-8733%

A list of extensions eligible for line key configuration shows.

3. From the list, select an extension, and click Configure Line Keys.

Ext  Phone Number Caller ID First Name Caller ID Last Name

1005 (555) 148-2556+ BillKorbe 1005 PolycomTest Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:01 PM (PST) Configure Line Keys
1010 (415) 508-5060+ BillKorbe 1010 Pilot-Test-550 Polycom SoundPoint IP 550 Rebooted 2013-03-22 03:02 PM (PST) Configure Line Keys
1054 (557)358-1270+° VWX 500PilotLab  Bill K Ext 1054 Polycom VWX 500 Rebooted 2012-06-27 03:25 PM (PST) Configure Line Keys
1053 (557)356-1221+ VVXSO0PiotLab  Bill K Ext 1053 Polycom VWX 500 Rebooted 2012-06-27 03:23 PM (PST) Configure Line Keys
1056 (567)377-5541+ VVXS500Pilotlab  Bill K Ext 1056 Polycom VWX 500 Rebooted 2014-05-07 01:16 PM (PST) Configure Line Keys
1055 (s57) 375-5405+ VVX 500 PilotLab  Bill K Ext 1055 Polycom VWX 500 Rebooted 2014-01-10 04:58 PM (PST) Configure Line Keys
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You are prompted to back up the Contact Directory or speed dials on the phone.

BILLING

figuration

| REPORTING | ORDERS

Configuration

MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

he extensicns that are eligible for Line Key Configuration through the Account Manager.

8 BillKorbe 1005

olycomTe:

508-5063

BillKorbe 1010 Pilot-Test-550

2868-122

00 Filet Lab  Bill K Ext 1053

-27 02:23 PM {PST) Co

358-127

Bill K Ext 1054

Polhyoo

A7E-5405

tLab Bill K Ext 1055

Folyc

M {PST) Confi

-27 03.25

Configure Line Keys Q

131-8378 VWX 400 Lab Ext 1057 Polyo 8x3 has a new Line Key feature to backup each phone’s local Contact Directory. Account
Manager can now allew centralized line key editing. In order to access the Line Configuration

1218383 Bill Korke WV Test 2010 Folys | Page with the new features, users have to make one update to their local phone Contact
Directory on their &t to initiate that backup. Please click on the Confirm button if you have

213.3281 VX 400 Lab 1088 Fal already dun.e s0. Otherwise, please click on No button and try the centralized line key editing
feature again later.

1235078 BK Lab 1080 Polyo

532-5383 BK Lab 1081 Polyo m

544-1471 BK Lsb VK 800 x1066 Palycon Rebooted 2014-04-25 09:44 AM (FST) Configurs Ling Keys

545-1290 BK Lab WK 800 x1087 Pohycom VWX 800 Rebooted 2014-04-28 10:19 AM (PST) {Configure Line Keys

Perform the backup process on your device. For details, refer to backup process below.
Back up Contact Directory from Your Phone Device

Branch Office - An Overview

Backing up the Contact Directory on the phone device is essential before editing any keys on Account Manager for

the first time. It is done automatically once the backup server launches.

Configuring line keys in Account Manager allows central editing after the local directory is saved once to prevent

accidental loss of locally-saved contact data on the phone. You can add a dummy new entry on the phone and

save it for a quick backup.

To back up Contact Directory from your phone device:

A P

ress

to display the Home view on the phone.

B. From the menu, go to Directories > Contact Directory.

C. Select a contact to edit, or use

to create a new contact.
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D. To edit a contact:

a. Select a contact, and press Edit. Scroll down the list of options, and press Favorite Index if you wish to
put the contact on Speed Dial.

b. Assign an index according to where you want the contact to display on phone or SideCar.
E. Save the contact, and back up the Contact Directory.
5. After completing the backup on the phone, click Confirm to continue in Account Manager.

6. The Line Key Configuration screen shows the device key map with assigned keys and unused spare keys on
your phone.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Phone System > Line Key Configuration > Extension 1066 Enter keyword [ Zearch |

Line Key Configuration for Extension 1066 - BK Lab VVX 600 x1066 - Polycom VVX 600
PHONE SYSTEM

Plan : Virtual Receptionist 14 Deuble-click (or) Drag and drop
¥ Extensions ( > the Line Key types onto the
ki figure.
> Auto Attendant unassigned keys to configure.
» Virtual and Toll-Free Line Q
Appearance 2
, Numbers ppear; o e ‘ 5
Ring Groups A
L4 anco :ota Ext. 1086 ppearance | gy
usic on
# Available
? Gall Queues wail a
> Paging -
- ne
> L
Company Seftings Appearance | = ot e
> Number Transfer — =
> Cal Record £/1088
al ing # Available I}
> Edit Voicomall / Fax
Notifications
? Cordless Devices
Line % Speed = 7]
Appearance |8 il Dial ﬁ

Ext. 1066 # Available (B
Phona
System
Setup 2 g

This key map corresponds to the keys on your phone.

7. On the side of the page, the following assignment key types are listed:
m Busy Lamp Field (BLF) Key: Use to track the status of other extension users on the same PBX.

m Speed Dial Key: Use to quickly dial out to most frequently-used number.

Note: The number of BLF keys allowed for the extension depends on the Power Keys plan it is
associated with. :

8. Referto Appendix A for the table for details on the Power Keys Plan and corresponding BLFs. There is no limit on
the number of speed dials.
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9. Drag and drop a desired key type to an unused key in the map.

Note: Chrome does not support the drag-and-drop functionality. Click the key for the key type
options.

10. Add a BLF Key

a. Drag and drop a BLF key on an unused key, or click on a key for the key type option.

b. Atthe prompt, select Group Call Pickup under Quick Search.

Line Key Configuration for Extension 10005 - Divina V - Polycom SoundPoint IP 550 @ Help

Plan : Power Keys 4 Double-click the Line Key types to

configure.

Available B

To select an extension, type the extension number, caller ID or phone number and hit the search button. )
You can also use the dropdown to search for a specific number type from the directory. BLF i 0
Quick Search @ Lailable

i (1]

Ext 1C Extensions

' Group Call Pickup

Additional BLF Call Ringing Notifications

[Searcn [ Reset IS

Speed —
= e

more Speed Dial Keys
ilable

In addition to the flashing red BLF phone ringing notification, you can optionally enable additional BLF phone
ringing alerts. (These alerts will apply to all BLF keys for this extension) :

#| Enable call screen notification |#/ Enable call audio tone

Scheduled to reboot on 2015-09-28 05:00 PM (PST) m m

c. Click Search.
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Find the Group Call Pickup extension you just created from the list, and click Select.

Line Key Configuration for Extension 10005 - Divina V - Polycom SoundPoint IP 550 @ Help
Plan : Power Keys 4 Double-click (or) Drag and drop
the Line Key types onto the
unassigned keys to configure.
il Select the extension to monitor with this key (%]
Appea Line 1 )
Ext. 1000 | To select an extension, type the extension number, caller ID or phone number and hit the search button. ~ PPEarance .
You can also use the dropdown to search for a specific number type from the directory. Railable E
Quick Search @ -
Lir ; BLF 4
Appes | Group Call Pickup = o
Ext. 1000 Actions  Ext Phone Number Caller ID First Name Caller ID Last Name wvailable
Select | 5003 Speed
= = ke
Select 5004 nore Speed Dial Keys
able
Additional B
In addition tc
alerts. (Thes
ENBDIE Caner e rncs e sncamamrns oy sammsras. srmsn mamamnne marsnnn
Scheduled to reboot on 2015-09-28 05:00 PM (PST) Cancel

The Edit BLF Extension window opens.
Enter the Group Call Pickup extension.
Edit the label that shows on the phone.

Optionally, allow the user to answer calls for this monitored extension.

Line Key Configuration for Extension 10005 - Divina V - Polycom SoundPoint IP 550 (7]
Plan : Power Keys 4 Double-click the Line Key type
configure.
Line % BLF { ~ Line ¢ )
Appearance | Edit ELF‘Extension Appearance |
Ext. 10005 2 available [E3)
Click on the lookup icon to select an extension.
BLF L0
- Extension Q, —
AppleJanreance ‘\f’ Label (9 characters maximum) 2 Available (ED)
Ext 10005 |« Enable this user to pick up calls for this monitored extension Sgie;elcl H 0

Mo more Speed Dial Keys

available
Additional BLF Call Ringing Notifications

In addition to the flashing red BLF phone ringing notification, you can optionally enable additional BLF phone
ringing alerts. (These alerts will apply to all BLF keys for this extension) :

#| Enable call screen notification |« Enable call audio tone

Last rebooted on 2015-09-25 02:18 PM (PST) m m
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11. Add a Speed Dial Key
a. Drag and drop the Speed Dial Key, or click on a key for key type option.
b. At the prompt, select Group Call Pickup under Quick Search.

Click Search.

a o

Select the Group Call Pickup extension from the list.

Select the number for this speed dial key 5

Enter extension, or type the phone number or caller ID and click Search.
Use the dropdown to search the directory for a specific number type.
{Search is optional, for Internal extensions only) . I

Group Call Pickup | Reset |

Actions Ext Phone Number Caller ID First Name Caller ID Last Name

| select | 5000

Select 5004

Contact Phone Number
First Name

Last Name

Label (8 characiers maximum)
Ring Type Default
Auto Divert Disabled
Divert Contact To

Auto Reject Disabled

(< [<]

K

€. To add a new contact, add additional details as desired.

12. Click Save.

Set up Hot Desk

With the 8x8 Hot Desk feature, employees log into a shared phone that immediately behaves like their own extension.
They can make and receive calls, and check their messages. 8x8 Hot Desk extensions help employees have a more
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personalized, secure, and convenient phone experience, whether traveling to other offices or working a shift at a shared
desk. For more details on this feature, refer to the Hot Desk User Guide. You can configure the caller ID and
emergency service address for this extension in Account Manager. Work with your 8x8 sales agent to place an order for
Hot Desk hot lines. Once the order is processed, the Hot Desk phone extension numbers in Account Manager are listed
under Phone System > Extensions.

To configure a Hot Desk extension:
1. Click Phone System in the top navigation bar.
2. OnView All Extensions, click View.

3. Find the Hot Desk extension number, and click Edit.

Manage Extensions @ Hel
EHONESTSIE Below is an overview of all extensions. You may edit the extension details individually be clicking Edit next to each extension or as a group by clicking on Edit
Multiple Extensions.
> Extensions
> Auto Attendant Edit Multiple Extensions | Change Extension Number | Download Call Recordings | Download Extensions (csv) | Download Activation Codes
> Virtual and Tol-Free P Statu — B 7
Numbers
> Ring Groups
> Music on Hold Edit |Replace Device Actve  Unimitd Extension 1055 (556)313-3281 /X 40DLab 1058 Polycom /X 400 bkorbe@BxE.com
> Call Queuss
s Edit |Replace Device Actve  Unlimited Extension Pro 1080 (408} 123-9076  BK Lab 1080 Polycom /X 310 brorbe@8xE.com
S Edit |Replace Device Actve  Unlimited Extension Pro 1051 (408 532-5383  BK Lab 1061 Polycom /X 300 bkorbe@BxB.com
> Company Settings Edit |Replace Device Active  Unlimited Extension Pro 1066 (558) 844-1471  BKLab /X 600 x106€_Polycom VA/% 600 bkorbe@8xE.com
>
;:::‘Tm"m' Edit [Replace Device Actve  Unlimited Extension Pro 1087  (559) 945-1290  Billkorbe 1002 PolycomTest 1 Polycom VX 600 bhorbe@8xE.com
> Call Recording Edit |Activate Device] Pending  Unlmited Extension 1068 (558 4455325  Unassioned  Unassigned  Polycom /X 400 bkorbe@BxE.com
te Ed;;"”:er“ﬂ" s Edit [Activate Device| Pending  Unlimited Extension 1089 (558)446-3476  Mardi Jackson Polycom /X 800 mardj@yahco.com
otfic ations
% Cordiess Devices Edit |Activate Device| Pending  Unlmited Extension 1070 (210)500-0633  Mardi Jackson Polycom /X 300 mardi@yahco.com
Edit |Replace Device Actve  Unimitd Extension 1071 (210} 500-0634  Mardi Jackson Polycom /X 400 mardj@yahco.com
Edit |Replace Device Active  Unlimited Extension 1072 (210)500-0835  Agent Barge Polycom /% 300 brorbe@8xE.com
Edit |Replace Device Actve  Unimited Extension Pro 1073 (408) 550-4550  Darryl Addington _ Polycom SoundPoint [P 335 darryl addington @8x8.cor
Edit |Replace Device Active  Unlimited Extension Pro 1074 (408) 550-4851  Darryl Addington Polyeom ScundPeint [P 335 darryladdington@8x&.cor
Edit |Replace Device Active  Unlimited Extension Pro 1075 (408) 550-4852  Darryl addington Polycom SoundPoint [P 335 darryl addington@8x8.cor
|E;1n |Replace Device Active  HotDesk Extension 1076  (210) 550-3866  Host Hot Desk I Polycom SoundPoint IP 550 mardi jackson@8x8.com
Edit [Replace Device Actve  HotDesk Extension 1077 (210) S50-3670 HolDesk  Demo Polycom SoundPoint P 550 bhorbe@B8x@.com
Edit |Activate Device] Pending  Unlmited Extension Pro 1098 (557) 327-4841  PlotLab 560 BilKorbe  Polycom Soundpoint IP 560 bkorbe@8xB.com =
4

4. Enter or update the caller ID first name and last name.

5. Verify the emergency address.
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6. Click Edit next to Emergency Service Address to change the address.

% 8x8, Inc.

HOME |

PHONE SYSTEM |

Account Manager

Company Name: polycombk

Welcome, Nalini Ananthamurthy | Sign Cut
Email: nalini.ananthamurthy@8x8.com
Edit My Profile

BILLING | REPORTING | ORDERS |

ACCOUNTS |

SUPPORT

Account: Business v

VIRTUAL OFFICE ONLINE

PHONE SYSTEM

» Extensions
¥ suto Attendant

¥ \iirtual and Toll-Free
Mumbers

> Ring Groups

> Music on Hokd

> Call Queues

¥ Switchboard

¥ Paging

> Company Settings

> Number Transfer
Request

» Call Recording

> Edit \Voicemail / Fax
Notific ations

» Cordless Devices

Phons
System
Setup

Home > Phone System > Manage Extensions > Edit Extension

Edit Extension

B Extension Information

External Caller ID:

First Name Hot Desk (7]
Last Name Demo 7]
Phone Number  (210) 550-3870
Extension 1077
Plan Hot Desk Extension
Equipment

Polycom SoundPoint IP 550 l

B Extension Settings

Time Zone
Preferred Codec

USiPacific v
G.729A (30 kbps) v | @

Emergency Service 2125 ONEL DR, SAN JOSE, CA 95131-2032
Address

¥ | Edit

Save Changes

Enter keyword

@ Help

Version 1.0
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7. Click Save Changes.
The extension appears as a Hot Desk extension on the phone (in this case, 1077 Hot).

% POLYCOM

= 1077 Hot

Thursday, June 18
10 41/M
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Disaster Recovery Companion Service

8x8 Disaster Recovery Companion Service provides continuity if the data center hosting your primary 8x8 Virtual
Contact Center suffers a disaster or site failure.

8x8 Virtual Contact Center Disaster Recovery Companion Tenant is a scheduled replica of your primary Virtual Contact
Center tenant in the standby mode. This instance of your Virtual Contact Center tenant is hosted in a geographically
diverse data center. It enables continuity for the contact center telephony traffic in the event of a site failure or natural
disaster where your Virtual Contact Center cannot be accessed.

On-demand administration is available using the 8x8 Account Manager application, whether you just want more
flexibility in everyday call routing, or plan for business continuity. You can divert your contact center inbound telephony
traffic to your companion tenant or alternate phone numbers.

Features
= Ability to maintain business telephony continuity
m Provides geographically-diverse data center for the Companion tenant
= Ability to define and validate rerouting plans in advance
= Ability to quickly switch and self-manage routing plans
= Ability to archive routing plans

m Ability to access and restore a historical version of a routing plan

Rerouting Options

The following built-in rerouting options in Virtual Contact Center help you maintain business continuity:

m Disaster Recovery (DR) Tenant: Subscribe to Disaster Recovery Companion Service, which provides access to
a secondary tenant.

L 8 _: Note: The Companion Disaster Recovery Tenant is an add-on service that can be purchased
separately. It requires prior configuration.
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m Forward Calls: Route your contact center inbound calls to an alternate phone number such as a phone queue or
workplace.

Rerouting Plans

Virtual Contact Center facilitates channel or agent rerouting using routing plans. A routing plan determines how your
contact center traffic is channeled. During normal operation, you can route traffic to the primary tenant. During a
disaster, you can redirect the traffic to a DR tenant or forward them to another phone number. By default, all routing
plans are set to direct inbound traffic to the primary tenant.

Virtual Contact Center allows you to define:
= Normal Routing Plan: Determine call routing during normal business operation.
m Disaster Routing Plan: Determine call routing during a disaster event.

= Alternate Routing Plan: Allows to test the set up in Voice Services Channel Rerouting, validate selected routing
options, and copy the validated plan to the Normal or Disaster routing plan.

Plan for a Disaster Recovery Event

An exclusive test phone number is provided with every DR tenant. At a minimum, you should use this test number as
well as other designated channel numbers monthly. 8x8 strongly recommends, and most industry guidelines require,
conducting a full DR failover test at least once a year.

As contact center managers , you must set up a disaster event contingency plan for the contact center, test the plan
ahead of time so you can activate it instantly when you need it. The plan should identify the VCC channel numbers to
be rerouted to the companion tenant or to the alternate phone numbers, as needed. With the plan in place and with a
few clicks in 8x8 Account Manager, your contact center traffic is automatically rerouted without the need to contact 8x8
Support.

Version 1.0 155



8x8

Set up Voice Channel Rerouting

Set up Voice Channel Rerouting

Before you activate a routing plan, we recommend testing out the plan. You can use the alternate routing plan to test if

a routing plan works as intended without disturbing the settings in the other two plans. With a routing plan, you can be

assured your disaster recovery plan is ready for activation when you need it.

The following features give you the ability to reroute the inbound traffic to your contact center:

m Voice Services Channel Rerouting: Allows you to divert the contact center's inbound telephony traffic to the

companion tenant or alternate phone numbers. This feature is available to both VO-VCC and Virtual Contact

Center users with dedicated public numbers.

m VCC Agent Login and Direct Dial Rerouting: Allows you to divert calls for agents with private channel

numbers to the companion tenant or an alternate phone number in case of emergency. During a disaster event, the

agents log in to their application URL like before, but the system diverts them to the disaster recovery site as

configured by the Account Manager administrator prior to the disaster. This feature is only available to VO-VCC

users.

We recommend the following workflow for setting up Channel and VCC Agent Login and Direct Dial Rerouting:

Step 1: Create an Alternate Routing Plan

1. Login to Account Manager by going to http://login.8x8.com from your preferred browser.

2. Click Contact Center in the top navigation bar.

£, Order Status. | View All

C0O1000004902 - Pending ACD Request

(((.n) 8x8 Network Alerts | Support

Al systems and networks are currently functioning at 100%

Account Manager | Phone System Name:
88 8x8,Inc. Welcome, Sarah Thomas | Sign Out Account: Busiess |
Email: sthomas@8x8.com
Edi e Phone System Name: | qatestrranei |
HOME | PHONE SYSTEM CONTACT CENTER BILLING | REPORTING | ORDERS | MY ACCOUNT | SUPPORT | VIRTUAL OFFICE ONLINE
Enter keyword
CallLog Summary Phone System Sefup
Select Time Frame =] Lo i Setup Features
Payment Amount: $0.00 View User Profiies =
Next Payment Due: 07-02-2013 View Privileges Corporata Directory
Rupali Rane
View Call Logs View Statements nstallation Appointment(s) .1 (556) 061-6445 (B2 10013 et
Update Billing Profile Downioad Activation Codes — i
Account Updates
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3. From the Contact Center menu, select one of the following:

m Voice Services Channel Rerouting: View and set up the Virtual Contact Center channel routing plans.

Set up Voice Channel Rerouting

Account Manager
8x8: "

Company Name:

07/10/2017 06:21 PM Alternate Routing Plan Kourosh Dowlatshahi
L L L - Route Al Channels - ¢ | - 10/16/2017 10:10 PM Disaster Routing Plan Kourosh Dowlatshahi
Switch To DR

Email: sthomas@8x8.co Account: | Business D
Edit My Profle
HOME | PHONESYSTEM | CONTACTCENTER | BILLING | REPORTING | ORDERS | | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Contact Center > VCC Disaster Recovery Channel Rerouting Entarhopword
Virtual Contact Center - Voice Services Channel Rerouting @ Help
CONTACT CENTER
View Primary Tenant Sito | View Disaster Tenant Site
> Contact Center
Galing Plans st @ 1-10 of 312 ] Last Channels Per Page | 10 &
e S
Channel Rerouting Select previous version v Select previous version
Rastons 11/07/2017 06:11 PM Alternate Routing Plan Kourosh Dowlatshahi
Direct Dial
Reroutng ol

Samanha (8592020048 [ Primary Tenant B DO 10/16/2017 10:07 PM Disaster Routing Plan Kourosh Dowlatshahi  Tenant &
Samantha  (925)266:5819 | Primary Tenant i O 09/26/2017 06:20 PM Disaster Routing Plan Kourosh Dowlatshahi [Tenant ¢
Jones, 9/26 DR Service channels
Samantha (925)266-5620 | Primary Tenant + B 07/10/2017 06:21 PM Disaster Routing Plan Kourosh Dowlatshahi  Tenant ¢
Tones, 07/10/2017 06:21 PM Normal Routing Plan Kourosh Dowlatshahi
Samantha  (925)266:5821 [ Primary Tenant B Disastet TRy TR | Ursgmtr revery Tenant §
saes . (@s)265822 | Primary Tenant D Disaster Recovery Tenant & Disaster Recovery Tenant §
samaha (292665623 | Primary Tenant : Disaster Recovery Tenant + Disaster Recovery Tenant §
Simantha  (925)266:5624 | Primary Tenant 5 Disaster Recovery Tenant & Disaster Recovery Tenant ¢
P (925)266-5625 | Primary Tenant ‘ Disaster Recovery Tenant ¢ Disaster Recovery Tenant
Samamha  (925)2665626 | Primary Tenant B Disaster Recovery Tenant & Forward Calls 4 aomsssirz
Smimba (625)266:5827 | Primary Tenant 5 Disaster Recovery Tenant + Forward Cals 4 [atesssiziz

Savo Changos

Copyright 2017 848, Inc. T

Cobrowse Holp

m VCC Agent Login and Direct Dial Rerouting: View and set up agent login and routing plans.

Account Manager

HOME | PHONE SYSTEM | CONTACT CENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Company Name: " Inc

8x8: P ————
Email: sthomas@818.com @ | Account: Busiess

Home > Contact Center > Agent Login & Direct-in-Dial Rerouting

Virtual Contact Center - Agent Login & Direct-in-Dial Rerouting * * *
CONTACT CENTER

Enter keyword

@ el

> Contact Canter ‘Agent Login & Ditect-in-Dial Rerouting
Calling Plans.

SV

Select previous version e- Seloctprevious version

- Route All Channes - :_ - Route All Channels -

RACEQRIE  Koly Grace 6004 Prmry Tonant : Disastor Rocovery Tenant & Prmary Tonant :
SaMgRKE e goor Primary Tenant B Disaster Recovery Tenant ¢ Primary Tenant B
DowNogRKE (Do, sooa Prmry Tonant : Disastor Rocovery Tenant & Prmary Tonant :
ROBGRIE  Townsend Rob 1002 TownsondRob 2255 | prmary Tonant : Disastor Rocovry Tenant & Prmary Tonant :
NAGRE  GarnorAa 1018 Prmry Tonant : Disastor Recovry Tenant & Prmary Tonant :
P R T T — : Disastor Recovery Tenant & Fomard Cals ¢ stosssizie
Koutosiar VORAGUL 101 Prmry Tonant : Disastor Recovry Tenant & Primary Tonant :

Save Changes

Gobrowse Holp

The following table shows the fields and options available in Virtual Contact Center:

Field Description

User ID

The agent user ID that is used to log in to Agent Console.

Last, First The last and first name used for the account.

Version 1.0
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Field Description

Ext The dedicated or virtual extension number assigned to the agent.

Calling Name Name displayed on PSTN calls, which contains the first 15 characters from the agent's first and
‘last name.

Channel Name The name of the channel that you are planning to reroute.

Channel The telephone number of the channel that receives the incoming calls.
Number

VCC Channels All Virtual Contact Center channels are listed. You can select all channels or only the ones you
' like to reroute.

Route all If selected, the system reroutes all Virtual Contact Center channels.
Channels

Primary Tenant Forwards all traffic to the channels that come to the primary tenant.

Forward Calls Forwards inbound traffic to a specified phone number.

Normal Routing Indicates the plan for call routing during normal business operation.
Plan :

Alternate Allows you to test the set up channel rerouting, validate routing options, and copy the validated
Routing Plan  : plan to the normal or disaster plan.

Disaster Indicates the plan for call routing during a disaster.
Routing Plan

4. Select a channel and specify a routing option under Alternate Routing Plan from the available choices:

Version 1.0

m Primary Tenant: forwards all traffic to the channels in the primary tenant.

m Disaster Recovery Tenant: forwards all traffic to the dedicated DR tenant.

|

Note: DR Tenant is limited to tenants with the 8x8 Disaster Recovery Service.

m Forward Calls: forwards inbound traffic to a specified phone number. Enter a valid phone number.
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5. Alternately, you can route all channels to the same destination by selecting an option from the Route All

Channels drop-down menu.

Set up Voice Channel Rerouting

Virtual Contact Center Channel Rerouting

VCC Channels

Search by Name or

Number I | Search

Channel Name

Channel Number

(101) 131-6248

(101) 131-6249

Normal Routing Plan
Select previous version

ute All Channels
- Route All Channels -
Primary Tenant

Disaster Recovery Tenant
Forward Calls

(BE6) 950-6806

Primary Tenant |

Step 2: Activate the Alternate Routing Plan

Click Save Changes. You are prompted to save with comments.

Enter a brief note to indicate the changes you made.

Saving takes a snapshot of the settings in the Alternate Routing Plan column.

Changes to your routing plan take effect upon activating the plan. To activate a routing plan, click Select under a plan.

The call redirection takes effect immediately. The ability to automatically store and retrieve previous versions of plans
provides the flexibility to revert to a previous plan any time.

Version 1.0
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1. Click Select to activate the alternate routing plan.

Alternate Routing Plan

Disaster Recovery Tenant ~|

Disaster Recovery Tenant |

Disaster Recovery Tenant ~|

Disaster Recovery Tenant ~|

2. Test if the calls are routed as intended.
3. When the selected plan operates successfully, you are now ready to copy the plan to the Normal Routing Plan
or the Disaster Routing Plan.
Step 3: Copy the Tested Plan

1. From the drop-down menu under Disaster Routing Plan or Normal Routing Plan, select the Alternate Routing
Plan you just validated.
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Account Manager
8x8 w e | 2370
esvs.com

Ema se
Edit My Profie

HOME | PHONE SYSTEM | CONTACTCENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Company Name:  Inc

Account: | Business

Home > Contact Center > VCC Disaster Recovery Channel Rerouting

CONTACT CENTER

View Primary Tenant Site | View Disastor Tenant Site
> Contact Centor i !
c:

First [4] 1-10 of 311 [3] Last

Virtual Contact Center - Voice Services Channel Rerouting

Enter keyword

@ Heip

VEC Channels

‘Search by Name o Number [N | Soarch

Select previous version

‘ Channels per Page | 10 %

v Select previous version
11/07/2017 06:11 PM Alternate Routing Plan Kourosh Dowlatshahi

07/10/2017 06:21 PM Alternate Routing Plan Kourosh Dowlatshahi
- 10/16/2017 10:10 PM Disaster Routing Plan Kourosh Dowlatshahi

JJJJJ Switch To DR
Samantha (855)202:0048 | Primary Tenant B 10/16/2017 10:07 PM Disaster Routing Plan Kourosh Dowlatshahi  Tenant ¢
“ones, Normal Normal
Samanha  (925)266:5818 | Primary Tenant B 09/26/2017 06:20 PM Disaster Routing Plan Kourosh Dowlatshahi  Tenant
9/26 DR Service channels
(925)266-5620 | Primary Tenant O 07/10/2017 06:21 PM Disaster Routing Plan Kourosh Dowlatshahi  Tenant &
07/10/2017 06:21 PM Normal Routing Plan Kourosh Dowlatshahi

(625)266:5821 | Primary Tenant Disaser newuvery ronain v rsaser newovery Tenant §
(e25)266:5822 | Primary Tenant Disaster Recovery Tenant $ Disaster Recovery Tenant ¢
(625)266:5823 | Primary Tenant Disaster Recovery Tenant $ Disaster Recovery Tenant ¢
(e25)266:5824 | Primary Tenant Disaster Recovery Tenant $ Disaster Recovery Tenant §
(625)266:5825 | Primary Tenant Disaster Recovery Tenant 4 Disaster Recovery Tenant 4
(625)266:5826 | Primary Tenant Disaster Recovery Tenant $ Forward Calls 4 aossssirz
(625) 266-5827 | Primary Tenant Disaster Recovery Tenant ¢ Forward Calls 4] [atssssrre

Savo Changes

(Copyright 2017 848, Inc. _www8x8.com | Referrals | Pivacy | Terms & Condions | ContactUs | Support| Feedback

Cobrowse Holp

2. Referto the comments to make sure you are copying the right version.

3. The copy action highlights the channels with changed settings.

Note: You can access up to five previously-saved versions of a routing plan. You have the
flexibility to revert to these plans, should the need arise.

Note: When you save changes to a routing plan, a snapshot of the plan is saved as a new version for

to the plan.

that plan. You can access up to five previously-saved versions for each plan. Saving changes across allé
three plans provides a separate version for each plan. Each of these versions reflects a snapshot of the
plan itself. This way, you can copy the settings from a column by selecting the desired version specific

Configure Email and Chat Channels During a Disaster

Virtual Contact Center Disaster Recovery Companion Service is intended to provide on-demand administration to

manually re-direct your contact center voice traffic to your companion tenant or other phone numbers. If you are utilizing

Version 1.0
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Set up Voice Channel Rerouting

the Virtual Contact Center email and chat media channels, the following steps are required by your system

administrators.

m Email Channel: As part of tenant synchronization process email channels can be synchronized to the companion

tenant. The email channel on DR tenant needs to be activated to retrieve emails from the email server. Same mail

server credentials as the primary tenant are put in place. Just enable the channel.

Email channel on primary tenant needs to be stopped from retrieving emails, assuming the tenant is still

accessible. Otherwise, in DR emergency where the primary tenant is not accessible, no action is required.

POC@ corp.com

« Back to channel list
Properties
Configuration

Channel type

* Channel Name

Channels » Email » Properties

Email

POC Test

* Incoming Email Address

* User ID

* Password

POC@ sorp.com

POC@ corp.com

* Uses Existing User Profile
credentials from Primary Email
tenant Channel

* Retype Password

* Incoming Mail Server
Protocol

* Email Script

Test

Outlock.office365.com

POP3 over SSL

POC Test

* Po

Check this field to Enable Email

it |995
[ This channel is enabled « Channel on DR Tenant

Once done entering the connection parameters to the mail server in the form below, you should test the connection with the mail server by clicking on the ‘Test' button below.

Test Save Cancel

m Chat channel: The Code snippet generated by the primary tenant which is being used on your web page offering

Version 1.0

chat service needs to be updated with snippet generated from the Companion (DR) tenant.
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2 Kourosh Dowlatshahi (deinc01) My Profie | Cobrowsing | Help | Logous

Home p
Scripts » Chat » Code o

Security
Groups
Users
Queues Chat Channel Sales

n
o <« Back to scrpt st
Seripts
CcRM | Properties | | Saript Code
Support Canter Code snippet
Outbound Setup
— Please, copy and paste this code exactly on the pk toinsert the chat your wabsite: (remember to select the right channel before genarafing the code snippet). Refer that, for sach channel selected, a new cade will generats.
Brosdcast * Channel KD Ghat Test |
Integration
Status Codes - lacs tis coda sigpet ampihersyou want 11 Buon o Soeat i your 2age. 10 bulin has bien confgured n the Ghat s, wll it shon s 1 ks any ssace. >

i 94395131°></cl

sl nmvlurew(h the button layaut, you just need ta include it in the same page. It must also be within the <body> section of the page, preferably just before the ending tag. --

cs:rpl e

Script_14988055675a0390746/4203.94 395131,
SJMDE",

D Chat Test’,
hipsf/vec-nal2. 8x8.com”,

94395131",

align: *right
13

(funetiont) {
var se = document.createEloment(*scriat');
so.type = “textfavasecript;
seagyne = ue;
+_exbChat gath + “/CHAT/

var o5 = document.getElementsByTagName("script"}(0];
o pareniNoda nseSaforsse, o

<ttt

Genarata Cods «

Note: You cannot predict when or where disaster will strike. You must manually redirect your voice
traffic to your 8x8 DR tenant as your service does not automatically failover. I
If you use 8x8 carrier services, quickly redirect your inbound voice traffic by using the Channel
Rerouting tool in the 8x8 online Account Manager.

If you do not use 8x8 as your carrier, we work with you during your DR planning to identify the steps
your carrier requires for manually redirecting your calls.

Configure Bria Softphone for Disaster Recovery

If your agents use Bria softphone, you must create and enable two Bria accounts (one for each proxy address): the
primary tenant proxy address and DR companion tenant proxy address. Select Auto Select from the drop-down.
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[ X I ] Bria 4 - kourosh

. Available =

Auto Select -
I..-I"“!::I *j D E——————— -

Enter name or number

COUNTERPATH

Add your primary and disaster recovery accounts in Bria and enable them.
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8x8

o000 Preferences
on Accounts A s D Ce Call Dir
| J L ]
Enabled Status Account Name Protocol  User ID Call
] @ EU3-Eurcpe sIP kourosh «
D @ MAC Address Book MADR  MAC Address Book X
& @  US1 - Primary SIP Kourosh o7
| () US2-DR Tenant siP Kourash @
+ = Preferred account for calls m

The following example displays the details of sip account settings. The proxy address for the primary tenant is vce-sip-
us1.8x8.com and the proxy address for the DR tenant is vce-sip-us2.8x8.com.
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Sip Account - Ready

Account name: US1 - Primary

Use for: [#] call
|:| IM/Presence

General Woicemail Topeology Transpeort Advanced

User Details

* User ID Kourosh

* Domain  8xB.com

Password

Display name

Authorization name
Domain Proxy
[#] Register with domain and receive calls

Send outbound via:

© Domain @ Proxy Address vcc-sip-usl.8x8.com |

Dial plan ' #1\a\a.T;match="1;prestrip=2;

I - | -

For more details on how to configure Bria, refer to Bria for Windows and Bria for MAC guides.

Version 1.0
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Manage Billing

Access to 8x8 service bills online through Account Manager saves your time to get on the phone for billing-related
queries. You can view current and past billing statements, set up a billing profile for automatic payment, and download
a summary of all accounts. Additionally, if you are an enterprise user, you can set your billing preferences to receive
single or multiple bills, and manage billing accounts through cost centers.

For details on billing for different types of users, refer to:
m  Small and Medium Business (SMB) Users

m Enterprise Users

SMB Users

If you are a Small and Medium Business (SMB) user, you can set your billing profile for consolidated or unconsolidated
billing, add a new credit account to your profile, and view statements. See the following sections for more information:

m Statements

m Billing Profile

Statements

Using Account Manager, you can view your statements for the last 18 months.
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1. Click Billing in the top navigation bar.
2. OnView Statements, click View. There are two versions of the page:

m SMB users see the following version of the Billing page.

Edit My Profile

HOME | PHONE SYSTEMIl BILLING \IREPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Account Mal‘lager Company Name: Specialty Cookizs | Main Number: (510) 962-5321
88 Bx8, Inc. Welcome, Fhillip Liu | Sign Out
Email: pliu@8x8.com Account: Business v

Home > Billing Enter keyword

Billing - Consolidated
BILLING

—
L Currency [ US Dallar
) m—
~ | “Vigw activity since your last payment
@ Next payment will be processed 03-02-2017
[ Update |

? Statements.
> Billing Profile Update Payment / View Statements Download
Billing Info All Accounts Activity Since Last Payment

@ Help

Manage Billing

m Enterprise users see the following version of the Billing page including Billing Preferences and Cost Centers.

HOME | PHONE SYSTEM || BILLING || REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

e

Home > Billing

Billing - Consolidated
BILLING

? Statements
* Billing Profile Update Payment / View Statements Download Billing
Billing Info All Accounts P Cost Centers

? Biling Preferences

3 Cost Canters — E 5 (25 24
= B = [ 1]
Update [ View | | View | | View |

Activity Since Last Payment
Currency (5 US Dollar v]

“iew activity since your last payment.
Mext payment will be processed 03-02-2017

@ Help

3. Select the Currency from the drop-down list under Activity Since Last Payment. Your selection determines the

type of currency for your statement.

Dollar, Australian Dollar, and Euro.

Note: You can select from the following currencies: British Pound Sterling, Canadian Dollar, US

4. Click View under Actions of the statement you want to see. You can view bills one by one, or view several bills at

once:

Version 1.0
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m The following is a statement for a single bill.

Home > Billing > Statements

BILLING

Billing Profiie

chat setting

o Important Message

avoid any potential service disruption JIEETXET

'We have been unable to successfully process your payment. The past due amount is§301.39. Please pay your bill by using the "Pay Now” button below to

Statements

Below are your statements for the past 18 months.
View Payment History

Statement Date

Consolidated

03-01-2015 §301.39 Past Due

@ Help

Activity Since Last Payment
Actions

Currency
“iew activity since your last

payment.
MNext payment will be processed 03-02-2017

m The following is a statement for multiple bills.

HOME

88 8x8, Inc.

Account Manager

Company Name: gatestnishant

Welcome, Nishant Jha | Sign Out
Email: nishant.jha @8x8.com
Edit My Profile

| PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS |

Account: | Business v

SUPPORT | VIRTUAL OFFICE ONLINE

BILLING

? Statements

Home > Billing > Statements

Statements

Below are your statements for the past 18 months.
View Payment History

Enter keyw

@ Help

> Biling Profie
» Biling Preferences
» Cost Centers s D skl o onsolidated o Activity Since Last Payment
[oa-01-2015 $316.60 g‘uf; ves Cost Center Next Payment
Expandto
show other cost -- Corporate Cost Center 10-02-2015 View
Cemeé;{é’ File miami 10-02:2015 View
new york 10-02-2018 View
Cost Center Status Consolidated Actions --
Bosot-2015 s21660 Past oy
" : Due
Il miami 512664 Peal Ves View
L new york 518996 ;fe' Yes Introducing A New Statement Format!

Manage Billing
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5. A detailed billing summary displays. Below is an example of an enterprise consolidated statement with cost
centers in Austin, Chicago, and Los Angeles in US dollars.

Version 1.0

Monthly Statement

Statement Date: 08-01-2015 qanash Billing Address
Account ID: RWO0108019 c/o Jha Nishant 2128 Omel Dr
cAUsAB5I1

Summary Payment Information

Due Date 08-02-2015| Date Bilea: NiA

Previous Belance' $0.00 Payment Type: ACH Billing

Monthly Charges. S 47488

Adjustments 5000

Payments since lst bil 0,00 Bank Routing Number: nul

Total Due $ 474.89 Bank Account Number. null

Payment Status ACH Bank Name: Not Available

Cost Center Summary

Cost Center Description Net Amount
Corporate 59498
CT-0001460 1o angeles. $75.98
CT-0001451 chicago 57598
CT-0001462 austin 5227584
Total Amount $4T4E8

Existing Services (Monthly Billing) From 07-01-2015 To 07-31-2015

Quantty UnitPrice | Service Charges | Usage Charges  Total

Usage Summary
In-Network Minutes Used In-Plan Minutes Used International Minutes Usad
o o o

Statement Details - Services

‘Service |V Start Date Service Plans. Telephone S/Ext.

New Services (18) From 07-01-2015 To 07-21-2015
= 0|06 Branch Office

h Offc
i Days Billed: 10
PAROGO0GSENT n Office
Days Bilea: 10
P80000000156808 Erarch Ofica
ooz — Days Billed: 15
Cost Center: austin I
PEAGI0a SETaT Virtual Office Unimted
o215 ile
Virual Office Uniimied
Billed
Virtual Office Uniimited
Billed: 10
Vinual Office Uniimaed
Billed: 10
Vireal Office Uniimied
1]
Vinual Office Uniimied 1408520
Days Biled 10 Ext 1012
Virtual Office Unimited -408-550-5835
Days Bies: 1% £x| 1013
eancoseno;seres Vinual Office Uniimied
Days Billed: 10 114
PaBoo0000156750 Nirtual Office Uniimited 14052508237
ooz — Days Biles' 16 Ext 1015
austin Sub Total
Cost Center: chifago
Pen000000156778 Virual Office Unimied i
et Days Billed: 19 Ext 1004
1408-550-5827
Ext. 1005
1408 550 5628
1. 1008
ehicago Sub Total
Ext. 1001
4
Ext. 1002
1
Ext 1
s angeles Sub Total
Total

3 s40.98 59458 5000 59458

50.00

$94.98 $000 $9498

3 $38.89 5000 57558

$0.00]

§75.98 $0.00_$ 75.98]

3 530.99 57558 5000 57558

$0.00

$ 75.98 $0.00 $75.98]

) $30.88 §227.84 5000 $227.84

$0.00/

5227.94 $0.00 §227.94

$ 47489

From 07-01-2015 To 07-31-2015

Amount

ES11 Service Fee (US only) 5000

Regulatory Recovery Fee® s000

State 811 Fee s000

Universal Senvice Surcharge 5000

Total 5000

Usage Summ.

In-Network Minutes Used International Minutes Used

International Usage
Country Usageimnates) Usage Charge

Mo temationsl usage.

Adjustments

Adiustment ID Azcount Reference
Ho adjustments appied.

Description Requested Gate  Process Date  Amount

[Dispiay Usage | [ Dowrioad Usage (511 | | 50| [ Downlosd

Additional Information:

T Previous 30 equpTEN purchased
mw-Mmuummmmmt MWWMMMM

2 Monkhiy Service Charges appy 1o the period DE-01-2015 To DE-31-2015

in prévious month. If you Rave ordered new Service 300
3t the time of 52k,

* Usage Charges apsly to the period 07-01-2015 To 07-31-2015

£Taxes & Faes - Taxes & Fass s based on Sarvios Aogress. Inoisies govemmen fass

13 140 12 e agsrgae gavermarial snity (oching. b
5 Tots nd co33 Fcurred by 38 3 resuR of provideg 34

iy te ot we mcur. TheYS Iovh, 30

and s that ve cobect o s oyttt ste o ccal

not imited to. sales, use. excise, public uiiily. i £ty Tl secton may ais
23 universal service fees (USF) Ve sect 1o colect them i
M-MWIHMIM may vary by cale 3nd may chasge from time 10 T wethout not
‘Mlml’bowwho waconmwm-ymm
inclucing, but not kméed to, 911, locai nu

12 rsoeersome ofthe corts we ocur 1 conely wh cal state s federal govermans
‘and programs, number portabity and number posling. We-
iy of B8 of thes e AnEalAS 20 rogras 2k SVBLIS 13 You 1 Yo BN

T et e e s et vemetts of
* This Mont's Total - Inciudes activty 35 charges for the time indicated. Doss not include paymeats for pror balances

7 Prome Diseount - Limited tfim promotional offer.

Billview s cisplayed @ 06-04-2015 03:17:48 PM (US Pacdic Time)
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6. To view billing details for a particular extension in Billing > Statements, click View next to the corresponding

extension.
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home = Billing > Statements m
Statements © Help
BILLING
Below are your statements for the past 18 months.
¥ Statements
View Payment History
> Billing Profile
> Biling
Currency (3 US Dolar v
04-01-2018 $8,863.38 Past Due es View
view activity since your last payment
D Next payment will be processed 03-02-2017
03-01-2016 $8,863.38 Past Dus es view
02-01-2016 $8,863.38 Past Due Yes View

7. To see account activity since your last payment in Billing > Statements, click View Activity. A detailed billing

summary opens.
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Billing > Statements | Search |
Statements @ el
BILLING
Eelow are your statements for the past 18 months.
¥ Statements . ;
View Payment History
¥ Billing Profile
> Billng Pr —
—— Statement Date Amount Sttus | Consolidated  Actions
Currency [§ US Dollar v
04-01-2016 58,863.38 Past Due es View
visw activty fsince your last payment.
5 payment will be processed 03-02-2017
03-01-2016 58,863.38 Past Due es View ’
02-01-2016 58,863.39 Past Due “es View

Billing Profile

This feature allows you to select whether you receive a consolidated or unconsolidated bill for your telephone
extensions and allows updates to your payment details.
8x8 offers two types of billing to meet your needs:
= Unconsolidated Billing: If you have chosen unconsolidated billing, you receive multiple bills per billing cycle, one
for each of your 8x8 services. The selected credit card is charged for each service independently.
m Consolidated Billing: If you have chosen consolidated billing, you get one monthly bill for all your 8x8 services,

and your credit card is charged once for the entire amount owed 8x8.

Billing Profile can be accessed by both SMB and Enterprise users:
m SMB users: If you are an SMB user, you can select unconsolidated or consolidated billing and switch between the
two billing types as desired.
= Enterprise users: If you are an enterprise user, moving from unconsolidated billing to consolidated billing cannot

be reversed. Please note that you must select consolidated billing to create cost centers.
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Change Billing Type

In Billing Profile, SMB users can change their billing type from unconsolidated to consolidated. Enterprise users,

however, can add or edit their payment options in Billing Profile. They can select their billing type by navigating to
Billing Preferences. For details, refer to Billing Preferences.

1. Click Billing in the top navigation bar.
2. Under the Billing menu, click Billing Profile.
3. Click Change to Consolidated.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Heme > Billing > Billing Profile

BILLING

¥ Statements
? Billing Profile
> Assign Payment

Billing Profile - Unconsolidated

Billing Pref e - UnConsolid

ed (Individual or grouped costs are billed to multiple payment sources)
Account Status
First[{] 1-4 of 4 [}] Last

@ Hep

Change To Consolidated Billing

Extensions Per Page| 100 ¥

ount | b E> e Numb Extension User Na

P85000000174173 3001 (210)500-1448 RA

reynavodaplex Virtual Extension

""1111, Exp 1/202E Active U,

Visa ™™ pda
P8B000000130328 1001 (558) 131-8487 Reyna Arzola reynavodaplex Unlimited Extension Visg " 1111, Exp 1/202¢ Pending Update
P35000000130320 1001 Reyna Aol reynavodaplex iPhone Application  Visa ""*****1111, Exp 1/202% Pending Updste

-

When the dialog box appears, select the payment method for consolidated payment from the drop-down menu
5. Click Save.

6. When the confirming dialog box appears, click Ok to confirm the change.

Your billing is now consolidated under one credit card.
Update Payment and Billing Information

1. Click Billing in the top navigation bar.
2. Click Update Payment/Billing Info.

HOME | PHONE SYSTEM I BILLING |I REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE |
Home > Billing Enter keyword | Search |
BILLING 0 Important Message

? Statements

> Biling Profile

Your inveice statement for the current month is currently being generated and will be sent to you shortly. If you have any questions please call 1-408-400-7775 or
email inveicebiling @8:8.com.

Billing - Consolidated @ Hep

W accoun
ANRSOIte Activity Since Last Payment

Update Payment /
Billing Info

[ csv o Currency [5 US Dolar v

“iew activity since your last payment
Mesxt payment will be processed 03-02-2017

3. For consolidated SMB accounts, select another payment type from the list, and click Select.
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4. Click Delete or Edit, if applicable.

Version 1.0

Note: At least one credit card must be active at all times.

If you are adding a new credit card, click Add Credit Card.

Update Billing Profile

Payment Options

Billing Preference - Consolidated (All costs are to a single payment source)

@ Help
Change To UnConsolidated Billing

Payment Type

Credit Card

Card Type / Bank Name

Visa

3151 Jay Street1

mooooooooes] 111 01/2025 Demo88 Santa Clara CA USA 5054 I Edit | Delete I
Invoice Reyna Arzola sen f;gg;‘t,';: - Edit
Select Credit Card Amencan Express oocoooeccoB 431 01/2025 Mishant SEHAJ‘;;LE;ELSSEI—;H 12 Edit | Delete
o iy 3 N 2125 onel drive_1
v Credit Card Visa wooooooooeod BB 1 01/2025 deses SFO CAUSA 04703 Edit
Sedect Credit Card Discover woononooooc@ 424 01/2018 Mishant Jha SE""};:; "é:ELILSD:v:s 121 Edit | Delete
Select ACH Nishant Bank wooxBTET Nishant Jha Edit

Account Status

Fi bl Lact

hone N

P8B000000174173 3001

(210) 500-1448 RA

Extensions Per Page 100 ¥

reynavodaplex Virtual Extension Active
PaB000000130328 1001 (558) 131-0467 Reyna Arzola reynavodaplex Unlimited Extension Pending Activation
PSBO00000130320 1001 Reyna Arzola reynavodaplex iPhone Application Pending Configuration
P2B000000174172 QA Test reynavodaplex Switchboard Softwars Mone

Fill in the information for the new credit card.

Add Credit Card

@ Help

Flease enter the new credit card information below. For billing addresses outside the U.S, UK and Canada, please call 8x8 Support (B88) 898-8733.

Credit Card Information

Make Active? L
Credit Card Type Visa
Credit Card Number

cvv ‘What is this?

Expiration Date
MName on Card

01 - January

v

Billing Information USA

Country *
Address Linel®
Address Line2
City*

State*

Zip Code®

2015 v

United States

Manage Billing
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7. Click Save.

Notes:
-For unconsolidated SMB accounts, in Update Payment Billing Info, click Update.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Biling > Billing Profile
@ Help

Billing Profile - Unconsolidated
‘Change To Consolidated Billing

BILLING
Billing Pref e - UnConsolidated (Individual or grouped costs are billed te multiple payment sources)

? Statements
* Biling Profie Account Status

* Assign Payment
Eo > one Numb o o s o
PSB000000174173 3001 (210)500-1448 RA reynavodaplex Wirtus| Extension Visa Hrres 1881, Exp 1/202¢ Actve [ Update | =
PSB000000130328 1001 (558)131-8467  Reyna Arols reynavodaplex Unlimited Extension  Visa "*******1881, Exp 1/202f Pendind Update ||
P85000000130328 1001 Reyna Arzola reynavodaplex iPhone Application  Visa " 1881, Exp 1/202¢ Pendind Update |

-Select the payment type from the listed options. You can also add a new credit card or delete an

existing one.

@ Help

Update Billing Profile

Add New Credit Card Delete Credit Card(s)

Payment Type] ' Debit Bank Account (ACH)
‘= Credit Card | \fisa / 1881

J Invoice

Credit Card Information Billing Information

Country usA
Is Active Yes Edit Card Info |address Linel 2125
Address Line2 onel drive_1

Credit Card Type  Visa

Credit Card Number **####++1551 City SFO
Expiration Date 1/ 2025 State cA
Postal Code 94103

Name On Card desee

| Save Jf Cancel |

Services Billed to this Credit Cards

Virtual Extension Active

(210) 500-1448 RA reynavodaplex

PEB000000174173 2001

P8B000000130328 1001 (558) 131-0487 Reyna Arzola reynavodaplex Unlimited Extension Pending Activation

P8B000000130328 1001 Reyna Arzola reynavodaplex iPhone Application Pending Configuratior 8
-

Enterprise Users
If you are an Enterprise user, you can set your billing profile to add a new credit card or ACH account, create cost

centers, and set your billing preferences to receive single or multiple bills. For details, refer to:
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m Statements

Billing Profile

Billing Preferences

Cost Centers

Billing Preferences

Manage Billing

Billing Preferences offer you the flexibility to control your billing needs for all your 8x8 services. The options vary based

on your subscription type. You have the option to select Consolidated Bill under Billing Preferences. Once you select

consolidated billing, you cannot go back to unconsolidated billing. You receive a warning message that this change

cannot be undone.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Biling > Billing Preference

Billing Preferences

BILLING
x . The Billing Praferances section gives you flaxibility to contrel your consolidated bill. Choose to recaive a zingle bill for all of your services and pay once, make things
iEiEiEE clearer by assigning your services to Cost Centers with a single bill, or designate Cost Centers and separate payments.
> Biling Profile
2 Billing =
Preferences Consolidated Bil You cannot undo if
» Assign Payment Single Bl (Defaul] you select and save

Single Bill for all Cost Centers Consolidated option
Muttiple Bills by Cost Center
® Unconsolidated Bil

Available for
unconsolidated bills
only. It will be replaced
by Cost Centers once
you select Consolidated

\EI”.

@ Hebp

Note: SMB customers do not see Billing Preferences.

Under consolidated billing, you can choose to receive a single bill for all of your services, or select multiple bills (one for

each cost center) to break down the cost and service details by cost center. Cost Center is a feature for enterprise

customers to customize their billing needs. For example, if your company PBX has two branches, such as San Jose and

San Francisco, you may choose to have separate billing for each branch. Creating a cost center for each branch enables

you to manage the separate billing needs.
For details, refer to Cost Centers.
Set up Billing Preferences

1. Click Billing in the top navigation bar.
2. Under the Billing menu, click Billing Preferences.

3. Enable Single Bill (Default) to see one bill for the cost center.
OR
Enable Multiple Bills by Cost Center to see multiple bills for each cost center.
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If you have two branches, such as San Jose and San Francisco, you see two monthly bill statements for each
billing cycle.

4. To create cost centers from PBX branches automatically, select the Auto Create Cost Centers from Branches
check box.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Biling > Billing Preference
Billing Preferences @ Hep
BILLING

The Billing Preferences saction gives you flaxibility to control your consolidated bill. Chooss to recsive = single bill for all of your ssrvices and pay oncs, make things

? Statements clearer by assigning your services to Cost Centers with a single bill, or designate Cost Centers and separate payments.

2 Biling Profile
¥ Billing
Preferences = Consclidated Bill

> Cost Centers & _Single Bill (Default)
«# Auto create Cost Centers from Branches

Single Bill for all Cost Centers
Muttiple Bills by Cost Center

5. Click Save.

6. Select your payment method.

Change to Consolidated Billing

To change your biling preference to one consclidated bill, please
select the Payment Method that will be used for payment.

Payment Method | \isa /1881 ¥

[ Save | Cancel

Note: Payment types can include invoice, ACH (checking), and credit card. If you want to keep
invoicing, make sure retain your payment type selection to invoice. If you change it to ACH or

credit card, you cannot move back to invoices.

7. Click Save.

8. Click OK.
Click Cost Centers in the top navigation bar.
You now see a list of cost centers for your existing branches.
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Heme > Biling > Cost Center
BILLING Cost Centers @ Help
% Statements All add-on new erders are assigned to the corperate cost center by default. If desired, please move them under individual cost center.
> giling Profile

> Biling Preferences  First [4] 4-2 of 2[¥] Last Cost Centers Per Page 10 ¥
¥ Cost Centers e =

ELREEY aran TROMAS. an Jose

San Francisco Sarah Thomas San Francisco

To decouple Branches from its Cost Centers, go to Billing Praferences and make the appropriate selaction

Note: If you created cost centers manually for your branches and later decide to link the cost
centers to branches, you must delete the existing cost centers and enable the option to
automatically create cost centers from branches. Deleting cost centers does not affect your
accounts.

Cost Centers

A cost center allows you to keep track of expenses for each department, branch, or location. For example, if your
company has branches in multiple geographic locations, you can create a cost center for each branch and track the
expenses individually. When you create a cost center manually, you must add accounts to the cost center. Each
account is based on a service type. For services:

m Add-on services added to extensions associated with a branch are automatically reflected in the cost center.
= New services added to branches are automatically reflected in the cost center.
You can create cost centers manually, or automatically if you have branches. To access cost centers, go to Billing >

Cost Centers.
Cost Center Prerequisite

The ability to create a cost center is available only to Enterprise customers who have set up consolidated billing. If you
have unconsolidated billing and would like to manage billing through cost centers, you must change your billing
preferences from Unconsolidated to Consolidated in Billing > Statements.
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HOME | PHONE SYSTEM || BILLING || REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
e

Home = Billing
Billing - Consolidated @ Help
BILLING

¥ Statements
> Siling Profie Update Paymnnti View Statements Download B"Hﬂg Cost Centers
" Billing Info All Accounts Praferences A
? Billing Preferances
> Cost Centers ? 3 [ B 4]

[Downioad [EEEEENEEE ‘= [ ew |

]
“iew activity since your last payment.
Mext payment will be processed 03-02-2017

Create a Cost Center Manually

In the manual setup, define a cost center based on accounts but not mapped to branches. In this case, changes done to
branches are not reflected in cost centers.
To create cost centers:
1. Click Billing in the top navigation bar.

2. Under the Billing menu, click Cost Centers.

3. Click Create Cost Center.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Biling > Cost Center
BILLING Cost Centers @ Help
? Statements All add-on new orders are assigned to the corporate cost center by default. If desired, please move them under individual cost center.
3 Biling Profie
? Biling Preferences
> Cost Centers

Cost Centers have not been created yet
4. Enter a Cost Center Name, and click Add Accounts.
Create Cost Center © Help

Cost Center Name I

Cost Center Contact Sarah Thomas

No Accounts Added Yet:

w7
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5. Alist of available accounts appears. Select the ones you wish to add to your cost center. You must add at least

Version 1.0

one account. You can add or delete accounts to an existing cost center at any time.
For details, refer to Manage Cost Center Accounts.

Click Add.

Manage Account - Cupertino

¥ Existing Accounts

Please select account(s) from the Available Accounts list and click on the Add button.

= Available Accounts

To search for an account, type the account number, User name, Ext or Phone number and hit the search button
Quick Search i)

Search by Account Mumber, Ext or Phane Number

Select account(s) and click on the Add button ‘ m
Fis ¥ Accounts Per Page| 10 ¥
Account Status

SDECIATyCOOKES Unlimited
@  POBO00DODOSS826 1002 16508462888 Sarah Thomas speciaftycookies WMetered UsA Active
& PEE0000000S5830 1008 Sarah Thomas spacialtycookies Overnead usa Active
Paaina
- PSBO0000O00S5S31 1007 14086278740 Jean Andje specltycookies Uniimited usa Active
v PEBE000000025832 1008 15566480703 Sarah Thomas o Basic usa Active
&  PSBO0000DOSSE34 1001 16508463018 Sarah Thomas specialtycookies Unlimited usA Active
v PBE000DO00SEE36 1005 16506463020 Suzy White specialtycookies Shared usA Active
v PBEDOODOO0BSB3T 1001 15109625321 Sarah Thomas specialtycookies Virtual Number usA Active
POB0000O00G5638 444 786695067 72 Saran Thomas Specaftycooies Tal-Fres USA Active
Number
PBE0000000E5ETD Sarah Thomas o i usa Active
Software

Click Save.
The cost center is created and added to the list.

Click Edit to rename or manage the cost center accounts, or click Delete if you wish to remove the cost center.

Cost Centers @ Hep

All add-on new orders are assigned to the corporate cost center by default. If desired, please move them under individual cost center.

Create Cost Center

Fi 3 Cost Centers Per Page 10 ¥

San Jose Sarah Thomas

San Francisco Sarah Thomas 4 m
Cupertino Saran Thomas ] m

Note: You do not have the privileges to delete cost centers created automatically from branches.
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Create a Cost Center Automatically

Manage Billing

If your company's PBX is segmented into branches and you wish to have cost centers for each branch, you can choose
to create the cost centers automatically and set up the billing preferences to generate cost centers from branches
automatically. The cost centers are mapped to branches, and are in sync with changes made to branches. All changes

to the branch are automatically reflected in the cost center.
Decouple Cost Centers from Branches

If you wish to separate cost centers from branches, you can go back to Billing Preferences. Select the Decouple

Cost Centers from Branches check box.
A message warns you that the change cannot be undone.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home = Biling > Billing Preference
Billing Preferences

BILLING

% . The Billing Preferences saction gives you flaxibility to control your consolidated bill. Chosse to raceive a single bill for all of your services and pay once, make things
SEiEEne clearer by assigning your services to Cost Centers with a single bill, or designate Cost Centers and separate payments.
2 Biling Profile

? Billing
Preferences = Consolidated Bil
¥ Cost Centers = Single Bill { Default)
I # Decouple Cost Centers from Branches I

Single Bil for all Cost Centers
Muttiple Bills by Cost Center

[ Save | Carcel |

@ Heb

Manage Cost Center Accounts

When you create a cost center, you must add accounts to it. Each account is based on service types, such as Unlimited
Extension, Service Extension (Ring Group, Call Queue, and Auto Attendant), the Virtual Office desktop app, or Virtual
Extension. When you add new services to your PBX, the new accounts show up under Corporate Cost Center in your
statement. To assign these accounts to the desired cost center, edit the cost center, and go to Manage Accounts.

To manage accounts:
1. Click Billing in the top navigation bar.
2. Inthe Billing menu, click Cost Centers.

3. Click Edit next to the cost center in the list.
A list of accounts, extension numbers, and extension users appears.

Version 1.0
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4. Click Manage Accounts.

Edit Cost Center © Help

Cost Center Name San Jose

Cost Center Contact Sarah Themas

Branch Name San Jose

P8B0000000BEE22 1004 18506482008 Sarah Thomas pecialt ki Global E i usa Active
P2B0000000BT220 1004 Sarah Thomas spacialycookies VO Online usa Active
P2B0000000BETEE 1017 12105502022 Sarah Thomas spacialycookies Virtual Number usa Active
P8B000000105873 1017 16673010101 John Smith spacialycookies Unilimited Extensio usa Active
P8B000000105003 1017 John Smith spacialycookies WO Online usa Active
P8B000000131624 1040 16681310440 Janica Lawis spacialycookies Unilimited Extensio usa Active
PEE0O000D00131638 1027 14083287170 Martha Stott specialtycookies Unlimited Extensio UsA Active
P8B0O00000131638 1028 14083287188 Eleszar Manalk specialtycookies Unlimited Extensio Usa Active
P8B000000131640 1025 14083287154 Joel Sandi speciaitycookies Unlimited Extensio UsA Active
P8B0O00000131658 1040 Janice Lewis speciaitycookies VO Online UsA Active

5. Select a check box by an account under Existing Accounts.
The Choose to Assign / Reassign option box appears under Existing Accounts.

6. Select an option from the drop-down list. You can choose to un-assign an account from its current branch and

assign it to another.

Manage Account - San Francisco

Existing Accounts

Choose to Unassign / Reassign ¥
e ey Accounts Per Page 10 ¥

Unassign From: San Francisco = M. 5 " 5 r C Account 5t

Reassign To: 3an Jose

2 P TIE TO3T 15581310400 Sarah Thomas specialtycookies I_L.'r'||ir'nit_e&:| usa Active
P2B000000131834 1030 14083207174 Darmran p I_L.lr'|||r'\’|lt_ed usa Active
P2B000000131713 1031 Sarah Thomas specialtycookies VO Online usa Active
P8B000000131718 1030 Darmran i i O Online usa Active

To add a new account to the selected cost center:
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1. Select a check box by an account under Available Accounts.
2. Click Add.

To search for an account, type the account number, User name, Ext or Phone number and hit the search button
Quick Search i)

Select account(s) and click on the Add button.

First[4] 1= pl Last
\ccount b

= Available Accounts

Accounts Per Page 10 v
ecount Shhe

co Ext Pho Extension U fam Pho 2 o p Home Coun Acco
v PEBO00O0ODOOBSETO Sarah Thomas i d usAa Active
Software

P8B000000OB5ET1 Sarsh Thomas specialtycookies Call Queaue usa Active
P8B000000176645 Sarsh Thomas specialtycookies VO Reports usa Active
P8B000000176648 Conrad Lee specialtycookies VO Reports usa Active
P8B000000176647 Sarah Thomas specialtycookies VO Reports usa Active
PEBE000000178648 Sarah Thomas specialtycookies VO Reports usa Active
PEB000000178640 Sarah Thomas specialtycookies VO Reports usa Active
PEB0000001785850 Sarah Thomas specialtycookies VO Reports UsA Active
PEB000000178851 Sarah Thomas specialtycookies VO Reports Usa Active
PEB000000178852 Sarah Thomas specialtycookies VO Reports usa Active

The selected account is added to the existing accounts.

Relationship Between Branches and Cost Centers

= All changes to branches are reflected in cost centers bound to the branch.

= Allline items (service type accounts such as Virtual Office Analytics and Barge-Monitor-Whisper) that can be

added to a cost center by managing accounts do not update the associated branch.

Version 1.0
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Manage Reporting

Using Account Manager, you can run and schedule call log reports that reflect activity on individual extensions, selected

extensions, or all extensions.

Run or Schedule a Report

1. Click Reporting in the top navigation bar.

2. Setthe Report Type and Display Format to select the type and organization of the activity reflected in the
report.

3. Set the Report Timeframe. Data can be reported from the previous day, week, month, and more. You can also

set a custom timeframe.

Version 1.0 183



8x8

88 8x8,Inc. Welcome, Phillip Liu | Sign Out

ACCOUHT Manager Company Name: Specialty Cockies | Main Number: (510) $62-5321

REPORTING

Motice: The report display formats have changed. Click here to see examples of the new formats.
? Run/Schedule

? Manage Schedules

? View Reports. Report Type
Call Logs v I © Runreportnow 0 Schedule report I
Display Format
Detailed Report v

Call Report Time Filter

el e time period for this report.

Report Timeframe Start Date Time (HH:MM}

“esterday v | [Mar05 2015 12 o B
ime Zone End Date Time [HH ]

Us/Pacific ¥ | Msros 2015 1 il WlPv v
Note: Date range cannot exceed 3 months

Seledt the number type then choose or search for the number(s) for this report

Number Types
’ Enter extension number, phone number or caller ID.
Select All

) Virtual Numbers | Search | Resat

# Tol-Free Humbers

# Extensions
444 (556)054-7455 Virtusl Number
1001 (510)982-5321 Virtual Number
444 (2686)950-8772 Tol-Free Number
1001 (850) 648-3015 Phillp Liu Unlimited Extension
1002 (850) 848-2088 Sukhanya Rajan Matersd Extension
1003 (550) 549-2002 Sarah Thomas Unlimited Extension

[Run ]

Email: pliu@Ex8.com Account: | Business v
Edit My Profile
HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Home > Reporting > Run/Schedule Enter keyword m
Run/Schedule @ Help

Calls Direction
All v
External Phone Number

Note: The date range cannot exceed 3 months.

If you selected the Custom report timeframe, you can set:
= Start Date
= End Date
m The Time for both dates
4. If necessary, set the Time Zone.
5. Select Data Filters:
a. Choose Number Types to display in the extension box:

m Select All

m Extensions
m Virtual Numbers
m Toll-Free Numbers

Version 1.0
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b. Select the extensions you want to include in the report.

Enter extension number, phone number or caller 1D.
| Search | Reset |
First [4] 1-100 of 113 [3] Last Extensions Per Page 1DDE|
Ext w0 DID 1
v 1001 | (408)B27-8959 Al York Unlimited Extension -
L 1002 | (408) TEE-9021 Hugo Olortegui Unlimited Extension
1003 | (408) 786-9106 Beth Carney Unimited Extension
1004 | (408) 786-9050 qatestblee! 1004 Uniimted Extension
1005 | (408) TBE-9051 gatestblee! 1005 Un.md“E;;;;;T
1006 | (408) 7TB6-9121 qatestblee! 1006 Shared Extension
1007 | (408) TEE-9181 gatestblee! 1007 Shared Extension
1008 | (403) T86-9026 gatestbles1 1008 Softak Premium (VO) -

c. Select the Calls Direction to include in the report:

n All
= Inbound
m  Outbound

Manage Reporting

d. To track calls made to or from your contact center that involve a specific external number, enter an optional
External Phone Number to include in the report.

If you want to schedule a report instead of running one immediately, select Schedule Report.

Under the Report Scheduling Settings section that appears:

a. Enterthe Report Name.

b. Setthe Report Frequency.

Report Scheduling Settings

Name report and set schedule

Report Name Set Frequency
Daily Report Report Frequency

Email Download Notifications To
Hugo Olortegui [=]

[T viewable by all admins

Report Summary : Time Frame : Yesterday. Daily every 1 day(s) starting on Mar 18 2013 at 12:0 AM US/Pacific. Ends Never,

Save and Run Now
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c. Inthe Report Schedule box that pops up, enter the necessary information. Reports can run at a future date,

or on a daily, weekly, or monthly repeating schedule. Click Done when finished.

Repeats :

Starts on :

Time Zone :

Ends:

Summary :

Daily (]

Repeatevery: 1 |«|days

mar 182013 [5H

Time(Hi:mmy: 12 0 B Av (<]

US/Pacific E|

@ Never
) After
) On
Daily

I Done || Cancel

d. Under Email Download Notifications To, select the system administrator you would like to send an email

notification to once the report is ready.

privileges.

Note: Email notifications can only be sent to system administrators. To create new ,
administrators for the reporting, go to Accounts > Privileges. Make sure to grant Reporting

€. To make the report available to all your phone system administrators with Reporting capabilities, select the

Viewable by all admins check box.

If you selected Run Report Now, click Run to finish.

OR

If you selected Schedule Report, click:

m Save to save a report without running it.

m Save and Run Now to save a report and run it.
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Manage Schedules

To edit scheduled reports, click Manage Schedules under the Reporting menu.
Find the report you want to manage, and choose from the following actions:

m Enable/Disable
m Edit
m Delete

= Run Now

View Reports

To view previously-generated reports, click View Reports under the Reporting menu.

Version 1.0 187



Manage Orders
8x8

Manage Orders

8x8 makes it easy to check your orders, buy new services, and upgrade existing services online using Account Manager.

Check Order Status

1. Click Orders in the top navigation bar.

Account Manager Company Name: Acmelets, Inc
% 8x8,Inc. Welcome, Acmelets Inc | Sign Out
Email: nalini@8x8.com Account: Business v

Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Orders > Check Order Status Enter keyword | Search |
Check Order Status @ Help
ORDERS
* Check Order Search for Orders

Status

‘Order Date Between and IR Advanced Search
¥ Buy New Services = E@

* Upgrade Services
The folloving orders were placed in the last 50 days.

Order 1D ‘Order Date Status Total Price Tracking Number Ship Date Acfions
* AO1000203438 02-25-2015 Hold $75.00 View
» 401000203384 02-20-2015 Complate 5279.90 View
¥ CO1000203385 02-18-2015 Not Shipped 54,480.14 View
[ [ |

2. To search orders by date (basic search):
a. Select a start date.

b. Select an end date.
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c. Click Search.

3. To search for orders by Order ID or Status (advanced search):
a. Click Advanced Search.
b. Enterthe Order ID, or click the drop-down arrow to select an order status.

c. Click Search.

Search for Orders

Order Date Between ﬂm and Basic Search
Order ID
Status Complete [=]

» 5A10000542 08-20-2011 Mot Shipped foz.28 Wigw
P AD1000004074 09-06-2011 Complete $75.00 Wiewy
» 401000004068 08-25-2011 Complete $72.04 Wiew
¥ C0O1000004064 08-25-2011 Complete §79.98 WiE

Buy New Services

You can buy add-on services and equipment for existing service types.
1. Click Orders in the top navigation bar.

2. Under the Orders menu, click Buy New Services.
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3. Select your Service Type.

Select Service Type

® Business
Virtual Office phone service

Virtual Office Solo
Business phone service for one

Virtual Meeting
Web conferencing service

4. Click Continue.
5. Provide your service location address for E911 emergency service.
a. To Select an existing Service Location Address, click the arrow for the drop-down list, and make your
selection.
b. To Enter a New Service Location Address, complete the required fields.

Note: Required fields are marked with *. You can only select one item at a time.

Select an existing Service Location Address
810 W MAUDE AVE SUNNYVALE CA 94085 -2910 USA v

Enter a New Service Location Address

Country *
United States

Street Number *
810

Pre-Directional Street Name * Street Name Suffix Post Directional
W - West ¥ | MAUDE Avenue v v

Secondary Location Unit/ Other

City * State * Zip Code *
SUNNYWVALE California ¥ | (34085 (2910

6. Click Continue to Step 2.
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7. Click Add Services or Equipment to select the services you would like to purchase.

What would you like to purchase?
* Phone Extension
Add & new eXIENSION 1o your business.
Fax Extension

Add a fax extension, works with standard fax machines.

Virtual Extension
Great for oy such as add driving directions, promations, product tps. Includes voicemail bax. No phone
required

Shared Line Extension
Used when multiple people share the responsibility for answering the same ine

Tell Free Number

Provade US callers with the ability to call you for free.

Virtual Number

Often used as a main number, rings to primary number(s} or auto attendant at your company. Can have same or different area code
Ring Group

Add a ring group 50 multipk can share the of incoming calks

Aute Attendant
Add anather Auto Attendant to your PEX

Accessories
Add on headsets, routers of ciher ACCesSOnes

8. Select a plan or device to purchase.

9. Click Next.

10.

11.

12. Select an outside phone number for the extension by selecting the user's:

13.

Version 1.0

If you are purchasing an extension, configure the extension by entering the user's:

m Extension Number
m CallerID First Name
m CallerID Last Name
s Email

Click Next.

m State
m Area Code
m City
Click Add to Cart.

Manage Orders
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14. Select a phone number from the list presented. To see more numbers, click Show me more numbers at the
bottom of the list.

Add Services or Equipment (%]

Select a Phone Number

State Area Code City
California [=] |es0 [*] PALOALTO (650-353000) [=]

Select a number below:
@ (555) 808-3150
(555) 808-6850
(555) 809-0551
(555) 809-4253
(655) 809-7956
(555) B10-1660
(555) 810-5365
' (5565) 810-9071

" (555) 811-2778

6 e Tie Tile e T

[Rad o Cart || Concel |

15. Click Add to Cart.

16. To purchase additional services or equipment, click Add More Services or Equipment on the Buy New
Services main page, and repeat the steps above.

17. Click Continue.
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18. Enter your billing and shipping information.
a. To Select an Existing Credit Card already on file, click the drop-down arrow, and make your selection.
b. To Enter a New Credit Card, complete the required fields.

Note: Required fields are marked with *.

Billing Payment Information

Select an Existing Credit Card

visa/ 1111[=]

Enter a New Credit Card

Credit Card Type * Credit Card Number * Card ID (CVV2) *

Visa = 0 What is this?
MName on Card * Expiration Date *

03[=] [2025[~]

Billing Address ™ Same as Service Address
Address 1 *

810 W MAUDE AVE

Address 2

City * State * Zip Code *
SUNNYVALE California [+] 94085 2910
Country *

United States 3|

C. Check the appropriate boxes if your billing address, service address, and/or shipping address are the same.
d. To enter a new billing or shipping address, complete the required fields.
19. Click Continue.

20. Review and confirm your order.

Upgrade Services
1. Click Orders in the top navigation bar.

2. Under the Orders menu, click Upgrade Services.
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Select the service type you want to upgrade.

Upgrade/ Replace Services and Equipment

STEPS: Account Type » Select Upgrade Services » Billing & Shipping Infor ion » Review & Confi

To upgrade your current equipment or existing service plans, select your account and click Continue.

Which service type would you like to upgrade?

s Business
Virtual Office phene service

Click Continue.

Manage Orders

Your service plans, along with the existing equipment that it is associated with your plan, are displayed. Select the

plan or equipment you want to upgrade.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Orders > Upgrade Services

upgrade/ Replace Services and Equipment
ORDERS

7 Cheek Order Slalws gyEpS:  Account Type » Select Upgrade Services » Billing & Shipping Information » Review & Confirm
 Buy New Services

¥ Upgrade Services
e Choose the plan and/or equipment you would like to upgrade.

Service Plan Equipment Account Status Name Phone Number Exiension
Unlimited Extension Aastra IP 6755i Deskphone  Active Phillip Liu (650) 646-30186 1001
Unlimited Extension Polycom SoundPoint IP S50 Active John Smith (650) 646-2992 1003
# Glbobal Extension Polycom SoundPoint IP 550  Active Sarah Thomas (650) 646-3006 1004
Shared Line Unlimited Extn. Active Suzy White (650) 646-3020 1005
IP Phone Basic Extension - No Fees  Aastra IP 6755i Deskphone  Active Specialty Cockies (555) 648-0703 1006
Unlimited Extension irtual Office Softphone Active Jean Andje (408) 627-8740 1007

© H=lp

Click Continue.

Select from the available upgrade options and new equipment presented.

Click Continue.

Note: If you do not see the service or equipment you want, contact 8x8 Sales at 866-879-8647.

194



Manage Orders
8x8

9. Enteryour Billing and Shipping Information.
a. To Select an Existing Credit Card already on file, click the drop-down arrow and make your selection.

b. To Enter a New Credit Card, complete the required fields.

Note: Required fields are marked with *.

Billing Payment Information

Select an Existing Credit Card

visa/ 1111[=]

Enter a New Credit Card

Credit Card Type * Credit Card Number * Card ID (CVV2) *

Visa = 0 What is this?
MName on Card * Expiration Date *

03[=] [2025[~]

Billing Address ™ Same as Service Address
Address 1 *

810 W MAUDE AVE

Address 2

City * State * Zip Code *
SUNNYVALE California [+] 94085 2910
Country *

United States 3|

C. Select the appropriate check box if your billing address and shipping address are the same.
d. To edit or enter a billing or shipping address, complete the required fields.

10. Click Continue.

11. Review and confirm your order.
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Usin
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.
.
.

g the Accounts tab, you can:

Create user profiles

Configure privileges

Define company communication preferences
Manage the Contact Directory

Set up Single Sign-On

Configure Analytics privileges

Access the Virtual Office Online App

Accounts Overview

In the Account Manager top navigation bar, you can find a tab for the Virtual Office online app for all phone

administrators and privileged users whose profile is associated with a Virtual Office extension. Clicking this tab opens

the Virtual Office online app in your browser. You can access additional features available with your 8x8 Virtual Office

account.

About User Profiles

User profiles are required to give users access to their 8x8 system. Create a user profile first before you assign users to

an extension or grant administrative privileges in Account Manager.

You must create one user profile per individual. A user profile can be assigned to multiple extensions or features. It is

important that a user profile remains current, especially the user's email address. The following fields are mandatory in

creating a new user profile:

Version 1.0
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First Name

Last Name

m Email Address

m Username

Note: When creating a new user profile, by default the user name is the email address. The system
administrator has the flexibility to change the user name to something other than the email address.

You can create user profiles one at a time orin bulk. To create a single user profile, refer to Step 1: Create a User
Profile. Follow the instructions below to create multiple user profiles:
Create Multiple User Profiles

1. Click Accounts in the top navigation bar.
2. OnUser Profiles, click View.

3. Click Download CSV Template to download an Excel file that stores the user profile information.

User Profiles @ Hel
ACCOUNTS
Create and edit user profiles below. User Profiles are required to assign users to system tools and features including
> User Profiles extensions, and to grant Account Manager privileges. Customize View
S
s You can hide or show columns, and create additional
> Communication customized fiekds by clicking Edit Viewable / Hidden Fields.
Preferences
» Contact Directory
’p — EZEN EEEY view:® Al O Active O Dissbled Create New User Profie [ll Edit Viewable / Hidden Fiekis
‘assword Policy
Dickenson Emiy nalini@8x8.com
Rudolpn Vaya nalini@8x8.com
= nalini@8x8.com
Shasta marzien fadsee@8x8.com
Tromas sthomas marzien fadsee@8x8.com
sritn jonny nalini@8s8.com
3

Creats and edit multiple profilas at once by downloading the csv tsmplate, anter data in appropriate columns and then upload || [N T
using the link to the right.

8 Profiles_acmejetsine_.csv | ¥ Show all downloads..

Note: If you are using customizable fields, before downloading the template, make sure that you
have labeled the field by following the instructions in Show Customizable Fields.
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Save the file to your computer once you make all your changes.

On the User Profiles page, click Upload CSV Template.
Click Proceed.

Click Add, and locate the file you just saved.

Click Open, then Upload.

Verify that the new information is correct, and click Submit.

Change User Profile Password

1.
2.
3.

Version 1.0

Click Accounts in the top navigation bar.
On User Profiles, click View.

Find the agent from the list, and click Reset Password.

Note: Do not make any changes to the 8x8 Internal ID column.

Account Manager

% 8x8, Inc. Welcome, John Smith | Sign Qut

Email: nalini@8x8.com
Edit My Profile

Company Name: Acmelets Inc

Account:| Business M

HOME | PHONE SYSTEM | CONTACT CENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts > User Profiles

User Profiles

? Communication
Praferences
2 Contact Directory

View: ® Al O Active

? Password Policy

ACCOUNTS

Create and edit user profiles below. User Profiles are required to assign users to system tools and features including
? User Profiles extensions, and to grant Account Manager privileges.
? Privieges

Enter keyword
© Help
Customize View

*You can hide or show columns, and create additional
customized fields by clicking Edit \iewable / Hidden Fields.

(Create New User Profie [Edit Viewable / Hidden Fields

Edit \IReset Password ||D\5:|I:Ie | Delets Emily Dickensan Emily nalini@8xE.com
Edit | Resst Password | Disable | Delete Maya Rudolph Msya nalini@ex8.com
Edit | Resst Password | Disable | Delete  Naney Gil nalini@ex8.com
Edit | Resst Password | Disable | Delete  Rob Shasta marzieh. fadaee@8x8.com
Edit | Reset Password | Disable | Delete  Sarah Thomas sthamas marzieh_fadase @8x8.com
Edit | Reset Password | Disable | Delele  john smith johny nalini@Ex8.com

»

using the link to the right.

Create and edit multiple profiles at once by downloading the csv template, enter data in appropriate columns and then upload Download CSV Template | Upload CSV Tempiate

Accounts Overview
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4. The Reset Password confirmation window opens.

Reset Password

An email with instructions on resetiing the password will be sent to the below
email address for the selected user profile.

User ID

EMILYD

Email Address nalini@~2x8.com

To change the password, click on the link provided in the email.

Check the user ID and email address, and click Send Email.

Accounts Overview

5. Anemail is sent to the agent's address as seen in the user profile. To change the password, the agent has to click

Version 1.0

the link provided in the email and follow the instructions.

The new password requires specific types of characters for security purposes. In the Reset Password window,

hover over the question mark to see the requirements.

- different from user name.
EC]UI =0 Characters ror passworda

Password should have

- atleast one uppercase letier,

- atleast one lowercase leiier,

- atleast one numeric digit,

- at least one special character from
the set (~4@#s"*—=|;, ?==8&)

- minimum of 8 and maximum of 25
characters and
- no white space.

Additionally, password should also be

Return to Log in
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Create User Profiles

Accounts Overview

As an administrator, you can create user profiles one at a time or in bulk. To create an individual user profile:

1.

2
3.
4

Click Accounts in the top navigation bar.

Under the Accounts menu, click User Profiles.

Click Create New User Profile.

Enter user information. The mandatory fields are First Name, Last Name, Email Address, and User Name (by
default, the user name is the email address).

ACCOUNTS

2 User Profiles

Home = Accounts > User Profiles

User Profiles

Create and edit user
including extensions,

First [4] 1-94 of 94 [k

First Name * wJohn

Last Name * Smith
Nickname

Email Address * jsmith@8x8.com
Job Title Product Manager
Department Product Management
Location San Jose

User Name * JOHNS
Bookmark

(Custom Fieid)

Trunk #

(Custom Field)

Region

Edit | Resetf
Edit | Resetf
Enable

Edit | Resetl
Edit | Resetf
Edit | Resetf
Enable

(Custom Field)
Federation ID

SalesForce ID s @EXE.COM
Zendesk ID

NetSuite ID

Mobile

Language English (U.S.)
Time Zone US/Eastern

Directory Scope ) Branch

*=Indicates Required Fields

o
L7}
Customer @ PBX

HOME | PHONE SYSTEM | CONTACT CENTER | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL

[Save I Carcel |

5. Select a Language from the list. The user's email communications are sent in the selected language.

6. Select a Directory Scope level from the following options:

Version 1.0

m PBX: Allows access to all contacts within the PBX, including the branches.

m Customer: Allows access to all contacts within the account (this may include multiple PBXs and branches
within the PBXs).

m Branch: Allows access to only the contacts assigned to that branch.

By default, all users in a PBX are allowed access at the PBX level. If required, you can change access per

user.
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B
o _.f Note: Directory Scope is only applicable to enterprise customers with multiple PBXs and
. branches.

: Note: For phone extensions that are not assigned to a specific individual, but instead located in a

E f— specific area like the front lobby, conference room, and so on, create a user profile for each area. For
; f = :| example, enter Front as a First Name and Lobby as the Last Name, and enter the email address of the

person responsible for maintaining the extension settings (such as the primary system administrator).

Disable User Profiles

To disable a user profile, click Disable in the Action column. Disabling a user profile removes the profile from all
extensions and features the user profile has been assigned to.

1.
2.

Version 1.0

====_  Note: You can re-enable a disabled user profile. However, you have to manually reassign the user
—_ ﬁ profile to an extension or other feature. To maintain historical reporting, you are unable to delete a user

profile completely from your system.

Click Accounts in the top navigation bar.

Under the Accounts menu, click User Profiles.
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3. To hide available fields in the User Profile chart, click Edit Viewable/Hidden Fields.

Account Manager Company Name: Acmejets, Inc
% Bx8, Inc. Welcome, Acmelets Inc | Sign Out
Email: nalini@8x8.com Account:| Business v

Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERSI\ ACCOUNTS |I SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts = User Profiles.

Enter keyword EE

User Profiles @ Help
ACCOUNTS
Crasts and sdit user profiles below. User Profiles are requirsd to assion users b system tools and festures including
extensions, and to grant Account Manager privileges. Customize View
> privieges. ‘You can hide or show columns, and create additional
> Communication customized fiekds by clicking Edit Viewable / Hidden Fields
Preferances
 Contact Directory -
Ex= view: ® all O active O Disabled Create New User Profie [il| Edit Viewable / Hidden Fields
Edit | Resst Password | Disable  John Smith sty Smitr@ExE com
Edil | Reset Password | Disable  Rob Shasta Shasts @8x8.com
a4 »

Create and edit multiple profiles at once by downloading the csv template, enter data in appropriate columns and then upload Dowmnload CSV Template | Upload CSV Template
using the link to the right. @

4. Clear the check boxes next to the fields to hide.

User Profile Fiekis

Check the boxes you want to have visible, leave unchecked to hide. To use custom fields, check the box
| and provide a header label for each field.

First Name <
Last Name 7|
Nickname

Email Address
Job Title &

Department

<

Locatic

User Name

Assigned to Extension

td

v

Assigned to Ring Group (¢ l
Custom Field 1 «#  Header label Bookmark FieldType Text v

{max 25 ehars 1
Custom Field 2 Header label Trunk # Field Type  Text v
(max 25 ehars) 1

Custom Field 3 Header label Region FieldType | Text v

reate
Status rd

Disabled Date B
Federation ID
SFDCID

Mobile

Zendesk ID
NetSuite ID
Directory Scope

Language

U VNI VR U U N
L

Time Zone

[Save | cancl |

5. Click Save.

Phone system administrators can create up to three customizable fields.
Show Customizable Fields
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1.

Go to Accounts > User Profiles.
2. Click Edit Viewable/Hidden Fields.

88 8x8, Inc.

Account Manager Company Name: Acmejets, Inc

Welcome, Acmelets Inc | Sign Out
Email: nalini@x8.com Account:| Business v
Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERSI\ ACCOUNTS |I SUPPORT | VIRTUAL OFFICE ONLINE

* Communication
Preferences

? Contact Directory

Home > Accounts > User Profiles Enter keyword m
User Profiles @ Hep
ACCOUNTS
Create and edit user profiles below. User Profiles are required to assign users to system tools and features incluging
? User Profiles extensions, and to grant Account Manager privileges. Customize View
> Privileges

‘You can hide or show columns, and create additional
customized fields by clicking Edit Viewable / Hidden Fields.

SN EEZY vien ® anl O acive O Disabled Create New User Profie Jll| Edit Viewable / Hidden Fields

Edit | Reset Passwiord | Disable  Jonn Smith smithy Smitr@8x8.com
Edil | Reset Passwiord | Disable  Rob Shasta Shasta @8x8.com
4 1]

using the link to the right.

Create and edit multiple pr%fai\es at once by downloading the csv template, enter data in appropriate columns and then upload Dovmioad CSV Templale | Upload CSV Templale

3. Select the check boxes next to the fields to display.

4. Name the field by typing in the adjacent Header Label box.

5.

Version 1.0

First Name
Last Name
Nickname
Email Address
Job Title
Department
Location

User Name

Edit User Profile Fields

Check the boxes you want to have visible, leave unchecked to hide. To use custom fields, check the box
| and provide a header label for each field.

Assigned to Extension

r

v

Custom Field 1
{max 25 chars)
Custom Field 2
(max 25 chars)

Custom Field 3

4

7 i
Assigned to Ring Group  (# '

4

Header label Bookmark Field Type Text v
Header label Trunk 2 Field Type Text v

Header label Regicn FieldType Text v

reate

Status

Disabled Date
Federation ID
SFDCID

Mobile

Zendesk ID
NetSuite ID
Directory Scope
Language

Time Zone

G C SR C VR N AR C YR NN

Click Save.

Accounts Overview
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Configure Privileges

Every Virtual Office account has one primary administrator with privileges in all categories. This administrator's access
cannot be edited or revoked. To grant administrator privileges to an individual, you must first create a user profile for
them. Using Account Manager, you can assign users administrator privileges such as:

m Phone System

= Billing

m Reporting

= Orders

= Accounts

= Support
The primary administrator, and users with full privileges, can access all administrative areas. When they log in to
Account Manager, they see complete navigation bar. However, when a user with limited privileges logs in to Account

Manager, they only have access to specific areas. For example, an accountant who is only granted billing and ordering
privileges sees the Billing and Orders tabs in the navigation bar in Account Manager.

Grant Privileges or Add a Second Admin

To grant privileges to an individual, you must first create a user profile for them.
For details, refer to Create User Profiles.

1. Click Accounts in the top navigation bar.

ACCDunt Manager Company Name: Specialty Cookles | Main Number: (510) 962-5321

% 8x8,Inc. Welcome, Phillp Liu | Sign Out

Email: pliu@8x8.com Account: Business v
Edit My Profile

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS il SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts Enter keyword Search

Accounts @ Help
ACCOUNTS
¥ User Profiles
> Privileges User Profiles Privileges Contact
» Communication Directory
Preferences — ~
) ==
» Contact Directory O
> Single Sign On }—%‘—’!
» Analytics Privileges
g View View View

2. On Privileges, click View.
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3. To select the new administrator's privileges manually, click Assign New Privileges.

4. Select a user profile, Account Manager privileges, and PBXs.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home = Accounts = Privileges » Assign Privileges w
Assign User Privileges @ Help
ACCOUNTS

. To allow ather peaple to view or manage this account, first select a User Profile, then define which areas of this account they can access.
ser Profies

-
Accom Manege: Pivieses C——

To assign privileges to existing user(s), select the user Selectthe account privileges for this Apply privileges to these PBXs.
profileis). Otherwise choose to Create New User Profile user(s).

| SpecialtyCookiesinc
Creaate New User Profile ¥l select All E 1y

¥ Analytics Privieges

T N v = System Service San Jose
@) Alan Marachino Phone System Services .
I Billing San Francisco
Shirley Beckmann
¥l Reporting Cupertino
Angela York @o Sant
Orders anta Clara
Valerie Fletcher
¥l Accounts Falo Alto
Anita Becker @s i
Sharing FromKitchen uppo!
Shantanu Garud
Remote Chef
Brylee Cullen M

(oo Carcol |

m Byclicking a link like Phone System Service, more privileges specific to that category become available.

Select the account privileges for this Select the account privileges for

BT this Admin,
FEERIGL Select All

#| Phone System Services ﬁ #| Phone System Services

| Biling

| Reporting #| Extensions

#| Orders #| Auto Attendant

¥ Accounts #| Virtual and Toll-Free

4| Support Mumbers

# Ring Groups

Music on Hold

Call Queues

Shared Lines

Eranches -

Ld
Ld
Ld
Ld

The following table lists the privilege category and sub-privileges available to choose from:

Privilege .
:Sub-Privileges
Category
Phone The ability to create and manage:
System & Extensions

Services Auto Attendant

m Virtual and Toll-Free Numbers

m Ring Groups
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Privilege : .
:Sub-Privileges
Category

= Music on Hold

= Call Queues

m Shared Lines

= Branches

m  Switchboard

m Paging

m  Company Settings

m  Number Transfer Request

= Call Recording

m Edit Voicemail / Fax Notifications

= Group Call Pickup

Contact
Center

The ability to create and manage:

m Contact Center Calling Plans

m Channel Rerouting

Billing

The ability to create and manage:

m Statements
= Billing Profile

m Cost Centers

Reporting

The ability to create and manage Call Log Reports

Orders

' The ability to:

m  Check Order Status
m Buy New Services

m Upgrade Services

Accounts

The ability to create and manage:

m  User Profiles

= Privileges

Version 1.0
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Privilege .
: Sub-Privileges
Category
m  Communication Preferences
= Contact Directory
= Single Sign On
= Analytics Privileges
Support i

Note: The Support options previously available through Account Manager are
now available through the 8x8 Support site. Please refer to our details on how to

access and use 8x8 Support.

= If you have multiple PBXs, select which PBX these administrative privileges applies to. If your PBXs have
branches, you can assign access by branches within each PBX as well.

5. Click Add.
6. When the dialog box appears confirming that the new administrator has been added, click OK.

7. The new administrator now appears in the list of administrators on the main Privileges page.

Privileges

Assign or update privileges so other users can access Account Manager.
Assign New Privileges

Alan Maraching  AMARACHING v

Bryles Cullen BRYLEEC ¥ Edit Copy Revoke
Becky Cullen BCULLEN v v ¥ Edit Copy Revoke
Roland MNguyen ROLANDN v v Edit Copy Revoke
Abbie Jackson  AANNIE v v v Edit Copy Revoke
Sarah Thomas  SPECIALTYCOOKIES v v v v v v Copy

Lancre Martinez ~ SPECIALTYCOOKIES.LM v v v v v v Edit Copy Revoke

= Primary Admin 2]

Edit Privileges
1. Click Accounts in the top navigation bar.

2. On Privileges, click View.
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3. Thellist of current administrators appears. Click Edit to change an administrator's privileges.

Note: the administrator marked with a star is the primary administrator whose privileges cannot be

changed.

Update the user information and privileges for the selected administrator.

4
5. If you have multiple PBXs, select which PBX these privileges apply to.
6. Click Save Changes.

7

When the dialog box appears confirming your changes, click OK.

Revoke Privileges
1. Click Accounts in the top navigation bar.
2. On Privileges, click View.

3. The list of current administrators appears. Click Revoke to remove all administrative privileges for that user.

Privileges

Assign or update privileges so other users can access Account Manager.
Assign New Privileges

Alan Marachine  AMARACHINO v v v v v v Edit CopylRevoke
Brylee Cullen BRYLEEC ¥ Edit Copy Revoke
Becky Cullen BCULLEN v v ¥ Edit Copy Revoke
Roland MNguyen ROLANDN v v Edit Copy Revoke
Abbie Jackson  AANNIE v v v Edit Copy Revoke
Sarah Thomas  SPECIALTYCOOKIES v v v v v v Copy

Lancre Martinez ~ SPECIALTYCOOKIES.LM v v v v v v Edit Copy Revoke

= Primary Admin 2]

Note: the administrator marked with a star is the primary administrator whose privileges cannot be
changed. '

4. When the dialog box appears asking you to confirm that you want to revoke all administrative privileges for that
user, click Continue.
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Manage Contact Directory

The Contact Directory is an online directory for users to view their contacts and see who is online and available.
Information used by the Contact Directory is pulled from user profiles that are created and maintained by your phone

system administrator in your system’s Account Manager.

Phone system administrators can exclude extensions and user profiles from the Contact Directory using Account
Manager. By default, all extensions appear in the Contact Directory, and the user profiles that have not been assigned

to an extension do not appear.
To configure the global system settings for your system's Contact Directory, go to the Accounts tab of Account

Manager, and click View on Contact Directory.

Account Manager Company Name: Specialty Cockies | Main Number: (510) $62-5321

% 8x8, Inc. Welcome, Sarah Thmas. | Sgn Out
En\all pl @8x8.c Account: Business v
Ed ofie

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCDUNTSl\ SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts Ex
Accounts @ Hep
ACCOUNTS
User Profiles Privileges Communication Contact
_ _ e —" e
h—El ¥ |7 2
o) A L=y

Note: Contact Directory data is pulled from the system's user profiles. To edit an individual contact's
information, you must make the changes to the user profile. For details, refer to Create User Profiles.

Exclude Extensions from the Contact Directory

By default, all extensions and the user profile information attached to that extension, are shown in the Contact
Directory. To exclude a user or service extension from the Contact Directory, select the corresponding check box in the
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Contact Directory Exclude Extension column.

Contact Directory User Specific Display Preferences @ Help
Advanced Search Display Preferences Select Columns to Display

First [4] 1-20 of 45 [#] Last Profiles Per Page | 20 %

Exclude Extsnsion Exclude Extension

Exclude User Profile @

1001 Kelly Morrison Engineering Technical Architect @j -
1002 Jerry McEnroe Faciliies Facilities Manager * =]
1003 Brent Snyder Marketing Analyst O (]
1004 Phillip Liu =) (=]
1005 Angelique Yu - o
1006 Anita Becker Sales Mccount Manager = =]

Include Contact Information for Non-Extension Users

By default, user profiles assigned to an extension are shown in the Contact Directory. However, phone system
administrators can also choose to display contact information for user profiles not assigned to an extension. User
profiles not assigned to an extension are displayed in the table below the extensions. To display contact information for
a non-extension user profile, clear the corresponding check box in the Contact Directory Exclude User Profile

column.

Exclude Contacts from the Auto Attendant Directory

When using the Auto Attendant feature of your phone system, you can give callers the option to:
= Dial by extension
= Dial by name
= Search directory

To exclude an extension from these three options, select the corresponding check box in the Auto Attendant Exclude

Extension column.

Contact Directory Display Preferences

Phone system administrators can control what user profile information to display in the Contact Directory of user
profiles. You can display Contact Card information such as email address, job title, and location, and also choose to
filter contacts by department, or show more details for job titles.

1. To select which user profile information is available to display, click Display Preferences.

2. Select the check box to determine the data that is available to display or be used in the Contact Card, for contact
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Filters, and to customize Detail Mode.
3. Click Save.

Note: By default, all but custom user profile fields are checked.

Contact Directory User Specific Display Preferences (7]

| Search " Reset | | Display Preferences |l Select Columns fo Displa

Contact Directory Display Preferences [x]

: Email Address v
04 Job Title i )
- Department Fj ] 7
1] ecialy t
= = Location 7l 7 7
3 ave Wobde Phane v
10 harin I T
Trunk # v ¥ i
1" o] +
™ Region 7 7 7
Valer

External Directory Upload

You can bring external contacts from Microsoft Exchange, Skype for Business, or other directories into the 8x8 Contact
Directory. The external contacts are displayed in your Contact Directory, giving you the ability to interact with external
and 8x8 contacts.

The Virtual Office desktop app and Switchboard Pro display the contacts uploaded in Contact Directory. In the Virtual
Office mobile app, external directory contacts can be filtered by the application user.

To upload external contacts:

1. Goto Accounts > Contact Directory.
Hover over the tool tip to learn about the upload requirements. This helps you comply with the upload
requirements, and prevent errors while uploading the data.
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HOME | PHOMNE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE

Home > Accounts > Contact Diredtory

ACCOUNTS

¥ Usar Proties
» Priy

» Communicaton
Sraterancas

Contact Directory User Specific Display Preferences

| Search | Reset ]

Display Preferences Select Columns to Display

[ 7=

Profiles Per Page |20 ¥

* Contact Dirsctory
¥ Single Sign On

» Anaytos Priveeges | [0 m— Tnomas -
1002 saran Thamas Il
1003 John Smim Product \ia1age1‘e1| Technical Witer
108 Saran Tromas
1005 Suzy Ve
1008 Saran Thomas
1007 Jean Andjz Enginzaring Sofware Enginaar
1009 Saran Thomas
1010 sal ¥ Saker \ia'eﬂg \da1age'

1011 el :a"‘e}' \ia'eﬂg \ia'eﬂg Cirector

1012 .-\1gea Yaork \ia'eﬂg \da'eﬂg Cirector

1013 Julia Znu Customer Succass Sr. Direcior

1012 LiE] Tandean Customer Succass Lead

1015 Sohkela \iag il Customer Succass Customer Success N

1016 Shantanu Garud E"g neering E"g neer -
< »

External Directory Upload

ternal contacts fram Microsoft Exchange,

Lync or other directories into the BxB Contact Directory. The
ry, giving you the ability to interact with external and BxB contacts. BxB Virtual Online, Virtual Of

rnal contacts are seamlessly displayed in your
Desktop and Switchboard Pro display the contacts

Uploai CSV Terpite

2. Todownload and open the Comma-Separated Values (CSV) file in Excel, click Download CSV Template.

3. Add external contacts to the template file by entering the necessary details.

4. Once you have added all the data, Save the file to your computer.

5.

Version 1.0

Notes:

-First name and last name are mandatory.

-Address entries are separated by a <_>. Multiple entries such as work address and home are :
separated by a <;> without a space. For example, you can have two entries written as <123 Street_f

SanJose CA 12345 USA WORK;456 Street San Jose CA 12345 USA HOME>.

In Accounts > Contact Directory, click Upload CSV Template.
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If your browser prompts you to accept the download, click Proceed.

Contact Directory User Specific Display Preferences @ =

i e

1001 Saran Tnomas

1002 Sarah Tnomas

1003 Jann Smén ProductManagement Technical Witter
1004 Sarah Thomas

1008 == Upload External Contacts ol

1006 Sarah

To upload external contacts you must use the External
Contacts C5V Template. If you have not used the
template click Cancel and click on Download C5V
Template. Make sure to save your changes as a C5V file.

1010 sany Wanagar

Softwarz Enginsar

1011 e Camey Marzing Marke®ng Diractor

1012 Angeia York Markzing Marketing Director

1013 Jula nu Cusomer Success St Direckar

1014 Sa Tandzan Cusiomer Suceess  Lead

1015 Sonisia Magid Cusmer Success  Cuslomer Succass N

1015 Shantanu Garud Engineenng Enginsar )
3

External Directory Upload

he BxB Contact Di
sitacts, ExB Virtual On

s from Microsoft
you the ability

Click Add.
Locate the file you just saved, and click Open.
Click Upload.

If you encounter any errors, please check the error message, fix the issues in the CSV file, and upload again.

Verify that the new information is correct, and then click Submit.

Uploaded External Contacts Summary Help

Raview the User Profile(s) below and dlick Submit to accept changes.

frathame laathame nickName emalla phones addresass JobTibe  department location customFlskil customFleld2 customFiekt contactid  Status
Neal Kumar  Masl | OTHER _OTHER 2125_Onsl drive_San  Technlcal Techpub o=
J0B8_CA_DTHER itar [ new
su8 Joangon  sue sue | OTHER _OTHER 2125_ONel_OMve_san  support  support [o=1
Jose_CA_GTHER [ hew ]
Vida Noorl  Vida vitancon@gmallcom OTHER  1231234123_OTHER 2125 Orchard_ave_san Sales  Sakes o=
JoBa_ca_OTHER Rep. [ hew ]

=

Accounts Overview
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The new contacts appear in the External Directory Upload table.

ACCOUNTS

¥ User Profias
¥ Breges

» Communicasan
Sraferences

Contact Directory User Specific Display Preferences

o H

Display Preferences Select Columns to Display

» Contact Directory
» Single Sign On

External Directory Upload

Bring external contacts from Microsolt Exchange, Lync or other directories
Ce ry, giving you the ability to interact with external and BxB con

¥ Analyies Pnvizges Melissa rawns Salkes AccountManager o
1022 Mik Remnan Markztng ProductMarszing ¥
Mz Laky
Namnl ﬁ1a1l‘|a'r.|'r|}'
Onine chet Saks ‘AccouniManagar
1037 sack Mesana ProduciManagemeni PraduciManagar
1022 Parice D=l aray Customer Sucoass
=i Tesl -
Phmp Liuid43
Pnmp Lui0dd |
Pravesn sz2gde Markeing Analyst
1045 =a) Singn
Ramana Gotipat Product Ma‘!age're'n Vice Prasident
Remate chef Markatng Analyst
1018 mia Tandzan Cuslmer Sussass | Lead -
4| | 3
Save Changes | Cancel

e ExB Contact Directory. The external contacts are seamlessly displayed in your
cts. BxB Virtual Online, Virtual Office Desktop and Switchboard Pro display the contacts

Download CSV Template || Upload CSV Template

Neel Kumar Neel neelkumar@hotmall.com_COTHER 4086750258_OTHER

Sue Johnson Sue ‘Sue Johnson@yahoo.com_OTHER 6699005533_OTHER

Vida Noaorl Vida wida noori@gmall.com_OTHER 1231234123_0OTHER o
4| 3

SAML and Google Federated Single Sign-On

Accounts Overview

Customers with identity management systems like Okta, OnelLogin, Ping Identity, and Microsoft ADFS require their
employees to authenticate to 8x8 apps using their company ID instead of an 8x8 username and password. In this

release, we support SAML 2.0 & Google OAuth Federated Single Sign-On (SSO) for the following 8x8 applications

that use the shared 8x8 login page:
= Account Manager
= Virtual Contact Center
= Virtual Office desktop app

Version 1.0
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= Virtual Office online app
= Virtual Office mobile app
= Virtual Office Analytics

= Switchboard Pro

With support for Federated SSO, users can log in to 8x8 applications through their company's identity management
system.

Identity Mapping
Ideally, the system maps each company user to an 8x8 user via the 8x8 username. If your company's 8x8 usernames
are not unique email addresses, you have to populate either of these new 8x8 user attributes via Account Manager:
m For SAML SSO: Federated ID
m For Google SSO: Google ID

Configure Federated Single Sign-On

Configuring access to 8x8 applications via federated SSO requires you to:

1. Set up SAML in the company's identity management system: Not covered in this document, since the
process varies with the identity management system adopted by your company, and is typically managed by its
administrator.

m For Okta: Search for 8x8 Inc in the Okta Application catalog and add it. Follow the SAML 2.0 setup
instructions provided for 8x8 users with matching Okta usernames. For 8x8 users without matching Okta
usernames, the Federated ID is populated as normal in Account Manager.

m For OneLogin: Search for 8x8 in the OneLogin Application catalog. Under Configuration > Connectors,
select Connector Version: SAML 2.0.

2. Set up Single Sign-On in Account Manager: Set up by the Virtual Office administrator. The administrator
must set up Single Sign-On and specify the identity provider used by the company.

To set up Single Sign-On:

1. Click Accounts in the top navigation bar.
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2. Under the Accounts menu, click Single Sign-On.

Accounts Overview

HOME | PHONE SYSTEM | CONTACT CENTER | EILLING | REPORTING | ORDERS |IACCOUNTS I| SUPPORT
Home = Accounts > Single Sign On
Single Sign On
ACCOUNTS
» User Profiles Authentication methods
> Privilege:
Priieges #| x5 Username and Password
> Communication
> Contact Direc tory
SAN
> Analytics Privileges Google
> word Policy
Password Polcy User Mapping Field | Automatically selected v 0
Ex

Select an identity provider from the following choices:

m 8x8 Username and Password: Allows users to log in to 8x8 applications using an 8x8 username and

password. If this check box is cleared, only the primary administrator can log in using their 8x8 username

and password. All other users must use Google or SAML SSO.
m SAML: Allows users to log in to 8x8 applications by signing in via SAML.

m Google: Allows users to use a Google ID to to log in to 8x8 applications.

Select the User Mapping Field that maps each user from your SAML identity provider or Google directory

to 8x8. The system begins by matching via 8x8 username. If that fails, 8x8 looks up and matches via

Federated ID (for SAML) or Google ID (for Google OAuth).
m 8x8 Username: The system maps via 8x8 username.
m Federated ID: For SAML, 8x8 maps via Federated ID.
m Google ID: For Google OAuth, 8x8 maps via Google ID.
Save these settings.
If you selected SAML,you should specify the following:
= Sign In URL: User authentication URL provided by identity provider (IDP).

m Sign Out URL.: User sign out URL provided by IDP to end the IDP session. The 8x8 app calls this URL
after you log out of the 8x8 app. If your IDP can redirect to another URL after it ends the IDP session, you

should append the variable string <{8x8Logout}>, which inserts the 8x8 login URL so the user can log

back in later.
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For Okta, the sign out URL may be https://'YOUR_COMPANY.okta.com/login/signout?fromURI=
{8x8Logout}.

= Issuer URL: IDP identifier.

m Identity Provider Certificate: Your identity management system should provide an X.509 certificate
file to download. Browse to locate the certificate file and upload here.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE |

Home > Accounts > Single Sign On > SAML config Erterkeyword

SAML Single Sign on

SAMIL Single Sign on

SignIn URL* (%)

ACCOUNTS

Sign Out URL (2]
Issuer URL * (2]

Identiy Provider Certicate

Current Certificate No Certficate Found

The certificate file is validated and notifies you of any errors.
7. Click Save. This completes the configuration of SAML or Google-federated SSO.

3. Define Federated ID or Google ID in User Profiles: This step is optional. If your company does not use
unique email addresses for 8x8 usernames, then you must map Virtual Office users to their Federated 1D (for

SAML) or Google ID (for Google) in the list of user profiles.
To define Federated ID or Google ID:

1. Click Accounts.
2. Under the Accounts menu, click User Profiles.
3. To edit an individual profile:

a. Click Edit next to the desired user.
Based on the choice of identity provider, the corresponding mapping field shows:

m For SAML, the Federated ID field is available.
m For Google, the Google ID field is available.
b. From the list, edit the desired user profile to add the mapping field data:
m For SAML, populate the Federated ID.
m For Google, populate the Google ID.
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STEM | BILLING | REPORTING | ORDERS | ACCOUNTS | SUPPORT | VIRTUAL OFFICE ONLINE
Profiles Enter keyword Search
N Update User Profile
User Profiles Q @ Help
Create and edit user First Name * Biren
faatures includ t + View
eatures including ex Last Name * o
Hickname Biren & or show columns, and create additional
fields by clicking Edit Viewable / Hidden Fields.
Email Address * Imartinez@8x8.com
Job Title Director Technical Programs
Department Engineering Hew User Profile Edit Viewable / Hidden Fields
First [1] 1-89 of 89 [ Location San Jose User Profiles Per Page Al [+]
User Name * Bx8.1087
Employee ID 537901
| {Custom Fiski) -
Edit | Disable Employee Hire Date 5/12/2010 v «Ext: 1093
L {Custom Figd)
Edit | Disable Favorite Color n «Ext: 1099
Edit | Dizable Federation ID bpatel@8x8.com I 22 «Ext: 1098
«Ext: 1028
*=indicates Required Fields JExt 1041
Edit | Disable iuz Ext: 1067 bpatel@8x8.c
Edit | Disable Branch Privileges BRUCE. FAITHWICK4@YAHOO.COM
« nm »
Create and edit multiple profiles at once by dovmloading the csv template, enter data in appropriste columns Download CSV Template Upload CSV Template
and then upload using the link to the right. @

4. To edit profiles in batches:
a. Click Download CSV Template.
b. Open the downloaded CSYV file in Microsoft Excel, or any spreadsheet app.
C. Add the desired username to the relevant ID field for each user, and save the file.
d. From Account Manager, click Upload CSV Template to upload the edited file.

5. Save your changes.
For 8x8 Users with Matching Okta Usernames

If all your users have 8x8 usernames (such as jdoe@anycompany.com) that match (not case-sensitive) their Okta
usernames:

= No additional 8x8 user configuration is required for Single Sign-On.

m 8x8 uses the 8x8 Username field to map each 8x8 user account to the Okta user account.

Note: If you have any users with 8x8 usernames that do not match their Okta usernames, you
must define the Federated ID in the user profile for all users manually in Account Manager.
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Sign in Using Federated SSO

The sign-in process for 8x8 applications is similar whether it is authenticated via SAML or Google. The initial sign-in
process takes users through the Virtual Office login page. Go to the 8x8 SSO login page, or launch the Virtual Office
desktop app.

1. Inthe login screen, click Use Single Sign On.

Virtual Office  Help

8x8

Virtual Office
L | 8x8 Username
@& Password
M remember e el

Use Single Sign On

The SSO login prompt opens.
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2. Enter your 8x8 username or company email for validation.

Virtual Office  Help

8x8

Virtual Office

Enter 8x8 Username or Company Email for
Single Sign on.

2 | 8x8 Usermame or Email
Continue
Back to Login

3. Click Continue to view your SSO options.

4. Click Log in using SAML to open your identity provider's login page.
OR
Click Log in using Google to open the Google login page.

Note: Clicking Clear SSO Setting takes you back to the first login page.

m To log in with SAML:

a. If you selected Log in using SAML, your company's identity provider login page opens.
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Virtual Office  Help

.
Pin
\dé\lllt\p'g
Sign On
USERNAME
PASSWORD

Remember Me

Note: If you log in using Okta or Centrify, the login page opens in a new browser tab
instead of in the application window. Until you log in, the application window reads Login
from browser.... :
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O 8x8,Inc-dev-174782 - Si. X

c

it Apps

Connecting to 88 =~

[7] Remember me

Need help signing in?

Powered by Okia Privacy Policy

b. Enterthe credentials to log in to the identity provider.

The application launches.

(Step 4).

To log in with Google:

a. If you selected Log in using Google, the Google login page opens.

b. Enter your company Gmail address and password.

Accounts Overview

Note: For consecutive SSO login sessions, you are routed from the custom login page
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c. Click Allow to grant 8x8 single sign-on access to your Gmail profile.

(5 Virtual Office " = —i5—

Virtual Office  Help

Go gle Johnsmith@#gx8.com «

O %

- 8x8 Single Sign On would like to:

@ Know who you are on Google

View your email address

View your basic profile info

v, you allow this app and Google to use your information in accordance
ctive terms of service and privacy policies. You can change this and

other Account Permissions at any time.
peny m

You are now authenticated to your 8x8 app. The application launches.

5. When prompted, click Allow to enable Adobe Flash Player settings to access your camera and/or microphone.

Configure Analytics Privileges

Virtual Office Analytics is currently offered in three separate bundles:

= Virtual Office Analytics: Comprehensive set of unique dashboards and reporting options for all extensions in an
organization’s 8x8 cloud PBX.

m Virtual Office Analytics Supervisor: A real-time view of all call activity for selected call queues or ring groups

within the 8x8 cloud PBX. Get comprehensive call center-quality reporting in a single dashboard view, available on
any device.

= Virtual Office Analytics Service Quality: Real-time information about endpoint devices and call quality.

To configure privileges for Virtual Office Analytics:

1. Click Accounts in the top navigation bar.
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2. Under the Accounts menu, click Analytics Privileges.

A list of available administrators displays.

HOME | PHONE SYSTEM | BILLING | REPORTING | ORDERS \I ACCOUNTSI\ SUPPORT | VIRTUAL OFFICE ONLINE

> User Profies
> Privileges

> Communic ation
Preferences

> Contact Directory
> Single Sign On

» Analytics
Privileges

Home > Accounts > Analytics Privileges e Ry
Virtual Office - Analytics Privileges @ Hep
ACCOUNTS

Please assign user privileges on this page. Analytics include:
1. Virtual Office Analytics,
2. Virtual Office Work Group Analytics and Reparts, and
3. Virtual Office Monitoring and Management.
Check the bax next to User Name for whom you are granting access. Click dit for additional details on report visibility. Analytics need to be purchased before they are
assignable to users below.
Brief description of user privilege assignment:

1. Virtual Office Analytics provides extension level analytics and is assignable to all extensions on your PBX. The number of licenses available is (N/A), since all extensions
can be assigned access.

2. Virtual Office Work Group Analytics and Reports is purchased as an add-on to VO Analytics. This adds Ring Group and Call Queue reporting. The number of licenses
available is shown within parenthesis ().

3. Virtual Office Monitoring licenses is purchased as an add-on to VO Analytics. This adds Call Quality and Device Status reporting. The number of licenses available is shown
within parenthesis ().

User Profiles Per Page 10 v

toring
Management  5)

ACCOUNTANNIE @ @ =] Edit -
ANGELIQUEY @ =] o Edit
DOOMTROLL @ @ (=] Edit
MSWAMY @ =] o Edit
NANANTHAMURTHY @8X8.4 @ =] o Edit
PHIL TEST v @ 3] Edit
PHILLIPLIU@EXE.COM ] =] =] Edit
PLIU1043 @ @ =] Edit
SPECIALTYCOOKIES RAMA @ @ =] Edit

STHOMAS @ =] o Edit -

Save Changes

3. Click Edit next to an administrator to manage their dashboard privileges.

Version 1.0
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4. Inthe pop-up, click the drop-downs to display the available privileges.

ACCOUNTS

> User Profiles
> Privileg

» Communication
Preferences

¥ Contact Directory

> Single Sign On

> Analytics
Privileges

Please assign user privileges on this
1. virtual Office Analytics,
2. Virtual Office Work Group Analy
3. Virtual Office Monitoring and Ma
Check the box next to User Name fo
assignable to users below.

Brief description of user pri

ilege

1. Virtual Office Analytics provides ¢
can be assigned access.

2. Virtual Office Work Group Analyti
available is shown within parenthesis

3. Virtual Office Monitoring licenses
within parenthesis ( ).

First [4] 1-10 0785 [¥] Last

Virtual Office - Analytics Privileges ]

Administrator

User ID: ACCOUNTANNIE
Name: Annie Thomas
Email Address: AAnnie@SpecialtyCookies.com

VO Analytics { N/A)

¥ company Summary

[ Extensions Summary
¥l Call Details Records.
¥ Active Calls

¥l Unreturned Calls

¥ calls By DID

¥ Employee Summary

WO Work Group Reports (4 )

¥l call Queue Call Data
¥/ Ring Group Call Data

ACCOUNTANNIE
ANGELIQUEY
[ poommrOLL

PLIU1043

VO Monitoring and Management (4 )

¥l Device Staus Details
¥l call Quality Trend and Details
¥l Extension Summary Details

s need to be purchased befare they are

znses available is (N/A), since all extensions
Jusue reporting. The number of licznses

1g. The number of licenses available is shown

User Profiles PerPage 10 v

Edit

Edit

Edit

Edit

Edit

5. Select or clear the check boxes for the desired privileges at the extension level.

6. Click Ok.

Version 1.0
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Get Support

The options previously available on Account Manager's Support menu are now available through
http://support.8x8.com.

Find solutions and answers to your phone system questions, report issues and submit questions, find out about 8x8
network alerts, manage cases, and transfer your telephone numbers from another service company to 8x8 by going to
8x8 Support.

You must log in to your 8x8 account to access all available options. If you are already logged in to Account Manager,
click the Support tab.

Number transfer is also accessible via Phone System > Number Transfer Request in Account Manager. See
Request Number Transfer for details.
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3!8 FAQ

FAQ

Check the following frequently asked questions for more information:
Which localization settings are required for a PBX extension user?

As a phone system administrator, you can enable localization language settings at the PBX level, branch level, or at the
extension user level. The language settings at the user level overrides all other settings.

The following table summarizes the localization settings in Account Manager:

Setting Description Configured At
Edit My The primary or secondary administrators who have access to Account Manager can User level
Profile - configure the Language setting in Edit My Profile to communicate emails in their :

language of choice.

This setting overrides the default PBX or branch language setting. It only applies to
the administrator's email communications. :

Account > Configure the Language setting for extension users to communicate emails in User level
User - their language of choice.
Profiles

This setting in user profile overrides the default PBX or branch language. It only
applies to the user's email communications.

Phone Configure the Language setting for all users in the PBX to receive Telephony PBX level
System >  |VR messages, such as voicemail greetings in the selected language. This setting
Company is overridden by language settings at the branch and/or individual extension level.

Settings In the absence of the individual extension user's language of choice, the language

setting of branch overrides the PBX language setting.
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Setting Description Configured At
Phone Configure the Language setting for users to receive Telephony IVR messages, Branch level
System >  such as voicemail greetings in the selected language.
Branches In the absence of the individual extension user's language of choice, the branch
B : anguage setting overrides the company language setting. In other words, i
(Add-on tt des the PBX | tting. In other words, if
subscnptlon-é an extension belongs to a branch set to Japanese, and if you have not defined
-another language at the extension level, Telephony messages are played in
based) ahother! t the extension level, Telephony IVR layed i
the Japanese language. If the extension belongs to a branch with no other
language defined, you inherit the PBX language.
Phone Configure the Language setting for extension users to receive Telephony Extension level
System > VR messages, such as voicemail greetings in the selected language. The display :
Edit on the user's desk phone also appears in this language.
Individual This setting overrides the PBX and branch language setting.
Extension .
: E— Note: If you need help with setting the user language in bulk, contact?i
1= 8x8 Support for help. E
£—_ Note: To access localized versions of 8x8 Virtual Office
E :_/ applications, refer to your computer or device manual to learn how
T_—i you can change the display language of your operating system.

Note: The PBX or branch language does not affect the agent's desk phone display. You must select the
language of preference for the individual extension user. For details, refer to Edit Individual Extensions.

Note: The agent cannot control any localization settings. The localization is configured at the user level,

individual extension user level, PBX level, and branch level all in the Account Manager and by the
primary administrator.

Version 1.0
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The following table shows the different Power Keys plans and the numbers of LAK and BLF keys included with them:

Up to 4 Line Appearance Keys

Up to 4 BLF Keys*

# of Physical
Polycom Phone Virtual Receptionist Plans Maximum Key Configuration
Line Keys
IP 550, IP 560 4 VA4 Plan Up to 4 Line Appearance Keys
and/or up to 2 BLF Keys®
Up to 4 Line A K
WX 300, VVX 310, IP 670 6 VA4 Plan p to 4 Line Appearance Keys
and/or up to 4 BLF Keys®
VVX 300, VVX 310, IP 670 8 VRS Plan Up to 6 Line Appearance Keys
and/or up to 4 BLF Keys*®
VVX 400, VVX 410, VVX 500 12 VA4 Plan Up to 4 Line Appearance Keys
and/or up to 4 BLF Keys®
VVX 400, VVX 410, YVX 500 12 VA6 Plan Up to 6 Line Appearance Keys
and/or up to 6 BLF Keys®
VVX 400, VVX 410, VWX 500 12 VR14 Plan Up to B Line Appearance Keys
and/or up to 10 BLF Keys*
VVX 600 186 VA4 Plan Up to 4 Line Appearance Keys
and/or up to 4 BLF Keys®
VX 600 18 VRS Plan Up to 6 Line Appearance Keys
and/or up to BBLF Keys®
VWX 80O 18 VR14 Plan Up to 6 Line Appearance Keys
and/or up to 14 BLF Keys*

*Limited by the number of spare Line Keys available on your phone]

Polycom Phone

Sidecar Model Physical

#of

Virtual Maximum Key
Receptionist Plans

Configuration

500, or VVX 600

Paper Label

Keys
VVX 300, VVX 310, VVX 400, VVX 410, VWX| VVX Sidecar 28 Key - | 28 - Up to 10 LAK, and/or up
500, or VVX 600 Color R e to 28 BLF
VWX 300, VVX 310, VVX 400, VVX 410, VWX| VWX Sidecar 40 Key - Up to 10 LAK, and/or up
40 VR40 Plan

to 40 BLF

Version 1.0
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Backing up the Contact Directory on the phone device is essential before editing any keys in Account Manager the first
time. It is done automatically once the back-up server launches. Configuring line keys in Account Manager allows
central editing after the local directory is saved once, in order to prevent the accidental loss of locally-saved contact data

on the phone. You can add a dummy new entry on the phone and save it for a quick backup.

To back up the Contact Directory from your phone device:

1. Press to display the Home view.

2. From the menu, go to Directories > Contact Directory.

A
3. Select a contact to edit, or use w to create a new contact.

4. Edit a contact:
a. Select a contact and press Edit. Scroll down the list of options and select Favorite Index if you wish to put
the contact on Speed Dial.

b. Assign an index according to where you want the contact to display on the phone or SideCar.

5. Press Save to save the contact and back up the Contact Directory.

Appendix C

End users can edit speed dials from the phone user interface using indexes for the key positions and assign to Contact
Directory entries.
1. Identify and catalog current key locations (LAKs, BLFs, and Speed Dial keys) on your Polycom VVX 500, VVX 600
telephone set(s), and sidecars.

2. Determine your new desired key locations for both phone set and sidecar. See charts below.

: — Note: When assigning any key to an index, ensure that the index is not already assigned to an
{ existing LAK, BLF, or Speed Dial key.
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3. To relocate or move any key, re-assign its favorite index to point to a line key position that is currently available.

Version 1.0

Polycom 300/310

Index 1 ' Index 4

Index 2 Index 5

Index 3 Index 6

Polycom 400/410

Index 1 ‘Index 7

Index 2 Index 8

Index 3 Index 9

Index 4 ' Index 10

Index 5 Index 11

Index 6 ' Index 12

VVX 500

Index 1 ' Index 5 ‘Index 9

Index 2 ' Index 6 :Index 10

Index 3 ' Index 7 ' Index 11

Index 4 ' Index 8 ' Index 12

VVX 600

Index 1 ' Index 5 ' Index 9 'Index 13
Index 2 ' Index 6 ' Index 10 ' Index 14
Index 3 ' Index 7  Index 11 ' Index 15
Index 4 ' Index 8 ' Index 12 ' Index 16
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Sidecar 28  :Sidecar 28  :Sidecar 28
Index Index Index Index Index Index
101 115 201 215 301 315
Index Index Index Index Index Index
102 116 202 216 302 316
Index Index Index Index Index Index
103 117 203 217 303 317
Index Index Index Index Index Index
104 118 204 218 304 318
Index Index Index Index Index Index
105 119 205 219 305 319
Index Index Index Index Index Index
106 120 206 220 306 320
Index Index Index Index Index Index
107 121 207 221 307 321
Index Index Index Index Index Index
108 122 208 222 308 322
Index Index Index Index Index Index
109 123 209 223 309 323
Index Index Index Index Index Index
110 124 210 224 310 324
Index Index Index Index Index Index
111 125 211 225 311 325
Index Index Index Index Index Index
112 125 212 225 312 325
Index Index Index Index Index Index
113 127 213 227 313 327
Index Index Index Index Index Index
114 128 214 228 314 328

Sidecar 40 - #1 : Sidecar 40 - #2 : Sidecar 40 - #3

Index Index : Index Index : Index Index
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Sidecar 40 - #1 : Sidecar 40 - #2 : Sidecar 40 - #3

101
Index
102
Index
103
Index
104
Index
105
Index
106
Index
107
Index
108
Index
109
Index
110
Index
111
Index
112
Index
113
Index
114
Index
115

Index
116

121
Index
122
Index
123
Index
124
Index
125
Index
125
Index
127
Index
128
Index
129
Index
130
Index
131
Index
132
Index
133
Index
134
Index
135

Index
136

' 201
élndex
202
ilndex
203
ilndex
204
élndex
' 205
' Index
' 206
' Index
207
élndex
208
glndex
' 209
élndex
210
ilndex
211
ilndex
212
élndex
213
' Index
214
" Index
215
élndex
216

221
Index
222
Index
223
Index
224
Index
225
Index
225
Index
227
Index
228
Index
229
Index
230
Index
231
Index
232
Index
233
Index
234
Index
235

Index
236

' 301
élndex
302
ilndex
303
ilndex
' 304
élndex
305
" Index
306
' Index
307
élndex
308
glndex
' 309
élndex
310
ilndex
311
ilndex
312
élndex
313
' Index
314
' Index
315
élndex
316

321
Index
322
Index
323
Index
324
Index
325
Index
325
Index
327
Index
328
Index
329
Index
330
Index
331
Index
332
Index
333
Index
334
Index
335

Index
336
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Sidecar 40 - #1 :

Sidecar 40 - #2 Sidecar 40 - #3
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